BY INSTALLING AND USING THE PROVIDED SOFTWARE, YOU ARE AGREEING TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT, WHICH INCLUDES THE SOFTWARE LICENSE AND THE SOFTWARE DISCLAIMER OF WARRANTY (collectively the "Agreement"). CLICK "QUIT" ON THE FOLLOWING DIALOG IF YOU DO NOT AGREE WITH THIS AGREEMENT. THIS AGREEMENT CONSTITUTES THE COMPLETE AGREEMENT BETWEEN YOU AND BIAS, INC. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE ON THE DISKS INCLUDED IN THIS PACKAGE AND PROMPTLY RETURN THE UNOPENED PACKAGE AND THE OTHER MATERIALS (INCLUDING WRITTEN MATERIALS, BINDERS OR OTHER CONTAINERS) THAT ARE PART OF THIS PRODUCT TO THE PLACE WHERE YOU OBTAINED THEM FOR A FULL REFUND.

BIAS SOFTWARE LICENSE

1. GRANT OF LICENSE. In consideration of payment of the LICENSE fee, which is part of the price you paid for this product, BIAS, as Licensor, grants to you, the LICENSEE, a nonexclusive right to use and display this copy of a BIAS software program (hereinafter the "SOFTWARE") on a single COMPUTER (i.e., with a single CPU) at a single location. BIAS reserves all rights not expressly granted to LICENSEE.

2. OWNERSHIP OF SOFTWARE. As the LICENSEE, you own the magnetic or other physical media on which the SOFTWARE is originally or subsequently recorded or fixed, but BIAS retains title and ownership of the SOFTWARE recorded on the original disk copy(ies) and all subsequent copies of the SOFTWARE, regardless of the form or media on which the original and other copies may exist. This License is not a sale of the original SOFTWARE or any copy.

3. COPY RESTRICTIONS. This SOFTWARE and the accompanying written materials are copyrighted. Unauthorized copying of the SOFTWARE, including SOFTWARE that has been modified, merged, or included with other software, or of the written materials is expressly forbidden. You may be held legally responsible for any copyright infringement that is caused or encouraged by your failure to abide by the terms of this License. Subject to these restrictions, and if the SOFTWARE is not copy-protected, you may make one (1) copy of the SOFTWARE solely for backup purposes. You must reproduce and include the copyright notice on the backup copy.

4. USE RESTRICTIONS. As the LICENSEE, you may physically transfer the SOFTWARE from one computer to another provided that the SOFTWARE is used on only one computer at a time. You may not electronically transfer the SOFTWARE from one computer to another over a network. You may not distribute copies of the SOFTWARE or accompanying written materials to others. You may not modify, adapt, translate, reverse engineer, decompile, disassemble, or create derivative works based on the SOFTWARE. You may not modify, adapt, translate, or create derivative works based on the written materials without the prior written consent of BIAS.

5. TRANSFER RESTRICTIONS. This SOFTWARE is licensed only to you, the LICENSEE, and may not be transferred to anyone without the prior written consent of BIAS. Any authorized transferee of the SOFTWARE shall be bound by the terms and conditions of this Agreement. In no event may you transfer, assign, rent, lease, sell, or otherwise dispose of the SOFTWARE on a temporary or permanent basis except as expressly provided herein.

6. TERMINATION. This License is effective until terminated. This License will terminate automatically without notice from BIAS if you fail to comply with any provision of this License. Upon termination you shall destroy the written materials and all copies of the SOFTWARE, including modified copies, if any.

7. UPDATE POLICY. BIAS may create, from time to time, updated versions of the SOFTWARE. At its option, BIAS will make such updates available to the LICENSEE and transferees who have paid the update fee and registered the software with BIAS.

8. MISCELLANEOUS. This Agreement is governed by the law of the State of California.

DISCLAIMER OF WARRANTY AND LIMITED WAR-RANTY

THE SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS (INCLUDING INSTRUCTIONS FOR USE)
ARE PROVIDED "AS IS" WITHOUT WARRANTIES OF ANY KIND. FURTHER, BIAS DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU, AND NOT BIAS OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, YOU AGREE TO ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.

BIAS warrants to the original LICENSEE that the disk(s) on which the SOFTWARE is recorded is free from defects in materials and workmanship under normal use and service for a period of ninety (90) days from the date of delivery as evidenced by a copy of the receipt and. Further, BIAS hereby limits the duration of any implied warranty(ies) on the disk to the respective periods stated above. Some states do not allow limitations on duration of an implied warranty, so the above limitation may not apply to you.

BIAS' entire liability and your exclusive remedy as to disk(s) shall be, at BIAS' option, either (a) return of the purchase price or (b) replacement of the disk that does not meet BIAS' Limited Warranty and which is returned to BIAS with a copy of the receipt. If failure of the disk has resulted from accident, abuse, or misapplication, BIAS shall have no responsibility to replace the disk or refund the purchase price. Any replacement disk will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer.

THE ABOVE ARE THE ONLY WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, THAT ARE MADE BY BIAS CONCERNING THE BIAS PRODUCT. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY BIAS, ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.

NEITHER BIAS NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

This Disclaimer of Warranty and Limited Warranty is governed by the laws of the State of California.

U.S. GOVERNMENT RESTRICTED RIGHTS

The SOFTWARE and documentation is provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subdivision (b)(3)(ii) of The Rights in Technical Data and Computer Software clause at 252.227-7013.

Contractor/manufacturer is BIAS (Berkley Integrated Audio Software), Inc/1370 Industrial Avenue, Suite A, Petaluma, CA 94952.

Should you have any questions concerning this Agreement, or if you desire to contact BIAS for any reason, please contact in writing:


Credits:

Peak Software:

Steve Berkley

Time Compression/Expansion Software:

Earl Vickers (aka The Sound Guy™)

Mercutio MDEF from Digital Alchemy, Copyright © Ramon M. Felciano 1992-2000, All Rights Reserved.
ASIO and VST are trademarks of Steinberg Software und Hardware GmbH.

CD-related data through the Internet from the CDDB™ Music CD Database.

CDDB-Enabled, CDDB, CDDB² and the CDDB Logo are trademarks of CDDB, Inc.
Disc Recognition Service and DRS are service marks of CDDB, Inc.

IDR dithering and noise-shaping technology licensed from K.S. Waves Ltd.

User’s Guide:
Steve Berkley, Bruce Bennett, Montara Creative Group, Ray Brunelle, and Heather Perkins

Package Design:
Montara Creative Group

Special Thanks to:
## Contents

### Chapter 1: Introducing Peak

- Welcome! ................................................................. 3
- Peak Features: ......................................................... 3
- Who Is Peak Designed For? ....................................... 4
- What's New in Peak 2.6? ........................................... 4
- New in Peak 2.5 ........................................................ 4
- Minimum System Requirements .................................. 4
- Maximizing Peak Performance .................................... 5
- About Your User's Guide ........................................... 5
- About Peak LE .......................................................... 6
- Using Online Help .................................................... 7
- Conclusion ............................................................... 8

### Chapter 2: Installing and Configuring Peak

- Installing Peak ......................................................... 11
- Authorization ........................................................... 12
- Making Audio Connections ........................................ 12
- PCI and PCMCIA Audio Cards .................................... 13
- Using the Inputs and Outputs of a Third-Party Audio Card .......................................................... 14
- ASIO and DAE .......................................................... 15
- USB and Firewire Audio Interfaces ............................... 15
- Conclusion ............................................................... 15

### Chapter 3: Peak Basics

- Introduction ........................................................... 19
- A Brief Explanation of Digital Audio ............................ 19
- About Disk-Based Recording and Editing ..................... 20
- Creating a New Peak Document ................................. 21
- Opening Existing Audio Documents .......................... 21
- Opening “Dual Mono” Files ....................................... 22
- Dragging and Dropping Folders, Disks, and CD Audio Tracks .......................................................... 23
- Saving and Closing Documents .................................. 23
  - Using the Save As... and Save A Copy As... Commands .......................................................... 24
- Peak Windows and Palettes ...................................... 25
  - Peak Audio Document Window ................................ 26
  - The Peak Cursor Palette .......................................... 26
  - The Contents Palette ............................................... 27
- Setting Preferences .................................................. 27
  - Setting Peak’s Playback Parameters .......................... 28
  - Show Marker Time .................................................. 29
  - Auditioning ............................................................ 29
  - Blending ................................................................. 30
  - Choosing Colors for the Audio Document Window .......................................................... 30
- The Toolbar .............................................................. 33
- Quitting Peak .......................................................... 34
- Conclusion ............................................................... 35
Chapter 6: Playlists and CD Burning

Introduction ....................................................................................................................................................... 85
Regions .................................................................................................................................................................... 85
Creating a Playlist .................................................................................................................................................. 87
Modifying Playlist Events .................................................................................................................................. 89
The Nudge Regions Dialog .................................................................................................................................. 90
Applying Plug-In Effects to Playlist Events ...................................................................................................... 90
Creating a New Audio Document from a Playlist ............................................................................................. 91
Exporting the Playlist as a Text Document ........................................................................................................ 91
Saving and Opening Playlists ............................................................................................................................. 92
Burning Audio CDs from Peak Playlists .............................................................................................................. 92
Peak’s Playlist and Toast ....................................................................................................................................... 92
Regions and the JAM Image file format ................................................................................................................ 93
Conclusion ............................................................................................................................................................ 93

Chapter 7: DSP

Introduction ............................................................................................................................................................ 97
Processing Audio with Peak’s DSP tools ............................................................................................................. 97
Peak’s Audio Processing Tools ............................................................................................................................. 97
Add ........................................................................................................................................................................... 97
Amplitude Fitter .................................................................................................................................................... 98
Change Duration .................................................................................................................................................... 98
Change Gain ......................................................................................................................................................... 99
Change Pitch ......................................................................................................................................................... 100
Convert Sample Rate .......................................................................................................................................... 100
Convolve ............................................................................................................................................................. 101
Crossfade Loop ................................................................................................................................................... 101
Dither ................................................................................................................................................................... 102
Invert ..................................................................................................................................................................... 102
Fade In & Fade Out .............................................................................................................................................. 102
Find Peak ............................................................................................................................................................. 103
Gain Envelope ...................................................................................................................................................... 103
Loop Tuner .......................................................................................................................................................... 104
Mono To Stereo/Stereo To Mono ......................................................................................................................... 104
Mix .......................................................................................................................................................................... 105
<table>
<thead>
<tr>
<th>Chapter 8: Plug-Ins</th>
<th>115</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction ..........</td>
<td>115</td>
</tr>
<tr>
<td>Processing Audio with Premiere and AudioSuite Plug-Ins</td>
<td>115</td>
</tr>
<tr>
<td>Adobe Premiere Format Plug-Ins</td>
<td>115</td>
</tr>
<tr>
<td>Installing Adobe Premiere Plug-ins</td>
<td>115</td>
</tr>
<tr>
<td>Premiere Plug-in Memory Settings</td>
<td>116</td>
</tr>
<tr>
<td>Premiere Plug-In Preview Time</td>
<td>116</td>
</tr>
<tr>
<td>RealTime Premiere Plug-In Processing</td>
<td>117</td>
</tr>
<tr>
<td>Premiere Envelope</td>
<td>117</td>
</tr>
<tr>
<td>TDM Plug-Ins</td>
<td>118</td>
</tr>
<tr>
<td>Bouncing your TDM plug-in assignments</td>
<td>119</td>
</tr>
<tr>
<td>Using TDM plug-ins with the Batch File Processor</td>
<td>119</td>
</tr>
<tr>
<td>AudioSuite Plug-Ins</td>
<td>120</td>
</tr>
<tr>
<td>VST Plug-Ins</td>
<td>120</td>
</tr>
<tr>
<td>Bouncing your VST plug-in assignments</td>
<td>121</td>
</tr>
<tr>
<td>Recording through VST plug-ins</td>
<td>121</td>
</tr>
<tr>
<td>Using VST plug-in with the Batch File Processor</td>
<td>122</td>
</tr>
<tr>
<td>Conclusion</td>
<td>122</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 9: Batch File Processor and Apple Events</th>
<th>125</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>125</td>
</tr>
<tr>
<td>Batch File Processor</td>
<td>125</td>
</tr>
<tr>
<td>Peak’s Audio Librarian Tools</td>
<td>128</td>
</tr>
<tr>
<td>Apple Events™ Support</td>
<td>128</td>
</tr>
<tr>
<td>Conclusion</td>
<td>130</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 10: Samplers</th>
<th>133</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>133</td>
</tr>
<tr>
<td>Working with SMDI Samplers</td>
<td>133</td>
</tr>
<tr>
<td>SMDI Samplers supported in Peak (at time of printing):</td>
<td>133</td>
</tr>
<tr>
<td>SMDI Samplers</td>
<td>133</td>
</tr>
<tr>
<td>A note about the Yamaha A3000</td>
<td>136</td>
</tr>
<tr>
<td>Working with the Roland S-760 Sampler</td>
<td>136</td>
</tr>
<tr>
<td>Working with AKAI samplers</td>
<td>138</td>
</tr>
<tr>
<td>MIDI Sample Dump Standard</td>
<td>139</td>
</tr>
<tr>
<td>MIDI Sample Dump Standard</td>
<td>140</td>
</tr>
<tr>
<td>Error Messages &amp; Troubleshooting</td>
<td>140</td>
</tr>
</tbody>
</table>
Chapter 11: Peak Menus

File Menu ............................................................................................................................................................................. 149
New ........................................................................................................................................................................................................... 149
Open......................................................................................................................................................................................................... 149
Close ...................................................................................................................................................................................................... 150
Close All ................................................................................................................................................................................... 150
Save ........................................................................................................................................................................................................ 150
Save As.................................................................................................................................................................................... 150
Save A Copy As... ................................................................................................................................................................... 151
Import CD Track .................................................................................................................................................................. 151
Import Dual Mono ................................................................................................................................................................. 152
Export Dual Mono ............................................................................................................................................................... 152
Export Regions ...................................................................................................................................................................... 152
Export as Text... .................................................................................................................................................................. 153
Batch Processor: ................................................................................................................................................................. 153
Recently Opened Documents .................................................................................................................................................. 154
Quit .................................................................................................................................................................................................. 154

Edit Menu ........................................................................................................................................................................... 155
Undo ................................................................................................................................................................................................... 155
Redo ..................................................................................................................................................................................................... 155
Edits... .................................................................................................................................................................................................. 155
Cut ..................................................................................................................................................................................................... 155
Copy .................................................................................................................................................................................................... 155
Paste .................................................................................................................................................................................................. 156
Replace ................................................................................................................................................................................ 156
Insert .................................................................................................................................................................................................. 156
Insert Silence ..................................................................................................................................................................... 156
Silence .................................................................................................................................................................................................. 156
Delete .................................................................................................................................................................................................. 156
Delete Except Audio ............................................................................................................................................................ 156
Crop .................................................................................................................................................................................................. 156
Clear Clipboard ................................................................................................................................................................. 156
Select All .............................................................................................................................................................................. 156
Insertion Point at Selection Start/End ................................................................................................................................. 157
Set Selection ....................................................................................................................................................................... 157
Select Loop ........................................................................................................................................................................... 157
Previous Selection/Next Selection ....................................................................................................................................... 157

Action Menu ....................................................................................................................................................................... 157
Zoom Out .............................................................................................................................................................................. 157
Zoom In ................................................................................................................................................................................ 157
Increase Vertical Zoom ........................................................................................................................................................ 158
Decrease Vertical Zoom ........................................................................................................................................................ 158
Fit Selection ......................................................................................................................................................................... 158
Zoom Out All the Way .......................................................................................................................................................... 158
Zoom at Sample Level ................................................................. 158
Zoom at Sample Level (End) ....................................................... 158
Snap Selection to Zeros .............................................................. 158
Loop This Selection .................................................................. 158
Nudge Loop Backward .............................................................. 158
Nudge Loop Forward ............................................................... 158
New Marker .............................................................................. 158
New Region .............................................................................. 159
Markers to Regions ................................................................. 159
Nudge ..................................................................................... 159
Go To ...................................................................................... 160
Loop Surfer ............................................................................. 160
Guess Tempo ........................................................................... 160
Audio Menu ............................................................................. 161
Rewind ..................................................................................... 161
Play ......................................................................................... 161
Play Selection ........................................................................ 161
Play w/Auditioning ................................................................. 161
Pause ...................................................................................... 161
Stop ......................................................................................... 161
Stop & Extend Selection ........................................................... 161
Fast-Forward .......................................................................... 161
Record ..................................................................................... 161
Record Settings ...................................................................... 162
SMpte Sync ............................................................................ 165
Arm External Sync ................................................................. 165
Hardware Settings ................................................................. 165
Meters ...................................................................................... 165
DSP Menu ............................................................................... 166
Add ......................................................................................... 166
Amplitude Fit ......................................................................... 166
Change Duration ..................................................................... 167
Change Gain .......................................................................... 167
Change Pitch .......................................................................... 167
Convert Sample Rate .............................................................. 168
Convolve ............................................................................... 168
Crossfade Loop ..................................................................... 168
Dither .................................................................................... 168
Invert ..................................................................................... 168
Fade In & Fade Out .................................................................. 168
Find Peak ............................................................................... 169
Gain Envelope ........................................................................ 169
Loop Tuner ............................................................................ 169
Mono To Stereo/Stereo To Mono .............................................. 169
Mix ....................................................................................... 170
Modulate ............................................................................... 170
Normalize ............................................................................... 170
Panner .................................................................................. 171
Phase Vocoder ....................................................................... 171
Rappify ................................................................................ 171
Repair Click .......................................................................... 172
Repair Clicks ......................................................................... 172
Remove DC Offset .................................................................. 173
Reverse Boomerang ............................................................... 173
Reverse ................................................................................ 173
Swap Channels ........................................................................ 173
Table of Contents
Chapter 1
Introducing Peak
Chapter 1: Introducing Peak

Welcome!

BIAS Peak™ is an advanced audio application that provides superior tools for editing and processing digital audio on the Macintosh computer. Peak was specifically designed to meet the needs and demands of audio professionals. By combining high-quality direct-from-disk digital audio editing features with a lightning fast, completely nondestructive editing environment, Peak provides unsurpassed audio editing power, and makes a superb addition to multitrack audio applications programs such as BIAS Deck and Digidesign’s Pro Tools®. Peak also offers advanced sampler support, and works directly with many popular MIDI sampling keyboards and rackmount samplers.

Peak Features:

- Direct-to-disk recording and playback at all sample rates supported by the sound hardware on your Macintosh, or supported through third-party audio hardware
- User-configured waveform display
- Support for commonly used audio document formats, including AIFF, Sound Designer II™, Red Book, QuickTime™, Wave, RealAudio™, Shockwave™, MPEG-3 (MP3), SUN .au, and System 7 Sound formats
- Completely nondestructive file-based editing with unlimited undo and redo
- Professional editing abilities, including user-definable fade curves, silence, and complete support for cut/copy/paste with multiple undo
- By using an application that supports Apple Events, such as Filemaker Pro™ or HyperCard™, you can catalog your Peak sound files and audition them from within the application
- Support for third-party digital audio hardware, such as the Digidesign™ or Mark of the Unicorn™ digital audio boards, through the Macintosh Sound Manager and ASIO
- Support for 8, 16, 24, and 32 bit audio files
- Support for playback and recording through Digidesign DAE™
- Support for third-party Adobe Premiere™, AudioSuite™, TDM™, and VST™ Plug-Ins, allowing you to add advanced signal processing features to Peak. Plug-Ins from companies such as BIAS, Waves™, Arboretum™, and Cycling '74™ can be used to empower Peak with digital filtering, noise reduction, reverb, equalization, and other effects in real time
- The ability to create audio CDs from a Peak Playlists using Roxio Toast™, which is bundled with Peak
- SMPTE synchronization
- Sophisticated Tools for looping, including Loop Surfer, Loop Tuner, and Guess Tempo
- Sampler Support
- Playlist editing and mastering
- Customizable Toolbar
- QuickTime Movie window with scrubbing
- Real Audio 5.0 support
Who Is Peak Designed For?

Peak is designed for a wide variety of users, ranging from composers and multimedia producers to sound designers and remix editors. Peak’s comprehensive recording, editing, looping, and processing capabilities make it a powerhouse tool for virtually any aspect of digital audio production. If you are interested in sound and possess imagination and creativity, Peak is for you.

What’s New in Peak 2.6?

Version 2.6 of Peak software has several new features and enhancements, including:

- WAVES Audiotrack and Vbox SE VST plug-ins.
- Pressing control-arrow keys scrolls the audio display left or right.
- Swap Channels DSP command to reverse the left and right channels in a stereo selection.
- Improved Edit Marker dialog, with more options for time units.
- Disable all VST plug-ins after bouncing.
- Compatible with DAE 5.1.
- Monitor ASIO devices through the Sound Manager.
- Option in the Import CD dialog to open files after importing from CD.
- Flattening Quicktime movies when creating QuickTime files to play on both Macintosh and Windows operating systems.
- 160kbps and 192kbps MP3 and Shockwave export options.
- Allows aliases to point to the VstPlugIns folder, the ASIO Drivers folder, or the Peak Plug-In folder.
- Automatic truncation of file names for audio documents created by Export Regions and Import CD if they are longer than 31 characters.
- And more!

New in Peak 2.5

Version 2.5 of Peak software presented several new features and enhancements, including:

- New user interface
- VST Plug-In Support for playback and recording
- Support for more third-party SCSI cards and Samplers
- Support for the CDDB™ online CD Data Base when using the Import CD Audio
- Dither
- Improved Guess Tempo
- Improved metering
- Single instance Repair Click
- Save A Copy As . . .
- New floppy-less, user-friendly registration and authorization

Minimum System Requirements

To use Peak you will need:

- Any PowerPC-equipped Macintosh or PowerPC-equipped PowerBook or G3/G4 Macintosh
- 64MB of RAM
- Sound Manager version 3.3 or later
- Macintosh System Software 7.6.1 or later (8.6 recommended)
• QuickTime version 3.0.2 or later
• QuickTime PowerPlug™ installed in the Extensions folder
• A hard drive with 18ms or faster average seek time
• A 13-inch or larger monitor (color is recommended)

The optimal system for use with Peak software is a Power Macintosh with AV (Audio Visual) features and 32MB or more of RAM available to run Peak. The Peak application runs in native mode on Power Macintosh and G4 computers. Peak can also take advantage of ASIO and DAE compatible sound cards in addition to sound cards with Apple Sound Manager drivers.

**Maximizing Peak’s Performance**

To get the best performance out of Peak and your Macintosh, do the following.

**To maximize Peak performance:**

• Use a minimal number of System Extensions. Extensions can slow down your Macintosh by using precious processor cycles. In particular, turn off System Extensions such as menu bar clocks and screen savers that are in constant operation. To set up a dedicated set of extensions for Peak, duplicate your Mac OS Base extensions set in the extensions manager and rename it (something like Peak_set), restart your computer with this extensions set and install Peak, enable the additional extensions required for Peak to run, and, restart your computer with this updated extensions set.

• Set your monitor to no more than thousands of colors (256 colors is recommended for older Macs).

• Turn File Sharing off, unless you need it.

• Disconnect your Macintosh from any networks and turn off AppleTalk, unless you need to be on a network.

• Use the Memory control panel to set the Macintosh’s disk cache to at least 384k (usually the Mac’s default setting is fine). Turn Virtual Memory Off.

• Allocate additional RAM to Peak if possible, using the Finder’s Get Info command. (Select Peak in the Finder, choose Get info from the Finder’s Special menu, and enter the desired amount in the Preferred Size field. Make sure you allocate more RAM than the amount indicated in the Minimum Size field!)

• Optimize your hard drive. (See Chapter 3 to learn about proper hard disk maintenance.)

**About Your User’s Guide**

Peak is designed to be simple and intuitive. Your User’s Guide is designed to help you set up and use Peak for digital recording and editing as quickly and easily as possible.

This User’s Guide assumes that you are familiar with standard Macintosh operating techniques, including:

• Setting up, starting, and using your Macintosh
• Choosing commands from menus
• Double-clicking, selecting, Shift-selecting, and dragging with the mouse
• Opening, copying, saving and deleting files
• Opening, closing, scrolling, moving, re-sizing, and selecting Macintosh windows

If you don’t know how to perform these tasks, please refer to your Macintosh User’s Guide and spend a little time learning about your Macintosh before going any further. This will make using Peak much easier and more enjoyable.
The Chapters in your Peak User’s Guide are arranged in the order in which you would typically perform tasks when embarking on an audio production project:

- Chapter 1 introduces you to Peak and explains some of the requirements for using Peak software
- Chapter 2 explains how to install Peak software and configure your Macintosh for recording and playback
- Chapter 3 introduces you to some basic concepts of digital audio and disk-based recording, as well as basic Peak operations
- Chapter 4 explains how to record and playback audio to and from hard disk in Peak using the Apple Sound Manager, ASIO, and DAE. It also explains how to import audio from compatible CD-ROM drives
- Chapter 5 introduces you to the concepts and techniques of nondestructive editing with Peak
- Chapter 6 explains how to create regions and sequence their playback using Playlists, as well as how to use Peak Playlists to burn audio CDs
- Chapter 7 explains how to use Peak’s native DSP tools
- Chapter 8 explains how to use third-party Premiere, TDM, AudioSuite, and VST plug-ins to enhance Peak’s audio production capabilities
- Chapter 9 explains how to use Peak’s Batch File Processor as well as how to use Apple Events for file management
- Chapter 10 explains how to import samples directly from compatible samplers (to edit or process the audio using all of Peak’s functions) and send the modified sample back to the sampler
- Chapter 11 describes each of the commands found in Peak’s menus
- Appendix 1 lists the default Keyboard Shortcuts for Peak

- Appendix 2 provides a troubleshooting guide for commonly encountered problems
- Appendix 3 describes how to use Peak’s RealAudio™, Shockwave™ Audio Encoder, and MP3 encoding to prepare audio for streaming over the internet
- A Glossary and an Index complete your Peak User’s Guide

⚠️ Look for important tips and notes whenever you see this exclamation mark.

About Peak LE

If you are using the limited edition of Peak, not all features will be available. Specifically, the following features are not available in Peak LE:

- 24 and 32 bit support
- Crossfades, DSP effects, and Gain Adjustment in Peak LE Playlists
- Loop Surfer™ and Loop Tuner
- Customizable Keyboard Shortcuts
- Customizable Toolbar
- Remove DC Offset
- Pitch Change
- DAE/TDM/AudioSuite support
- VST plug-in support
- SMPTE sync
- Import Dual Mono
- Meters Dialog
- QuickTime movies
- Batch File Processor
- Up to three Premiere plug-ins only with three second preview limit
Using Online Help

Peak provides two types of online help. The first type, Balloon Help, can be activated by selecting Show Balloons from the Macintosh’s Balloon Help menu in the Finder. Balloon Help will show you the functions of each menu item as you move the mouse across different menu items. If you enable Speak Help under Peak’s Preference menu, the Balloon Help for items in the Toolbar will be “spoken” by your computer using the Apple Speech Manager. Also, if you hold the mouse cursor over a Toolbar icon for 2 seconds, the Balloon Help for that icon’s function will appear.

The second type of online help is available via the Apple menu’s Help item. This help system gives you detailed information about how to use the Peak software.

Online Help is available in the Apple menu

About Peak SE

Peak SE is functionally the same as Peak LE but adds sampler support.

Features that are not supported in Peak LE or Peak SE will show this icon in the manual. LE features will also appear grayed out in their menus.
Conclusion

Now that you know a little about Peak, proceed to the next chapter to learn how to install your software and get started using it.
Chapter 2
Installing and Configuring Peak
Chapter 2: Installing and Configuring Peak

Installing Peak

Peak's auto-installer software makes installation very easy.

Your complete Peak system consists of:

• CD-ROM Installer
• Peak serial number and Product Authorization Code (PAC)

⚠️ Before you install Peak, please check the Minimum System Requirements on Page 4 of this Users Guide.

The Installer dialog

To install Peak:

1. If you are using any virus-protection software, turn it off or temporarily remove it, and restart your Macintosh.

2. Insert the Peak Install CD-ROM in your CD-ROM drive, open the Product Installers folder, and double-click the Install Peak icon.

3. When the Installer dialog appears, read the Read Me for late-breaking information concerning the Installer, then click Continue to proceed.

4. Select where you would like to install Peak, using the Switch Disk pop-up menu.

5. Click Install at the bottom right of this dialog.

6. After you have clicked Install, follow the on-screen instructions. Peak will be installed into a folder named Peak 2.5 on your selected hard disk.

7. At the end of the installation, the installer will allow you to register Peak electronically, which you may find more convenient than mailing your registration card.
8. When the installation is complete, a message will appear indicating that the installation was successful. Click Quit to quit the Installer, or click Continue to install additional copies (don’t forget to turn back on any virus-protection software that you may be using the next time you restart the computer).

⚠️ If you don’t register Peak, you will not be eligible for technical support and you won’t be notified about updates, upgrades and other important news from BIAS!

### Authorization

Peak must be authorized to work on your Macintosh. To authorize Peak, you will need your Product Authorization Code (PAC) in addition to the serial number that appears on your Peak Owner’s Certificate. BIAS will provide you with your Product Authorization Code when you register Peak. **You must register Peak in order to obtain your Product Authorization Code; Peak will not launch after the 14 day registration period unless you authorize Peak with your Name, Organization, Serial Number, and Product Authorization Code!**

When you first launch Peak, it will prompt you to authorize it by entering your Name, Organization, Serial number, and Product Authorization Code.

⚠️ Send in Your Registration Card! After you have installed Peak, please send in the Registration Card included with your software to receive your Product Authorization Code, free technical support, software updates and notification of upgrades.

Peak will run, fully functional, in Registration Mode for 14 days. This allows you the time necessary to register your product and get the Product Authorization Code from BIAS.

### Making Audio Connections

While it is possible to listen to Peak using a Macintosh’s built-in speaker (or headphones, as might be the case with a PowerBook), most people will prefer to listen through a better quality external speaker system.

It is very easy to set up audio connections between your Macintosh and a mixer or speaker system. Your exact setup will differ slightly depending on whether you are using the built-in sound input and output connectors on your Macintosh, or those of a plug-in audio recording/playback card. Instructions for each case are given below.

#### Using the Macintosh’s Built-in Inputs and Outputs

If you wish to use your Macintosh’s built-in audio
inputs and outputs for recording and playback, do the following:

1. Turn down the volume on your playback system. Peak can be used with a variety of playback systems, including:
   - a stereo receiver or amplifier and speakers
   - a mixer, amplifier, and a pair of speakers
   - a mixer and a pair of amplified (self-powered) speakers
   - or simply a pair of amplified (self-powered) speakers, smaller versions of which are often called “multimedia” speakers.

2. Connect your audio source output to the Macintosh’s audio input connector. Your audio source can be one of a variety of devices, such as:
   - a cassette or DAT deck output
   - a mixer output
   - a stereo receiver line output (such as “tape deck record” output)
   - an instrument line output (such as the output of a synthesizer).

   The audio input jacks on most Macs are a standard mini-plug (1/8-inch) connector. Most source outputs are either 1/4 inch “phone” connectors or RCA connectors. To make this connection, you may need to use an 1/4-inch to mini-plug or RCA to mini-plug cable or adapter.

3. Connect your Macintosh’s audio output to your playback system’s input. The Macintosh’s audio output jack is a standard stereo mini-plug (1/8-inch) connector. Most mixer, receiver, and amplified speaker inputs are equipped with 1/4-inch, RCA, or mini-plug jacks. To make this connection, you may need to use a mini-plug to 1/4-inch or mini-plug to RCA cable or adapter.

4. Raise the volume on your mixer or playback system. Your system should now be properly configured and ready for recording and playback.

**PCI and PCMCIA Audio Cards**

If you have a Sound Manager-compatible record/playback card (such as the Digidesign AudioMedia III or the MOTU PCI-324) or ASIO compatible (such as the Yamaha DSP Factory or the Digigram VX)
Pocket) installed in your computer and wish to use its input and output capabilities instead of your Macintosh’s built-in capabilities, do the following:

1. Turn down the volume on your mixer or playback system.

2. Make sure that you have installed the plug-in audio card into one of the available expansion slots inside your Macintosh. If you are not sure how to do this, please refer to the instructions that came with your Macintosh and the audio card itself.

3. Install the Sound Manager and/or ASIO drivers for your sound card. Please refer to the installation instructions for your sound card on how to do this.

4. Connect your mixer’s output to the audio cards input connectors. (Some audio cards have an external interface box which contains the input connectors.)

5. Connect your audio cards outputs to your mixer’s (or playback systems) input. Note that some audio expansion cards have an external interface box which contains the output connectors.

6. Raise the volume on your mixer or playback system. Your system should now be properly configured and ready for recording and playback.

A typical mixer/computer configuration is to have the computer outputs go to channel inputs on your mixer and to have the auxiliary or bus sends from the mixer go to the inputs of the computer. Instruments you want to record you patch into other channel inputs on the mixer and you can then route them out the auxiliary or bus sends on the mixer to be recorded by the computer. The mixer’s main outputs go to the amplifier/speakers.

Using the Inputs and Outputs of a Third-Party Audio Card

Peak supports many Sound Manager compatible, ASIO compatible, and DAE compatible third-party audio cards, including those made by Digidesign, Digigram, and Mark of the Unicorn. In order to effectively use these cards with Peak, you will need to make sure you have installed the sound manager drivers supplied by the manufacturer (the Peak installation disk includes Apple Sound Manager drivers for some hardware, though most hardware manufacturers include their own drivers). If you haven’t already installed your sound cards sound manager drivers, please do so now. In most cases, you will need to place the card’s sound manager driver extension in your System folder’s Extensions folder. After you have done this, restart your computer.

Please see Chapter 4: Playback and Recording for a detailed description of how to configure Peak to playback and record using the Apple Sound Manager.

If your sound card also has an ASIO 1.0 driver or a backwards compatible ASIO 2.0 driver you will want to put it into Peak’s ASIO Drivers folder.

If you have Digidesign hardware that supports DAE 3.4.x or Digidesign TDM hardware that supports DAE 3.4.x or later, you will want to be sure to install the correct version of the DAE and the DigiSystem Init as well as the Digidesign Sound Manger Drivers.

To use a third-party audio card’s outputs for previewing Premiere-format plug-ins, the Open dialog, and the Import CD Audio dialog:

1. Choose Sound Out from the Sound Control Panel
2. Select audio card (Digigram’s VX Pocket is shown in this example) as the sound output device.

The Apple Sound Control Panel

3. Close the Sound window when you have finished.

The settings you make in the Sound Control Panel’s Sound Output panel will only affect playback through Premiere plug-ins, the Open dialog, and the Import CD Audio dialog. For playback, you will need to select your audio card in Peak’s Sound Out menu.

ASIO and DAE

Peak also supports ASIO 1.0 and DAE 3.4 or later. If you want to use Peak with your sound card via ASIO, place the ASIO driver for your sound card in the Peak ASIO Drivers folder. For DAE, simply install DAE 3.4 or later. For more detail on using Peak with ASIO and/or DAE supported sound cards, please read Chapter 4: Playback and Recording.

USB and Firewire Audio Interfaces

Mac OS 9.0.4 supports USB Audio on iMacs, iBooks, B/W G3s, and G4s. Peak supports USB audio with interfaces such as the Tascam US-428. Peak also supports compatible Firewire audio interfaces, such as the MOTU-828.

Conclusion

Now that you have installed Peak and configured the Macintosh Sound Manager for recording and playback, proceed to the next chapter to learn several basic concepts and functions essential to using Peak.
Chapter 3
Peak Basics
Chapter 3:  
Peak Basics

Introduction

This chapter explains several key Peak concepts and functions, including how to open, close, and save audio documents.

A Brief Explanation of Digital Audio

If you are new to digital hard-disk-based recording, you may wish to acquaint yourself with a few of the principles behind digital audio before you dive into using Peak software. This section explains a few key concepts that will give you a good general understanding of how Peak does what it does.

What we hear as sound is actually a pattern of pressure waves that move through the air. The frequency of these waves determines the pitch of the sound — how low or high it sounds. Sound frequency is measured in cycles per second, or Hertz (Hz). The range of human hearing is generally considered to be from about 20 at the low end to 20,000 Hertz (20 kilohertz, or 20kHz) at the high end. In practice, however, most adults hear only as high as 12kHz to 18kHz, especially those of us who may have spent more time than we should have with headphones or at loud rock concerts.

Sampling and Sample Rate

Your Peak software-equipped Macintosh computer stores audio digitally. This means that analog electrical signals from microphones or other sources are converted into numbers by a circuit called an analog-to-digital converter and stored on hard disk. The analog-to-digital (A/D) converter uses a technique called digital sampling to convert analog electrical signals into numbers.

Digital sampling is the sonic equivalent of taking a snapshot. By taking thousands of little digital samples per second and storing them to a hard drive, an A/D converter can capture an accurate sample-by-sample representation of a sound, much like a movie is a frame-by-frame representation of a moving image. The number of samples taken of the audio in a second is called the sample rate.

The sample rate determines the recording’s upper frequency response. A higher sample rate delivers higher frequency response. As a rule of thumb, a digital recording’s upper frequency response is roughly half of its sample rate. The audio on compact discs, for example, is recorded at 44,100 samples each second, or 44.1kHz. This sample rate is the standard for professional-quality digital audio, and provides an upper-end frequency response of approximately 22,550Hz, somewhat higher than most people’s hearing range.

Bit Resolution

Another factor that affects the quality of the audio is the resolution of each sample. The greater the resolution, the better the quality. To use an analogy from the film world, just as image resolution and quality increase with film size (8 millimeter film is much lower in image quality than 70 millimeter film) greater bit resolution (8-bit, 16-bit, and 24-bit) results in better fidelity digital audio. Audio CDs have a resolution of 16-bits.

In practice, the bit resolution determines the recording’s dynamic range — that is, how many
distinct steps you have to describe a sound’s level, from quiet to loud. For instance, an 8-bit recording has 256 \(2^8\) levels available, which is the equivalent of 48 decibels (dB) of dynamic range. On the other hand, a 16-bit recording has 65,536 \(2^{16}\) levels available, equivalent to 96dB dynamic range. (The rule of thumb for dynamic range is to take the bit rate and multiply it by 6.)

---

**About Disk-Based Recording and Editing**

If you are new to hard-disk-based recording, you will be pleased at the amount of power and control that Peak software provides for recording and editing digital audio. You will encounter several new concepts and techniques for using a disk-based system such as Peak. Perhaps the most important among these is the concept of nondestructive manipulation of audio.

**Nonlinear Versus Linear Recording**

Nondestructive audio manipulation is possible thanks to the nature of Peak’s recording medium: a hard disk instead of a roll of analog tape. Unlike analog tape, which is a linear recording medium, hard disks provide a nonlinear, or random-access medium. This is because audio is stored on hard disk as digital information which the hard disk can access immediately or randomly (hence the term “random-access”), simply by moving its read/write head to the appropriate location and reading the appropriate data. This allows you to perform such miraculous feats as cutting and pasting “pieces of sound” and rearranging material long after it has been recorded.

**Nondestructive Editing**

Perhaps most impressive is the fact that with disk-based audio production you need not actually modify the original source material in any way to accomplish these feats. In most cases, by cutting and pasting you are in reality only asking the hard disk to access portions of the audio file in a slightly different order.

Since Peak doesn’t normally cut up, move around, or delete the actual recording on the hard drive, it’s said to be a nondestructive editing system.

Other manipulations, such as playing audio material backwards, can be accomplished by reading the data in reverse order. The power and flexibility of disk-based audio production software such as Peak far surpasses the capabilities of traditional analog audio production tools.

**Hard Disk Storage Requirements**

The actual recording of audio to hard disk requires a significant amount of storage. This is directly affected by the sample rate and bit resolution at which you record: the higher the fidelity, the greater the requirements for storage. As a guideline, 16-bit, 44.1kHz audio requires roughly 5 megabytes of storage per minute of mono recording. Stereo 16-bit, 44.1kHz audio requires roughly 10 megabytes per minute. Stereo 24-bit, 44.1kHz audio requires roughly 15 megabytes per minute.

**Hard Disk Maintenance**

Because audio recording and playback is a hard disk-intensive task, it is important that your hard drive be in good operating condition. In the computer world, this means keeping it from becoming fragmented by using hard drive maintenance software. Fragmentation occurs as your hard drive begins to run out of contiguous (uninterrupted) space where it can write files. If the data that makes up a file is stored at a single location on your drive, it is much easier and faster for your drive to find the data and read it. However, as contiguous space runs out, the drive may not be able to write the entire file in one location and instead must fragment the file by writing pieces of it at various locations in whatever smaller open areas it can find. This requires that the drive search near and far to read the pieces of the file. Too much fragmentation can lead to errors in recording and playback as the hard drive struggles to keep up with the demands of your audio application.
In general, you should keep your hard disk below 10% fragmentation. Most hard drive maintenance software packages let you monitor the degree of fragmentation on your drive and defragment it by rewriting files into contiguous blocks of data. In addition to defragmenting your drive regularly, you should also back up your files and reformat your drive on a regular basis to keep your system in top operating condition. By doing this, you will ensure maximum performance from your Macintosh and Peak software and keep your studio running smoothly.

Now that you understand some of the basic principles behind digital audio and disk-based recording, take a few moments to learn some of the basic operations of Peak. These are covered in the sections that follow.

### Creating a New Peak Document

Peak will allow you to create an empty audio file of zero duration by choosing a new mono or stereo document. However, you would typically record audio into Peak to create a new audio file or open an existing audio file into Peak for editing. Peak allows you to have multiple audio documents open at the same time.

**To create a new audio document:**

1. Choose New (⌘-N) from the File menu or Toolbar. This command provides a hierarchical menu which allows you to choose either a mono or stereo format for the new document.

2. When a new empty window appears, you are ready to begin your project.

### Opening Existing Audio Documents

Peak allows you to open audio files created in a variety of common audio formats including AIFF, Sound Designer II, QuickTime, Red Book, WAVE, .au, .snd, System 7 Sounds, and even MP3 (if you are running QuickTime 4.x or later).

#### Opening WAVE files

The Macintosh recognizes files using a “type” and “creator.” WAVE files are recognized by some audio applications with a type “.WAV,” while others recognize only “WAVE” as the type.

Peak, along with Apple’s QuickTime software and most other Multimedia applications, recognize WAVE files of the type “WAVE,” but not of type “.WAV.” You can use ResEdit or other third-party applications to ensure your WAVE files have the correct type prior to attempting to opening them with Peak.

#### Opening Compressed Audio Documents

AIFF/AIFC and QuickTime files with compression such as MACE 3:1, MACE 6:1, IMA 4:1, QDesign, or μlaw are compatible with Peak. If Sound Manager version 3.3 or later is installed, Peak can open these files for editing.

**To open an audio file:**

1. Choose Open (⌘-O) from the File menu.

2. In the dialog that appears, locate the file that you wish to open. From this dialog, you can open AIFF, Sound Designer II, QuickTime, RedBook, WAVE, .au, .snd, System 7 Sound, and MP3 formatted audio files. This dialog also allows you to audition files by selecting the file in the list and then clicking the Play button.

3. When you find the file you wish to open, click the Open button and Peak will open the audio file
into a new audio window, displaying an overview of the entire sound. You can open multiple files before proceeding to step 4.

4. When you are finished opening audio documents, click the Done button.

The Open dialog

Recent Documents

Peak automatically remembers up to the last eight audio documents that you have opened and keeps a list of these at the bottom of the File dialog. This allows you to easily select a document’s name and reopen it without having to search on your hard drive. Peak can find and open a document even if you have changed its location on your hard drive. If you change the name of the file, the next time you open Peak, it will automatically update the name in its internal list.

Opening “Dual Mono” Files

Certain audio applications, such as BIAS Deck and Digidesign’s Pro Tools do not directly support stereo interleaved files, and instead use “dual mono” files, which comprise the right and left channels of stereo material. Peak allows you to open such dual mono files, and in the process creates a new stereo audio document. Because Peak actually writes a new stereo audio file to disk, this conversion process requires hard disk space equivalent to the two original mono files.

Please note that the Import Dual Mono command requires that both files be mono files and have the same sample rate.

To open a dual mono file:

1. Choose Import Dual Mono from the File menu.
2. In the dialog that appears, locate the desired files.

3. Select either half of the dual mono file and click Open. Peak imports the first file and then prompts you for the second.

4. Select the second audio file and click Open. When Peak has finished creating the new stereo audio document you can begin editing.

⚠️ For simpler importing of Dual Mono files, turn on the Auto Import Dual Mono feature in the Preference menu. With this feature activated, you can automatically import dual mono files by choosing Open from the File menu and selecting one of the dual mono file’s channels. Peak will then create a new stereo document containing both channels. Please note that these dual mono files must have exactly the same file name with the suffix “.L” for the left channel and “.R” for the right channel.

Peak also allows you to export your stereo audio documents in Dual Mono format, which means that it’s easy to import dual mono tracks from Pro Tools into Peak, edit and process them within Peak, and then export them as Dual Mono files to be reincorporated into your Pro Tools sessions.

**Saving and Closing Documents**

It is good practice to save regularly throughout a project to avoid losing valuable work in the event of a power failure or other unfortunate occurrence. The Save command saves the changes you have made to your audio document by writing it to your hard disk. The Save command cannot be undone. If you want to be able to continue to undo your edits, use the Save a Copy As... command under the file menu.

Peak allows you to save your audio documents in a variety of common audio file formats, each of which is described below. Be aware that different formats allow different information to be stored with the file. Peak preserves this information unless you save the file into a different file format. Saving a file in a format different from its original format may, however, cause some information stored in the file to be discarded.

**Peak supports the following audio file formats:**

- **AIFF**: This is Apple’s Audio Interchange File Format. It is also Peak’s default file format and is supported by many Macintosh software applications.

- **Sound Designer II**: This is Digidesign’s audio file format for its digital audio products. Use this format if you wish to use an audio document in a Digidesign audio application.

- **.au**: This file format is commonly used on the World Wide Web and in Java audio applets. It is supported by many platforms and programs.

---

**Dragging and Dropping Folders, Disks, and CD Audio Tracks**

In addition to opening individual documents by dropping them onto the Peak application’s icon, you can now drop entire folders or disks onto the Peak application’s icon. The contents of the disk or folder(s) will be scanned entirely for audio document’s that Peak can open, such as QuickTime, .WAV, AIFF, .au, Sound Designer II, Red Book, etc.

⚠️ This feature is particularly useful when used with Peak’s Batch File Processor, described later in this manual.
• **WAVE**: This is Microsoft’s Windows Audio File Format. It is supported by many Window’s software applications and some Macintosh applications. The WAVE format is best if you plan to use an audio document in an application that supports or requires WAVE format files.

• **QuickTime**: This is Apple’s audio file format for QuickTime-based multimedia. It is supported by all Macintosh software applications that support QuickTime. The QuickTime format is best if you plan to use an audio document in multimedia applications that support QuickTime, such as Adobe Premiere or Macromedia Director™.

• **Raw**: This is the header-less raw file format that may be useful for some game platforms.

• **RealAudio**: This is the file format for RealNetworks™ RealAudio 5.0, 3.0 and 2.5 Encoders, used for preparing audio for streaming over the internet.

• **System 7 Sounds**: This is the Apple audio file format used for Macintosh Operating System Sounds.

• **JAM image files**: This is the JAM audio image file format. JAM audio image files may be created in Peak and used in Roxio JAM for burning audio CDs.

• **Sonic AIFF**: The file format used by Sonic Solutions audio workstations.

• **.paf**: This is the file format used by E-mu’s Paris audio system. Note this file format favors mono and dual mono files.

• **Shockwave**: This is the file format used for Macromedia’s Shockwave, for preparing audio for streaming over the internet (the SWA Export Xtra must be in the Peak Plug-Ins folder for this option, see Appendix 3 for the URL).

• **MP3**: This saves your document in MP3 format (the SWA Export Xtra must be in the Peak Plug-Ins folder for this option, see Appendix 3 for the URL).

---

### To save a Peak document:

1. Choose Save from the File menu or press ⌘-S on your keyboard.

2. Select a file format from the pop-up File Type menu. AIFF is Peak’s default audio file format.

3. Enter a name for the new audio document, select where you want to save the new file, and then click Save.

### Using the Save As... and Save A Copy As... Commands

The Save As... command allows you to save a copy of the current document under a different name, or in a different location on your hard disk. Since the Save As command closes the current document and lets you keep working on the renamed copy, it is useful for saving successive stages of a project. This allows you to save each major step under a different name. Later you can retrace your steps should you want to go back to an earlier version. The Save A Copy As... command will save a copy of the file you are working on, but it will keep the copy you are working on open. This allows you to continue working on your audio and still be able to undo any edits you executed prior to using the Save A Copy As... command.

### To save an audio document under another name:

1. Choose Save As... (Shift-⌘-S) or Save A Copy As... (Option-⌘-S) from the File menu. The Save dialog appears:

   ![The Save dialog](image)

   This document will occupy approximately 16% of disk space
2. Select the desired file format from the File Type pop-up menu. AIFF is Peak's default audio file format.

3. If you wish to save the audio document in a different bit depth resolution, click the bit depth pop-up. If not, leave this item unchecked. (*Peak does not use dithering when saving this way; you will want to use the Dither function under the DSP menu before saving for higher-fidelity conversion.)*

4. Enter a name for the new audio document, select where you want to save the new file, and click Save.

**Saving Compressed Audio Documents**

AIFF/AIFC and QuickTime files with compression such as MACE 3:1, MACE 6:1, IMA 4:1, QDesign, or µlaw are compatible with Peak. If Sound Manager version 3.3 or later is installed, Peak can open these files for editing and then save them with compression.

*You may only Save with file compression using AIFF or QuickTime file formats.*

*User Tip: Audio compression should be the last step in mastering your audio documents. Decompressing and re-compressing audio documents will degrade their sound quality each time they are re-compressed, so it is best not to save with compression until all editing and mastering has been completed.*

**To save an audio document with compression:**

1. Choose Save As... (Shift-⌘-S) from the File menu. The Save As... dialog appears.

2. Choose the audio compressor you wish to use from the Compressor pop-up menu. Some compressors work with 8-bit or 16-bit data only, so the compression options may be grayed out, depending on your setting in the bit depth pop-up. The types of audio compression that will be available to you if you have Sound Manager 3.3 or later include: MACE 3:1, MACE 6:1, QDesign Music, Qualcomm PureVoice™, ALaw 2:1, 32-bit Floating Point, 64-bit Floating Point, IMA 4:1, 24-bit integer, 32-bit integer, 16-bit Little Endian, 16-bit Big Endian, and µLaw 2:1.

3. Type the name of the new audio document, select the folder you wish to save the audio document, and click Save.

Peak shows how much disk space the compressed audio document will occupy with the compression and bit depth settings.

*If Sound Manager 3.3 or later is not installed, there will be no compression options in the Compressor pop-up menu.*

**Closing Audio Documents**

To close a file in Peak, choose Close from the File menu (⌘-W). If you have made any changes to your document since the last time you saved, Peak will ask you if you want to save them. If you do, choose Yes; if you don’t, choose No. If you change your mind and wish to continue your session, choose Cancel.

To close all files currently open in Peak, choose Close All from the File menu (⌘-Option-W).

---

**Peak Windows and Palettes**

By now you have noticed that when you open Peak, there are several windows and palettes that either appear by default or are available to you under Peak's Windows menu. Windows that appear in Peak by default are the Info Strip that appears along the bottom of your screen and an audio document window for each audio file you have open. Windows and palettes that you can turn on or off include the Toolbar, the Cursor Palette, the Contents Palette and the Movie Window. This section will cover the basic function of these Peak Windows and Palettes.
Peak Audio Document Window

Peak Audio Document windows contain a Waveform Display, an Audio File Info Bar (lower left corner) and a Max Level Indicator (upper left corner). The Waveform Display is a graphic representation of the audio file, the Audio File Info Bar shows the sample rate, bit resolution, file format and file size of the audio file, and the Max Level Indicator shows the highest amplitude level in the audio file. On top of the Audio Document window is the File Overview, if it is enabled under the Peak Preference menu. The Audio Window is described in more detail in Chapter 5.

The Info Strip

The Info Strip is anchored to the bottom of the screen. This strip contains three areas—the cursor location display, a time display showing elapsed time, and audio level meters with clip/peak indicators. The Info Strip is described in detail in Chapter 5.

The Peak Cursor Palette

Peak has a floating Cursor palette that contains several useful functions. On the right side of the palette are four different icons representing different cursor modes. The default cursor is a standard Arrow Cursor. You can also use the cursor palette to select a Hand Cursor for moving a waveform within its window, a Pencil Tool for drawing directly on the waveform at the sample level, and a Magnifying Glass Tool for zooming the waveform view in and out. On the left side of the Cursor Palette there are two buttons that control Blend Enable/Disable and Loop During Playback. To access any of these cursors or functions, just click on the corresponding icon in the Cursor Palette. To change the cursor tool, click on a new icon. The Blending and Loop Playback functions are discussed in more detail in Chapter 5.

Arrow Cursor Tool

The Cursor Tool is the default tool. It is the standard “arrow” tool that lets you click and select on-screen items.

Hand Tool

The Hand Tool lets you grab and move a waveform around in its window.

Magnifying Glass (“Zoom Tool”)

To use the Magnifying Glass tool, simply click on the tool in the Cursor Palette, then move the cursor over the waveform. A “plus” (+) sign will appear inside the Magnifying Glass. Click on the waveform to zoom in; each click of the mouse will zoom in farther. To zoom out, option-click on the waveform. A “minus” (-) sign will appear in the Magnifying Glass, and you can click on the waveform to zoom out. Double-clicking on the Magnifying Glass will open the Zoom Amount dialog where you can specify the Zoom Amount.
The Peak Contents Palette

Setting Preferences

You can customize a number of Peak’s parameters so you can work with the program in a way that best suits you. Most of these parameters are found in the Preference menu. These include the controls for playing back audio documents, the selection of the icons in the Toolbar, and the colors that you want for the audio document window. Once you have set these preferences as you like, they will stay that way until you decide to change them again. This section explains how to set several of these parameters. For any menu items not covered here, please refer to Chapter 11: Peak Menus. There you will find explanations of each command in the Preference menu and other Peak menus. Items from the Preference menu are also covered throughout this manual where their discussion is relevant.
The Preference menu

Setting Peak’s Playback Parameters

Peak’s Playback Preferences dialog allows you to control the master output volume, Spacebar operation, hard disk playback buffer size, and window buffer size.

Playback Master Volume

Peak provides a master volume control for audio playback. In the Playback Preferences dialog, set Peak’s output volume to the level that you desire by adjusting the slider or entering a number value from 0 (silent) to 7 (loudest). If you are controlling your playback volume with the volume control of your playback system, you’ll probably want to leave the output level set to 7.

Playback Buffer

Peak allows you to control the amount of RAM the program uses when playing back audio documents. In general, lower is better. A playback buffer of 32k is a good place to start. If you are experiencing clicks in your playback, working with fragmented files, using processor-intensive real-time DSP, or are using a slow hard drive, you may need a larger playback buffer setting.

Window Buffer

Peak also allows you to control the amount of RAM the program uses to cache audio data and the size of each processing chunk. Use larger values if you are working with a few large files, and smaller values if you are working with many smaller files.
**Dynamic Scrub Time**

Peak provides a unique audio auditioning technique called dynamic scrubbing. This feature is very useful for precisely pinpointing and selecting a desired location in an audio document. Dynamic scrubbing allows you to drag the mouse forward or backward over a waveform while Peak plays a short loop (between 10 and 600 milliseconds) at the scrub location. When you have found the location you are looking for, let go of the mouse and the insertion point will be exactly where you want it to be. Peak allows you to choose the length of this playback loop with the Dynamic Scrub Time command in the Preference menu. You can also select Tape-Style Scrubbing in this dialog. For a full description of scrubbing audio in Peak, please see Chapter 5.

**To select a loop duration for dynamic scrubbing:**

1. Choose Dynamic Scrub Time from the Preference menu, and choose a duration from the hierarchical submenu. Typically, a value of between 40 to 80 milliseconds works well.

2. You can also select Tape-Style Scrubbing by selecting it in this submenu. To deselect Tape-Style Scrubbing, just click any duration value in the submenu.

- **Dynamic Scrubbing is not available when using DAE.**

- **Tape-Style Scrubbing requires Sound Manager 3.3 or later and is not available when using ASIO.**

**Scroll During Playback**

With the Scroll During Playback command enabled, Peak will “scroll” through the audio document as playback progresses. This allows you to visually follow the progress of audio playback. A check next to this menu item indicates that it is enabled.

**To enable Scroll During Playback:**

1. Select Scroll During Play from the Preference menu. A check next to this item indicates it is enabled.

2. To disable Scroll During Playback, simply re-select Scroll During Play from the Preference menu. The absence of a check next to this item indicates it is disabled.

**Show Marker Time**

With the Show Marker Time command enabled, all Peak markers will show a time value as well as the marker name.

**To enable Show Marker Time:**

1. Select Show Marker Time from the Preference menu. A check next to this item indicates it is enabled.

2. To disable Show Marker Time, simply re-select Show Marker Time from the Preference menu. The absence of a check next to this item indicates it is disabled.

**Auditioning**

Peak’s Auditioning command allows you to audition a selection along with a specific amount of audio
preceding or following it. The Auditioning dialog allows you to select a desired amount of pre-roll or postroll when you play the selection. To play a selection with the selected amount of pre- and postroll, press Control-Space bar.

To configure Auditioning:

- Select Auditioning from the Preference menu. Enter the desired amount of Pre-roll and Postroll into the dialog boxes. Click OK to exit the dialog.

Blending

Blending is an automatic crossfade function with a user-editable envelope. Peak can apply blending to areas of an audio document when they are modified by cutting, deleting, or other editing processes in order to smooth abrupt transitions between waveform amplitudes. It can be very useful for creating a smooth transition between edits that would otherwise sound too abrupt. If you have cut, pasted, or inserted audio into a document, you may wish to enable blending to smooth things out a bit. It can be toggled on or off by choosing the Blending command from the Preference menu, or by clicking the Blend enable/disable button on the Cursor Palette, or via the caps lock key on your keyboard.

To configure blending:

1. Select Blending from the Preference menu. Enter the Duration over which you wish Blending to occur into the dialog box.
2. To edit the Blending Envelope, click on the Edit Blending Envelope button. Click OK to exit the dialog.

For detailed instructions on how to use blending or how to edit the blending crossfade envelope, see Chapter 5: Editing.

Auto-Import Dual Mono

Certain audio applications, such as BIAS Deck and Digidesign’s Pro Tools, do not directly support interleaved stereo files, and instead use “dual mono” files—a pair of files, one for the left channel and one for the right channel. These files will probably have been exported with the suffix “.L” for the left channel, and the suffix “.R” for the right channel. Auto-Import Dual Mono, when selected, will allow you to select just one channel of the dual mono file in the Open dialog. Peak will automatically “grab” the other half of the file, and convert both files into a single stereo Peak document.

⚠️ Please note that the Import Dual Mono command requires that both files be mono files, have the same sample rate and bit depth, and the must have the exact same name followed by the suffixes “.L” and “.R”.

To enable Auto-Import Dual Mono:

1. Select Auto-Import Dual Mono from the Preference menu. A check next to this item indicates it is enabled.
2. To disable Auto-Import Dual Mono, simply re-select Auto-Import Dual Mono from the Preference menu. The absence of a check next to this item indicates it is disabled.

Choosing Colors for the Audio Document Window

Peak allows you to customize the colors used to display the elements in audio documents. You can use this dialog to set the background color, waveform color, and colors for markers and loops. You can
select either a preset color combination, or individual colors for each element in the audio document window, as well as picking your own custom colors from a color palette. You can also choose to have the waveform display shading for a 3-D look, as well as select the amount of shading. Changes made using the Colors dialog affect both the current audio document’s colors, and any subsequent new audio document’s colors.

To customize the colors and shading of the waveform display:

1. Choose Colors from the Preference menu.

2. To select a preset color combination, click the Theme pop-up menu and choose the preset that you desire.

3. Alternatively, to select individual colors for each element in the audio document window, choose Custom from the Theme pop-up menu and then select the desired colors from the Background, Waveform, Markers, Loops, and Regions pop-up menus.

4. If you wish, you can use this dialog to further customize any element in the audio document window. Pick an element to customize, choose Custom from the Theme pop-up menu, and select User Color. A standard Macintosh color palette will appear. Use this wheel to select any color you wish. Click OK to return to the Colors dialog.

5. You can also customize the degree of shading, or darkness, of audio selections in the waveform display. Use the Selection Shading slider or enter a percentage in the number box to choose the degree of shading you wish to see in selected portions of audio.

6. Another way to enhance the look of audio waveforms in Peak is by giving them a 3-D look. Use the Shadowed Waveform checkbox to turn the waveform shadow on or off.

7. To close this dialog, click Change (to change one color) or Change All (to change the colors for all open audio documents). The audio document window is now set to the colors and look you’ve selected.

The Colors dialog

Choosing a Time Format

The Units command allows you to choose a time format for the audio timeline in Peak’s audio document window. You can choose samples, seconds, SMPTE frames, and Bars|Beats. The format you choose will depend on the nature of the project that you are working on.

To choose Peak’s time format:

1. Choose Units from the Preference menu.

2. From the submenu, choose the time format that you desire: samples, seconds, SMPTE frames, or Bars|Beats. The timeline in Peak’s audio document window and Info Bar switches to the format that you choose.

Choosing a time format with the Units command
Audio File Meter, Tempo, and Timestamp Settings

If your audio document is using bars and beats as its units, you will want to tell Peak what the tempo of the audio document is. Use the Audio Info command from the Preference menu, or click on the gray Audio Info Area on the lower left of any audio waveform display, to set the tempo of the audio document. You can also enter the meter of an audio document using the Audio Info dialog. The numerator represents the number of beats per measure, and the denominator represents the value of a beat, where 4 = quarter note, 8 = eight note, 16 = sixteenth note, etc.

You may also enter a timestamp for the audio document in seconds. If the audio document has a timestamp, then the displayed time in an audio document will be offset from this time rather than starting at zero. For example, if the timestamp for an audio document is four seconds, then the first sample in the audio document will appear in the audio document with a time of 4 seconds instead of zero seconds.

Choosing a Scratch Disk

Because audio data can be very large, Peak utilizes a portion of your hard disk's free space to hold audio data that has been cut or copied, as well as for temporary or scratch files for undo purposes. If your hard disk is short on space, you may not be able to cut, copy, or modify large selections. If you have more than one hard drive attached to your Macintosh, the Scratch Disks command in the Preference menu allows you to choose the hard drives (or “scratch disks”) that you wish to use for these temporary files. Peak allows you to select which disk you want to have as your default, or “Primary” disk for this purpose—usually you would select the disk that has the most free space. If you are connected to a file server, you can utilize available storage on the server by clicking the checkboxes next to the drives in the list. To choose the Primary Disk, or the default disk for temporary files, click on the Primary button next to that disk. If you are connected to a file server and would like to use storage available there as well, enable the Allow Servers checkbox.

1. Choose Scratch Disks... from the Preference menu. The Scratch Disks dialog appears.

2. The Scratch Disks dialog will show all hard drives currently connected to your Mac. Choose the hard drive(s) that you wish Peak to use when it creates temporary files by clicking the checkboxes next to the drives in the list. To choose the Primary Disk, or the default disk for temporary files, click on the Primary button next to that disk. If you are connected to a file server and would like to use storage available there as well, enable the Allow Servers checkbox.

3. Click OK to close this dialog. Peak will use the disk you have selected as your Primary scratch disk, and, if it becomes full, will then use the other disks you've chosen.

⚠️ The hard drive with the original audio file must have the equivalent amount of free space (i.e., a 60MB file would require that there be an additional 60MB of free space on the hard drive on which the file resides).

⚠️ If you are using Peak with DAE and ProTools III or earlier hardware, you must be sure to configure the Scratch Disks dialog to utilize only those drives on your dedicated ProTools SCSI bus.
**Keyboard Shortcuts**

Peak allows you to customize any Peak menu item with a keyboard shortcut. To change your keyboard shortcuts, go to the Preference menu and select the Shortcuts and Toolbar item. Keyboard shortcuts are stored in a Preference file in the System Folder’s Preferences Folder, called “Peak 2.5 Shortcuts.” Peak’s default Keyboard Shortcuts are listed in Appendix 1 at the end of this manual.

**To add a new Keyboard Shortcut**

1. Choose Shortcuts & Toolbar under the Preference menu.
2. Scroll through the list of menu items, or, with the list box selected, simply type in the first few letters of the menu item you wish to assign. Then click on the name of the Peak menu item you wish to assign a new keyboard shortcut.
3. Use the Shortcut Key box to enter the letter you wish to use for a shortcut. You may select the Command, Option, Shift or Control keys as additional modifiers by clicking on the checkboxes in this dialog.
4. Close the Shortcuts & Toolbar dialog.

**To remove a Keyboard Shortcut**

1. Choose Keyboard Shortcuts under the Preference menu.
2. Scroll through the list of menu items, and click on the name of the Peak menu item for which you wish to remove a keyboard shortcut.
3. Click on the Clear button.
4. Close the Keyboard Shortcuts dialog.

*User-defined Keyboard Shortcuts and Toolbox customization are not supported in Peak LE.*

**Making a Keyboard Shortcuts “Cue Card”**

It’s easy to make a “cue card” that you can keep on your desk with all the Peak shortcuts you’ve assigned.

Using the supplied FileMaker Pro template, you can import all of your shortcuts from a text file describing each keyboard shortcut generated from Peak.

**To Create a Custom “Cue Card” of your Keyboard Shortcuts:**

1. Choose Shortcuts under the Preference menu.
2. Click on the Save As Text... button.
3. Enter the name of the keyboard shortcuts text file you wish to save, and choose the disk and folder you wish to save into. Click Save.
4. Switch to the Finder and Launch FileMaker Pro.
5. Choose Open from the File menu in FileMaker Pro.
6. Open the supplied “Peak Shortcuts Template” FileMaker Pro template.
7. Choose Import Records... from the File menu in FileMaker Pro.
8. In the pop-up menu at the bottom of the Open... dialog in FileMaker Pro, choose Tab-Delimited.
9. Find the shortcuts text document you saved in step 3 and click Open.
10. FileMaker Pro will add the records to the database.
11. Use the Print option in FileMaker Pro’s File menu to print out your keyboard shortcuts.

You can also sort the imported keyboard shortcut commands by description or shortcut. Consult your FileMaker Pro User’s Guide for more information on importing records, sorting records, and printing.

---

**The Toolbar**

Peak 2.5 allows you to select almost any Peak command for the Toolbar. The Shortcuts & Toolbar
menu allows you to group together the functions you use most often, so that you can simply click a button instead of going to the menus. For example, if you frequently use Normalize and Pitch Change, you can choose to have the icons for these functions in the Toolbar, so that all you have to do is to make an audio selection and click a button. The Toolbar is an easy way to make your work in Peak faster and more efficient, allowing you to customize the program to suit the way you work.

To add or subtract items from the Toolbar, use the Shortcuts & Toolbar item under the Preference menu. Toolbar selections are stored in a Preference file in the System Folder’s Preference Folder, called “Peak 2.5 Shortcuts.”

You can “grow” or “shrink” the Toolbar by clicking on the plus (+) and minus (-) signs in the vertical gray bar on the right of the Toolbar. You can also choose whether to have a vertical Toolbar at the left of your screen, or a horizontal Toolbar along the top of your screen—just click on the box at the upper right of the Toolbar, and it will snap to its new position.

To add a new icon to the Toolbar

1. Choose Shortcuts & Toolbar under the Preference menu.
2. Scroll through the list of menu items, and click on the name of the Peak menu item you wish to have appear in the Toolbar.
3. Click on the “Place In Toolbar” checkbox to select the icon to add to the Toolbar. If there is no icon, the menu item cannot be placed in the Toolbar.
4. Close the Keyboard Shortcuts dialog.

To remove an icon from the Toolbar

1. Choose Shortcuts & Toolbar under the Preference menu.
2. Scroll through the list of menu items, and click on the name of the Peak menu item you wish to remove from the Toolbar.
3. Click on the checkbox to uncheck the item you wish to remove.
4. Close the Keyboard Shortcuts dialog.

Customizable Toolbar is not supported in Peak LE.

Quit Peak

When you have finished a project or wish to end an editing session, the Quit command allows you to quit Peak and return to the Finder. If you haven’t saved changes, Peak will warn you before allowing you to quit.

To quit Peak:

• Choose Quit from the File menu (⌘-Q).

If you have made any changes to your document since the last time you saved, Peak will ask you if you want to save them. If you do, choose Yes; if you don’t, choose No. If you change your mind and wish to continue your session, choose Cancel.

If you wish to close all currently open windows without saving, hold down the Option key and click Don’t Save.
Conclusion

You now know how to create, open, import audio files, export, close, and save Peak documents. You also know how to set the preferences for operating Peak. The next chapter explains how to use your Peak software to record audio to disk.
Chapter 4:
Playback and Recording

In this chapter you’ll learn how to record and playback audio with Peak. Peak allows you to capture sound from external sources through your Macintosh’s built-in audio input or by using a third-party audio card. If your Macintosh is equipped with a CD-ROM drive, you can also import audio directly from an audio CD. Peak will also let you record and playback via DAE and ASIO.

Preparing Peak for Recording

Before you begin recording, you must set several parameters for the audio that you wish to record. If you followed the instructions in Chapter 2, your system’s basic recording and playback setup should already be configured properly. At this point, you may simply select Record Settings... from the Audio menu or Toolbar to confirm or configure recording parameters, and then you can begin using Peak to record audio to your hard disk.

Proper Levels for Recording

To obtain the best possible fidelity when recording digital audio, it is important to record your audio signal at the highest possible level without introducing clipping (distortion). The reasons for this are twofold: If your audio input level is too low, the recorded audio may contain a significant amount of noise which can manifest itself as hiss. Conversely, if your audio input level is too high, it may clip and cause audible crackling or other types of distortion. You should avoid digital distortion at all costs because unlike its analog counterpart — which can sometimes sound “warm” and appealing — digital distortion sounds terrible. In order to prevent this from happening, always leave a little headroom (6dB or so) when you set levels so that you don’t hit maximum input levels and clip.
Record Settings

When you select Record Settings from the Audio menu (Option-R) or Toolbar, the Record Settings dialog appears. This dialog is used to configure your settings for recording with Peak.

⚠️ Please note that the settings you choose here override any previously set with the Apple Sound Control Panel.

The Record Settings dialog

You will notice several pop-up menus, buttons, and checkboxes in the Record Settings dialog. These allow you to select which hard drive to record to, what file format you’d like to record in, sampling rate, source input, and so on. You may also wish to record in real-time through your Premiere or VST audio plug-ins. The next few paragraphs describe how to set all of these parameters using the Record Settings dialog.

Record Disk

The Record Disk pop-up menu allows you to choose which hard drive you would like to record to. If you have more than one hard drive connected to your Macintosh, use this pop-up to select your record drive. (This option will default to the largest drive currently available to your Macintosh unless you select otherwise.)

File Format

The File Format pop-up menu allows you to select the file format for the incoming audio. You can choose from AIFF or Sound Designer II. (If you need the newly recorded audio file to be in a different format, you can always use the Save As... function. To save it as a new format once recording is complete.) If you do not select a file format for recording, Peak will default to 44.100kHz 16-bit stereo.

Auto Gain Control checkbox

The Auto Gain Control checkbox allows you to disable the Automatic Gain Control feature used by the Sound Manager with some Macintosh microphone inputs. If the recording device you are using supports this feature, check the Auto Gain Control checkbox.

Monitor checkbox

The Monitor checkbox allows you to monitor the audio throughput while you are recording.

Split Stereo Files checkbox

The Split Stereo Files checkbox allows you to record the incoming stereo audio as dual mono files rather than a single stereo file. Dual mono files are used in programs like Digital Performer, Pro Tools, or BIAS Deck, so this option is useful if you need to record dual mono files (i.e., split stereo).

Append to document checkbox

The Append to document checkbox allows you to record into an existing audio document. To record new audio into an existing document, place the insertion point in the existing audio document at the point where you want to insert the new audio. If the insertion point is at the beginning of the file, the newly recorded audio will be inserted at the beginning of the file. If the insertion point is at the end of the file, the newly recorded audio will be appended to the end of the existing file. If the insertion point is somewhere in the middle of the file, the newly recorded audio will be inserted at that point. If you make a selection of audio, the Append to document feature will allow you...
to replace the current audio with newly recorded audio from the beginning of the selection through the end of the document or wherever you stop the recording.

**Record timer... checkbox**

The Record timer... checkbox allows you to designate a specific duration for recording. Peak will stop recording after this set time and bring up the Save dialog for your audio recording. Checking the Record timer... checkbox will bring up the Recording Time dialog. In the Recording Time dialog, designate the duration for recording in seconds and click OK.

![Recording Time dialog](image1)

**Device and Sample Format...**

Clicking on the Device and Sample Format button brings up the Sound dialog. This dialog contains a pop-up menu that bring up three sub-dialogs, and, on the right side of the dialog, a Speaker select pop-up, Volume and Gain controls, and an audio input level meter.

![Sound dialog](image2)

**Compression**

The compression option is not supported in Peak yet, so leave Compression set to none.

**Sample**

Selecting Sample from the Sound dialog pop-up menu allows you to choose the sample rate and bit depth, as well as whether the incoming audio will be recorded as a Stereo or Mono file. To some degree, the choices that appear here will depend on your audio hardware. Possible sample rates are as follows:

- **48.000kHz** This is one of two standard sample rates for digital audio tape (DAT) recorders, and is often used by sound editors working in audio post-production for video or film.
- **44.100kHz** This is the standard sample rate for Compact Discs, digital audio tape (DAT) recorders, and high-fidelity audio applications on Macintosh.
and PC-compatible computers with 16-bit playback capability. Most sound engineers working in music production—or anything that may be distributed on a CD—work at “forty-four one.”

**22.050kHz & 11.025kHz** These sample rates are often used for lower-fidelity audio playback on Macintosh and PC compatible computers that have 16-bit playback capability. Many games and other multimedia productions utilize 22.050kHz 16-bit or 8-bit audio, since it uses one-quarter of the disc space of CD-quality audio. 22.050kHz 16-bit is the Shockwave audio standard.

**16-bit** is the current Compact Disc standard for professional-quality recordings.

**8-bit** is often used for computer-based and web-based multimedia and games.

---

### Source

Selecting Source from the Sound dialog pop-up menu allows you to select and configure the audio input you wish to use for recording. If you have a third-party audio card installed in your Macintosh, you can select it as the input device using the Device pop-up. Use the Input pop-up to select the hardware inputs you wish to record through.

Your exact setup will differ slightly depending on the input device that you are using with Peak. You can use either your Macintosh’s built-in audio inputs, or, if you own a third party sound card, such as Digidesign’s AudioMedia III card or Digigram’s VX Pocket, you may wish to use its audio inputs and outputs.

Once you have configured the options in the Sound dialog to your liking, click OK to return to the main Recording Options dialog.

⚠️ **If you are using a third party sound card, be sure that you have correctly installed its Sound Manager drivers in your active extensions folder so that it will be available to Peak via the Apple Sound Manager. If the sound card’s Sound Manager drivers have been correctly installed it will appear in the Apple Sound Control Panel for Sound In and Sound Out as well as under Peak’s Sound Out submenu under the Audio menu and in the Source Device and Sample Format dialog accessible from Peak’s Record Settings dialog under the Audio menu.**

### Hardware Options

Clicking on the Hardware Options button in the Record Settings dialog brings up a dialog appropriate to the audio hardware you selected in the Source dialog. Note that in many instances there may be no settings for a given device (including the Apple Built-In Sound!). Some sound card’s drivers have control panels or utility applications that will launch when you click on the Hardware Options button. The VX Control dialog for the Digigram VX Pocket is shown below, but the actual third-party dialog will differ depending on the type of audio card you have.
Record Through Plug-In

If you have Premiere-format or VST compatible audio plug-ins installed in your Peak Plug-Ins or VstPlugIns folder(s), you can record through them in real-time. This is useful if you want to use a noise reduction, equalizing, or dynamics plug-in during recording.

To configure Peak to record through a Premiere-format audio Plug-In in real-time:

1. Open a Peak audio document that has the number of channels you plan to record.
2. Select Record Settings... from the Audio menu. The Record Settings dialog will appear.
3. Click and hold on the Record Through Plug-In pop-up. All of the plug-ins you have installed in your Peak Plug-Ins folder will appear in the pop-up.
4. Scroll to the plug-in you wish to record through and select it. The plug-in’s dialog will appear.
5. Configure the plug-in to your liking, then click OK or Process to close it’s dialog, and select Record from the Audio menu (⌘-R) or Toolbar. You are now ready to record audio through the plug-in(s).
6. Be sure to disable the active VST Plug-In(s) after you have made the recording.

The Record Dialog

When you select Record from the Audio menu (⌘-R) or Toolbar, the Record dialog appears. There are transport buttons along the bottom to Start, Pause and Stop the recording, an Audio Source display that shows you the waveform as it is being recorded, and a Notepad window. There are also text displays showing you the sample rate, bit depth, and number of channels you selected in the Record Settings dialog, as well as the amount of time you have left to record on the selected Record Disk.
The Record dialog

The Notepad feature in the Record dialog allows you to type in text descriptions, transcribe a recording, or type in comments called Notepad Cues at specific points during the recording of an audio document. The Notepad feature is available from the Record dialog and may be used once a recording starts. Each time you start typing on a new line, a new Notepad Cue is generated for the current recording time. Press the Return key on your computer keyboard to begin the next line.

When you are finished recording, Peak will create markers in the audio document that correspond to each Notepad Cue you have entered. By clicking on the Create Regions instead of Markers checkbox, you can choose to create regions rather than markers during recording.

\[ \text{LE} \] Notepad Cues are not available in Peak LE.

Recording

To record audio to disk, do the following.

To start recording:

1. Turn down the volume of your instrument or audio source.

2. Connect the instrument or audio source to the audio input jack on the rear of your Macintosh. If you are using a plug-in audio card, use the connectors on this card. (Some audio cards have an external interface box which contains the input and output connectors. If this is the case, use these.)

3. Choose Record Settings from the Audio menu (Option-R) or Toolbar, and configure the settings as described in the previous section. Make sure that you have checked Monitor in the Record Settings dialog and Speaker on during Recording in the Device and Sample Format dialog, so that you can listen to your audio source as it is recorded into Peak.

4. Select Record from the Audio menu (Option-R) or Toolbar

5. Play your instrument or audio source. You should see the signal levels register on Peak’s Audio Meters (in the Info Strip at the bottom of your screen).

6. Adjust the output of your audio source so that its signal registers relatively high on the meters but never hits top (indicated by the red Clip Indicators.). Remember to always leave 6dB or so of headroom on the meters so that you don’t clip. Use the yellow and orange meter lights and red Clip indicators to help you make this adjustment.

7. Click the Record button in the Record dialog. You are now recording to disk. You should see the audio waveform begin to scroll in the Audio Source Display window.
8. To stop recording, click Stop. To pause, press Pause.

9. The Save dialog appears, prompting you to name the audio document. You must save the audio document to the same hard drive you selected in the Record Settings dialog. Enter a name and click Save. Peak automatically saves the document in the audio file format you selected in the Record Settings dialog. If you wish to later save the document in a different audio file format, use the Save As command.

To play back the recording:
1. Press the Spacebar on your computer keyboard. Playback begins.
2. To stop playback, press the Spacebar again.
3. To start playback from a specific point in the recording, with the Cursor Tool selected in the Cursor Palette, double-click on the waveform at the point from which you want playback to begin, or click the mouse at the desired point and press the Space bar.

To import tracks from an audio CD:

1. Insert an audio CD in your CD-ROM drive.
2. Choose Import CD Track from the File menu.
3. In the dialog that appears, select the CD track that you wish to import and click Mark. You may mark multiple tracks for import. If you wish to import all of the tracks on the CD, click on the Mark All button.

Importing a Track From an Audio CD (CD Audio Extraction)

If you own a Macintosh computer that is equipped with a compatible CD-ROM drive and Apple’s Sound Manager software (version 3.3 or later), you can use Peak to import audio directly from an audio CD. This process is sometimes referred to among multimedia developers as audio extraction, or audio-across-SCSI. If you own an Apple or non-Apple external CD-ROM drive, you may also be able to take advantage of this feature.

Please note that not every CD-ROM drive supports audio extraction, and that even among drives of the same model, one drive’s firmware (the internal operating software) may support audio extraction, while another’s may not. If you are unsure as to whether or not your drive supports Apple-standard audio extraction, your best bet is to try the instructions that follow. If this doesn’t work, please contact the CD-ROM drive’s manufacturer to establish whether your drive (and your drive’s firmware) will support Apple-standard audio extraction.

Import CD Audio dialog
4. To Name a selected CD track, click on Name... button, or, if you are online, you can use the online CD Data Base by checking the Get CD Info from CDDB checkbox.

You must be online and have the CDDBLib installed in your Extensions folder in order to use CDDB in Peak’s Import CD dialog. To learn more about the CDDB, click the About CDDB... button.

5. To select only a portion of the track, click on Set Import Times button or double-click on the track in the list. The Audio CD Import Options dialog will appear.

4. In this dialog that appears, select the desired sample rate, resolution, and format. By adjusting the Start and End time controls at the bottom of this dialog you can import the entire CD track, or a just specific portion of the track. The slider in this dialog assists you in locating start and end times. Click Play to audition the CD track (or selected portion of the CD track). Click OK when you are happy with the selection.

5. Check the Open tracks after importing checkbox if you want the CD track(s) you are importing to open in Peak. If you prefer to import the CD track(s) straight to disk, be sure.

6. Click the Import button in the Import CD Audio dialog to import the selected tracks and the Save dialog appears. Use the pop-up menu at the top of the dialog to navigate to the hard drive where you wish to save the audio file. Click Save to save the file to disk. Peak will saves the file(s) in the AIFF audio format.

Using CDDB

Peak uses the CDDB2 Disc Recognition ServiceSM (DRS) from CDDB, Inc. to get the artist, title, track, credit, and other information about the CDs you want to import. This service is FREE and automatic. The first time you use the service, you must register with CDDB. CDDB enhances Peak’s Import CD Tracks dialog which is accessed from Peak’s File menu.

To register with CDDB:

1. Insert a CD and then choose Import CD Track from the File Menu.

2. Click on the Get CD Info from CDDB button. If prompted, follow the screens for a New Registration to select a "nickname" and password. The remaining information is optional, but does help CDDB provide better service.

3. Once you register, you do not have to reregister, unless you want to change your registration information or settings.

To change your CDDB registration information, click on the “Edit CDDB Disc Info...” button in the Import CD Tracks dialog.

To see or edit the full CDDB2 information for a CD, Click on the “Edit...” button in the Import Audio CD dialog.
Peak supports ASIO 1.0 for recording and playback of audio through your ASIO support sound card. ASIO is a standard technology for routing audio between sound cards and software application developed by Steinberg Software und Hardware, GmBH. ASIO, unlike the Apple Sound Manager, supports bit depths beyond 16-bits and sample rates beyond 65kHz. Most audio cards currently available have ASIO drivers and many of these cards support higher bit-depths and sample rates. The following lists some of the third party sound cards that have ASIO drivers that are compatible with Peak:

- Apple Sound Manager
- Digidesign Direct IO
- Digidesign AudioMedia III
- Digigram VX Pocket
- Emagic Audiowerk
- Echo Gina, Layla, and Darla
- E-mu PARIS
- Korg 1212 I/O
- Lexicon Core 2
- Lucid PCI-24
- M-Audio Delta 66
- Midiman DMAN 2044
- MOTU PCI-324
- RME Digi96
- Sonorous STUDI/O
- Yamaha DSP Factory

The MOTU PCI-324 needs to be configured using the MOTU PCI-324 Console and the PCI-324 Cuemix Console prior to launching Peak. The Yamaha DSP Factory requires that you be running MixTest prior to launching Peak and selecting the DS2416 ASIO driver. Other cards, such as the M-Audio Delta series, may similarly require software utilities provided by the card’s manufacturer.

Installing ASIO Drivers

To install a sound card’s ASIO driver for use with Peak, drag and drop the ASIO driver into Peak’s ASIO Drivers folder. When you launch Peak, it will load and recognize the sound card’s ASIO driver.

Playback with ASIO

To select the ASIO driver for playback, select ASIO from the Sound Out submenu under Peak’s Audio menu.

Premiere format plug-ins can only Preview through the Apple Sound Manager. Therefore, if you are using Peak with ASIO, you must be sure that the Deactivate for Previewing checkbox is checked. Your Premiere format plug-ins will then preview through whatever is selected for Sound Out in the Apple Sound control panel.
The ASIO dialog appears.

![ASIO I/O dialog](image)

**Driver**
Choose the driver for your ASIO supported Audio card from the ASIO Driver pop-up menu.

*It is important to note that many ASIO drivers support playback through only a limited number of sample rates. For this reason, using ASIO drivers for playback will require that your audio files are at sample rates supported by the driver you are using.*

**Clock Source**
You may choose the clock source for digital sync using the ASIO Clock Source pop-up menu.

**Sample Rate**
Choose the sample rate for playback using the ASIO Sample Rate pop-up menu.

**Play Through**
Choose what channels you wish Peak to playback through using the ASIO Play Through pop-up menu.

**Driver Setup**
Clicking on Driver Setup in the ASIO dialog will launch the control for certain ASIO supported cards, such as Digidesign Direct IO. However, some cards’ drivers will either not have driver control panels or they will have driver setup utilities that need to be configured prior to launching Peak and cannot be accessed from within Peak.

**Active In Background**
The ASIO Active in Background checkbox enables the ASIO driver to operate in the background while Peak is in the background. If you are running more than one audio application using the same ASIO driver, you will want to disable ASIO Active in background.

**Deactivate for Previewing**
The ASIO Deactivate for Previewing checkbox deactivates the ASIO driver when the Apple Sound Manager is being used for previewing (e.g., when previewing in the Open dialog or Import CD Audio or previewing a Premiere format plug-in). You will want to enable Deactivate for Previewing if you are using both the audio card’s ASIO driver and its Sound Manager driver.

**Recording with ASIO**
To record in Peak with ASIO you will first need to have configured Peak for playback with ASIO. Once Peak is configured for playback with ASIO you can go to the Record Settings dialog and configure Peak for recording with ASIO. The Record Settings dialog can be accessed from under the Audio menu (Option-R) as well as from the Toolbar. Clicking on the Hardware Options button in the Record Settings dialog will launch the ASIO driver’s control panel if one is available. To configure Peak to record with ASIO click on Device and Sample Format and the ASIO Recording Settings dialog will appear.
Playback and Recording

The ASIO Record Settings dialog

Record Through
Using the ASIO Record Through pop-up menu you can choose the source for recording.

Sample Rate
Using the ASIO Sample Rate pop-up menu you can select the sample rate at which you wish to record. Some sample rates may not be available depending on the limitations of the audio card and its ASIO driver. Please note that if you are recording from a digital source you will want to be sure that you record at the same sample rate as your digital source.

Channels
You may also choose to record a mono or stereo file using the radio buttons under the Channels heading.

Bit Depth
Choose the bit-depth using the radio buttons under the Bit Depth heading. Please note that you will be limited to recording at bit depths that are supported by your audio card and its ASIO driver.

Monitor with Sound Manager
Enable the Monitor with Sound Manager checkbox to monitor recording through the Apple Sound Manager while recording through ASIO. This feature is especially useful if you want to monitor your Digigram VX Pocket through headphones plugged into your Powerbook.

After you have configured the ASIO Recording Settings, click OK and you can begin recording in Peak via ASIO.

⚠️ Be sure to set the Clock Source in the ASIO dialog to digital if you plan to record via ASIO from a digital source.

Digidesign’s DAE

Peak supports Digidesign’s DAE (Digidesign Audio Engine) 3.4.x or later for playback and recording. If you own the appropriate Digidesign hardware and software, taking advantage of Peak’s DAE support gives you access to AudioSuite and TDM plug-ins (with compatible hardware). Peak also provides true 24-bit playback and recording through supported 24-bit capable DAE hardware.

If DAE 3.4.x or later is installed on your Macintosh, and you have compatible DAE hardware, you will see a DAE option under Peak’s Sound Out submenu under the Audio menu.

⚠️ It is only necessary to use DAE for AudioSuite or TDM plug-ins. Otherwise, use your Digidesign sound card’s Sound Manager or ASIO drivers.

Restrictions
Premiere plug-ins work exclusively with the Apple Sound Manager. When using DAE, you will not be able to use Premiere plug-ins in real-time, or use Dynamic
Scrubbing. There are two work-arounds to this limitation:

1. You can still use Premiere plug-ins and preview their settings by using the appropriate Digidesign Sound Manager output driver, selected for Sound Out in the Apple Sound Control Panel.

2. Switch to the Digidesign Sound Manager driver under Peak’s Sound Out submenu under the Audio menu when working with playlists or when you need to use Premiere plug-ins in real-time.

DAE only works with mono files. Consequently, Peak must write temporary dual mono files from interleaved stereo files for playback with DAE. Peak will have to write these DAE playback files after every edit you make in an interleaved stereo file.

If you are using Pro Tools III hardware or earlier, you must configure Peak’s Scratch Disks preference to use only the hard drives on the dedicated Pro Tools SCSI bus before launching DAE.

Configuring DAE

To configure Peak to use DAE for playback and recording:

1. Choose DAE from Peak’s Sound Out submenu under the Audio menu. DAE will launch and initialize any TDM or AudioSuite plug-ins. This process can take some time, depending on the number of plug-ins installed.

2. Peak will ask you to enter your playback engine settings in a Digidesign Playback Engine Setup dialog. Configure the dialog for your hardware and press OK. Peak will play back and record through your DAE hardware on outputs 1 and 2.

Special Notes for Digidesign systems equipped with a dedicated SCSI bus

If your Digidesign hardware requires that you attach hard drives for audio to the Digidesign Disk I/O or other Digidesign hardware for playback and recording, you will need to configure Peak to use these devices exclusively for playback, editing, and recording.

To configure Peak to use Digidesign hard drives for playback, editing, and recording:

1. Choose Scratch Disks from Peak’s Preferences menu. The Scratch Disks dialog will appear.

2. Enable only the hard drives that are on the dedicated Digidesign SCSI bus by clicking on the Use checkbox next to the name for each of these hard drives. Disable all other hard drives appearing in the Scratch Disks dialog and click OK. Do this before launching DAE in Peak.

Playback of audio documents using DAE with Peak

Audio documents played back using DAE from Peak must have a sample rate of 44.1kHz or 48kHz. Peak will inform DAE of the sample rate of your audio document. If your audio document is not at 44.1kHz or 48kHz, the audio may sound slower or faster than it should and at the wrong pitch.

Peak will automatically inform DAE about playback of 24 or 16 bit audio files. You may not play back 24-bit audio files using DAE on Digidesign hardware that does not support 24-bit playback.

DAE does not support Interleaved Stereo files, so Peak must write temporary Dual Mono files for Interleaved Stereo files to playback through DAE. Peak will write these temporary DAE playback files when an interleaved stereo file is open and also after every edit or DSP process.

Recording audio documents using DAE with Peak

Peak can record 24-bit and 16-bit mono or stereo audio documents using DAE. Recording 24-bit files through DAE requires compatible 24-bit hardware (such as a Pro Tools d24 or Mix+ card, and the 888-24...
I/O). All recordings made with Peak using DAE will be in the Sound Designer II file format. Stereo files must be recorded in the Dual Mono file format.

To configure recording under DAE:
1. Choose Record Settings from the Audio menu. The Record Settings dialog appears.
2. If you are using Digidesign hardware that has its own SCSI bus, you must choose to record to an audio hard drive attached to your Digidesign SCSI bus to record to. DAE cannot record to any hard drive not on the dedicated Pro Tools SCSI bus.
3. Press the Device and Sample Format button. The DAE Recording settings dialog appears. You can select the bit-depth of the recording, the sample rate, and Mono or Stereo.

The DAE Recording dialog

To make a recording using DAE:
1. Choose Record from the Audio menu. The Record dialog appears.
2. When you are ready to begin, click the Record button on the bottom right corner of the Record dialog. Recording will begin.

Note that the Audio Source Display in the Record dialog is not available with DAE.

Playing Audio with Peak

Once you have configured Peak for Playback and Recording using either the Sound Manager, ASIO, or DAE, you can start to playback and record audio with Peak.

The Transport Buttons

The Transport buttons that appear in the Toolbar are useful tools for initiating both playback and recording. They function much as the controls on a tape recorder would. These buttons are customizable, as are all Toolbar buttons, so you can choose which Transport functions to display. As they appear below, from left to right, they are Rewind, Play, Play Selection, Pause, Stop, Fast Forward, Record, and Record Settings...

To start playback from the beginning of a document:
1. Press the Spacebar, or click the Play button on the Toolbar. Playback begins from the beginning of the document.
2. To stop playback, press the Spacebar again or click the Stop button on the Toolbar.

To rewind playback to the beginning of a document:
- Click the Toolbar Stop button twice, or click the Rewind button. You can also press the Return key if playback has been stopped.

To start playback from a specific point in a document:
1. Click the cursor at the desired location in the audio document and press /command-Spacebar on your computer keyboard. Playback begins from the cursor location and continues to the end of the document.
2. Alternatively, double-click the mouse at the desired location in the audio document. Playback begins from the location that you double-clicked and continues to the end of the document.

3. You can also click anywhere in the Audio Waveform Overview to begin playback from that point.

4. To stop playback, press the Spacebar.

**Triggering Playback of Multiple Audio Documents**

As explained earlier, Peak allows you to have multiple audio documents open at the same time. Peak assigns each of these documents a number based on the order in which it was opened. Peak provides you with a convenient way of triggering playback of any open audio document by pressing a number key on your computer keyboard. This can be a very useful feature for applications such as “live” sound effects playback, since you can open multiple audio documents and play them from your Macintosh keyboard.

*To trigger sequential playback of multiple audio documents:*

1. Open several audio documents, taking note of the number that Peak assigns them in the Windows menu. (This is based on the order in which the documents were opened.)

2. Press the number which corresponds to the document(s) you wish to play note: the numeric keypad will not work for this function, you must use the numbers at the top of the keyboard). You don’t need to wait until a document has finished playing to press the next number: typing a numerical sequence on your keyboard will “cue up” all of the corresponding files. They will then play in the order you choose.

3. If you wish to stop playback and jump to the next document in line, press the Return key. Peak initiates playback of the next document in sequence.

---

**Conclusion**

You have now learned how to record and playback audio to and from hard disk using the Apple Sound Manager, ASIO, and DAE. You have also learned how to import audio tracks from CDs. In the next chapter, you will learn how to edit audio with Peak’s powerful set of digital editing tools.
Chapter 5: Editing

This chapter introduces you to the concept of digital audio editing. You will learn how to do digital audio editing with Peak’s many powerful digital editing tools.

Editing Audio with Peak

Peak provides you with a powerful interactive, nondestructive environment for editing and manipulating audio. In this environment, not only are virtually all editing actions completely “undo-able” and “redo-able,” but they can be performed interactively while audio playback is engaged.

Interactive Editing

Interactive editing means that you can cut, paste, loop, and process audio with DSP functions and Plug-Ins even while playing back the very audio that you are editing (Plug-Ins are covered in chapter 7). For example, you can start playback, cut a selection of audio and paste or insert it later in the document, and when Peak reaches the location of the inserted audio, it will play it as if it were there all along. This revolutionary capability makes Peak a supremely fast and flexible audio production tool that makes conventional recording and editing methods, such as analog tape and a razor blade or Sound Designer, seem primitive and archaic by comparison.

Nondestructive Editing

Peak’s nondestructive editing capabilities mean that the edits you perform to an audio document do not permanently change the original source recording until you finally save the document. Thus, you can cut, copy, paste, fade in and out of, and otherwise completely change a recording, and still be able to return back to square one — the original untouched state of the recording — up until the time that you save the document to disk. At that time, all edits are permanently written into the document.

Unlimited Undo and Redo

As an editing session progresses, Peak maintains an internal list of the edits that you perform. Changes that you make to an audio document are never permanently applied to the file until you ultimately save it. This is what gives Peak its unprecedented unlimited undo and redo capability. Through the use of the Macintosh’s standard Undo and Redo commands, you can undo or redo your actions sequentially, or by using the Edits command, using a “playlist-style” editing event list. This is a very exciting technology that allows you to maintain complete creative freedom of choice—right up until the last moment before you save your project to disk. By making good use of these nondestructive, interactive editing capabilities, you will be able to perform feats of audio production that until recently were virtually impossible with traditional tools.

The Audio Document Window

The heart of Peak’s powerful editing capabilities is the audio document window. The audio document window provides you with a “window into sound,” allowing you to make good use of both your eyes and ears to perform extremely precise editing tasks. The Audio Document window give you a time-domain representation of sound, that is, you see the amplitude of the sound over time.
To increase the vertical scaling magnification:
- Hold the Control key down and press the Up Arrow key.

To decrease the vertical scaling magnification:
- Hold the Control key down and press the Down Arrow key.

Audio Waveform Overview
Peak provides an Overview display of the entire audio waveform along the top of the screen under the menu bar. This provides you with a convenient visual reference of the overall document when you are editing only a portion in the audio document window. The highlighted area in the Overview display shows the area of the audio waveform currently visible in the audio document window. If desired, you can hide the Overview display to allow the audio document window to occupy more of computer screen.

To show the Audio Waveform Overview:
- The Overview display appears along the top of the audio document window under the title bar. Check Show Overview in the Preference menu or Toolbar. A check next to this item indicates it is enabled.

To hide the Audio Waveform Overview:
- To hide the Audio Waveform Overview, uncheck Show Overview in the Preference menu or Toolbar.

An Audio Waveform
If you have never seen sound displayed in a visual format before, it may not be immediately obvious how to “read” an audio waveform. It is actually quite easy to navigate through a recording with a waveform as your road map. The peaks in the waveform are areas of high amplitude (loud spots). The valleys in the waveform are areas of low amplitude (quiet spots). If the audio material is music with a pronounced, regular beat, it is generally very easy to pick out where the beats are simply by looking for peaks. Using this information, and the guidelines given shortly in the “A Selection” section, you will be able to successfully locate and select a desired portion of the audio document and perform the edits that you wish. The cursor marks the current location, and also serves as an insertion point.

Vertical Scaling
Peak allows you to control the vertical magnification of audio waveforms. This feature is useful if you are editing and viewing a document with very quiet audio material.
A Selection

A selection is just what it sounds like: a portion of audio that you have selected by clicking and dragging with the mouse. You must select audio in order to perform an editing action on it. To make good selections for editing, the best rule of thumb is to begin a selection just before a peak in the waveform and end it just after a peak in the waveform. In other words, try to make selections start and end in areas of low amplitude (“valleys” in the waveform).

It is also important, when possible, to begin and end a selection at a point where the waveform meets the zero crossing line (the center line through the waveform). This helps you avoid creating pops and clicks if you later cut or paste the audio because the point at which the waveform meets the zero crossing is a point of low amplitude in the sound wave. Pops and click generally only occur if you make a careless selection and begin or end on a portion of the sound wave where the amplitude is high (where the waveform is high above the center point). Enable Auto-Snap to Zero in the Preferences menu to have Peak nudge your selection to zero crossings automatically.

The Zoom In function helps you make very precise selections by letting you zoom in to a higher magnification and select exactly the portion of the waveform you desire. Also, once you have made a selection, you can adjust the beginning or the end of the current selection by holding down the Shift key and clicking with the mouse. Your selection will be shortened or lengthened accordingly.

Channel Independent Processing

To select only the Left channel, move the cursor over it. The cursor will show a small “L” at the insertion point. To select only the Right channel, move the cursor over it. The cursor will show a small “R” at the insertion point. You can process one channel of an audio document using Peak’s native DSP or third-party plug-ins. However, you cannot edit a single channel of a stereo document (e.g., by using Cut, Copy, or Paste).

Peak allows you to select and process the left and right channels of a stereo file independently, but you cannot edit (i.e., Cut, Paste, Delete, etc.) the left and right channels of a stereo file independently.

A Marker

A marker can be placed in a document to identify a point of importance. A marker appears as a line with a solid triangular base. Peak allows you to place markers into a document in order to mark a given location or region in a document for later selection, navigation, or editing. Markers can be moved, named and renamed, “anchored” to a particular location on a waveform, and given other attributes. The use of markers is covered in greater detail later in this chapter.
A Loop

A loop refers to a section of audio that is bounded by loop markers. In the illustration above, the area that falls between the loop markers “beg loop” and “end loop” is looped. Loops are used to sustain or repeat a section of audio. They can be used for material that you intend to transfer to a sampler, or simply for playback within Peak itself. Peak allows you to create one loop per audio file.

Audio Between Adjacent Markers

Audio between adjacent markers refers to a section of audio that is bounded by markers. In the illustration above, the area that falls between the Break #1 and Break #2 markers is audio between markers. (Note: A selection of audio between markers is different than an audio Region. Regions are described later in this chapter, as well as in Chapter 6, Playlists and Audio CD Burning.)

Audio Info Area

The gray bar at the lower left of each Peak Audio Document is the Audio Info Area. The Info Area shows the sample rate, bit resolution, file format, and file size of the audio file.
playback, and the relative volume of the audio signal as it plays. Each area also shows additional information during different Peak actions, as described below.

**Cursor Location Display**

The cursor location display tracks the vertical and horizontal movement of the cursor. If audio is selected, it also displays information about the duration of the selection.

**Meters**

Peak’s meters are much like the VU or LED meters on a mixing board or tape recorder. They are bar graph meters that show the relative volume or loudness of the audio as it plays. They are also designed to show peak volume and whether the signal has “clipped,” or distorted.

**The Meters dialog**

You can configure the Meters display by choosing Meters from the Audio menu, or by clicking the appropriate button in the Toolbar. Using the Meters dialog, you can select the Peak Hold time, Clip Indicator Hold Time, and also configure the MIDI Meters. The Peak Hold indicators appear as yellow bars at the far right of each of the bar graphs as audio plays, and selecting a hold time causes the indicator to pause for easy reading of the peak value during playback. The Clip Indicators appear as red bars at the far right of each of the bar graphs as audio plays, and are triggered when audio distorts, or “clips”, and selecting a hold time causes the indicator to pause for easy reading of any clipping or distortion that occurs during playback. Setting the Peak Hold and Clip Indicator Hold Times to None turns these features off.
MIDI Meters section of the Meters dialog allows you to configure Peak to send a MIDI note-on message to any OMS device in your system. You set a threshold in this dialog, and every time the threshold is met during audio playback, a MIDI note-on is sent. This is particularly useful with Steinberg’s X Pose Visual Sampler. You can enable the MIDI Meters by selecting the checkbox in the Meters dialog. You can then "tune" the sensitivity of the MIDI Meters by selecting a Threshold value with the slider, select a MIDI Note Range to send the note-on events to, and choose the OMS Device you wish to trigger during audio playback.

Selecting Audio

In order to perform any type of editing action on an audio document, first you must select the portion of the document that you wish to modify. Peak has several techniques for making and modifying selections.

To make a selection with the mouse:

- Click the cursor at the desired location in the audio document and drag to select the desired range.

To extend or shorten a selection:

1. Make a selection with the mouse as explained previously.
2. Hold down the Shift key and click on the end of the selection that you wish to modify.
3. Drag the mouse to extend or shorten the selection. When you are satisfied with the length of the selection, release the mouse.

To select audio between two markers:

1. Hold down the Command key (⌘) and click anywhere in between two markers. (Markers are explained in detail in the next section.) Peak selects the audio between the markers.
2. If there are additional markers in the document and you wish to extend the selection to encompass other portions of audio that fall between the markers, hold down the Shift key and the Command key, and click between another two markers. The selection will extend from the originally selected audio to the audio that you just added.
3. Repeat as desired to navigate to and select additional audio between markers.

.ContentType: text/plain
To select audio between two markers with the Tab key:
1. Create markers at several locations in the document with one of the techniques explained in the next section.
2. Press the Tab key on your computer keyboard. Peak selects the portion of the waveform that lies between the first two markers in the document.
3. Press the Tab key again to select the portion of audio between the next two markers. (If you hold down the Shift key while tabbing the selection through the audio file, you can add each successive area to the selection.)
4. Repeat as desired to navigate to and select additional audio.

To select all audio in a document:
• Choose Select All from the Edit menu or press ⌘-A on your Macintosh keyboard.

Auditioning Audio
It is often useful to audition a selection along with just a bit of audio preceding or following it—without actually including this material in the selection itself. Peak’s Auditioning command allows you to do this by specifying a desired amount of pre-roll or postroll when you play the selection.

To audition audio with pre-roll or postroll:
2. Enter the desired amount of pre-roll and postroll and click OK.
3. Click the cursor in the audio document and drag to select the desired range.
4. Press Control-Spacebar. Peak plays the selection, adding the amount of pre-roll and postroll that you specified.

Scrubbing
Dynamic Scrubbing
Peak provides a unique audio auditioning technique called dynamic scrubbing. This feature is very useful for precisely pinpointing and selecting a desired location in an audio document. Dynamic scrubbing allows you to drag the mouse forward or backward over a waveform while Peak plays a short loop (between 10 and 600 milliseconds) at the scrub location. When you have found the location you are looking for, you can commence editing. Peak allows you to choose the length of this playback loop with the Dynamic Scrub Time command in the Preference menu. Peak provides two type of dynamic scrubbing: dynamic shuttle scrubbing and dynamic jog scrubbing. Both are described below.

To select a loop duration for dynamic scrubbing:
• Choose Dynamic Scrub Time from the Preference menu, and choose a duration from the hierarchical submenu. Typically, a value of between 40 to 80 milliseconds works well.
To use dynamic “Shuttle-type” scrubbing:

1. Hold down the Control key and click and drag the mouse across an area of the audio document in the audio document window. As you drag the mouse, Peak plays a short loop of the audio at the insertion point. You can control the tempo and direction (forward or backward) of playback by dragging the mouse slower or faster, forwards, or backwards.

2. Release the mouse button to stop scrubbing. The insertion point will be exactly where you left off scrubbing.

3. To make a selection starting at the current scrub point, stop scrubbing, hold down the Shift key, and click the mouse to extend the selection from the insertion point to the desired location.

Since jog scrubbing mode is engaged by pressing the Option key in combination with the Control key, it is possible to toggle back and forth between jog and shuttle modes simply by pressing or releasing the Option key.

Tape-Style Scrubbing

In addition to dynamic scrubbing feature, Peak provides tape-style scrubbing. To enable tape-style scrubbing, set the Dynamic Scrub Time under the Preference menu to Tape-Style.

Tape-style Scrubbing requires Sound Manager version 3.3 or later. Please also note that QuickTime 4.0.1 does not support tape-style scrubbing. If you are running QuickTime 4.0.1 you will want to update to a more current version of QuickTime.

To start tape-style scrubbing:

• Hold down the Control key on your keyboard, and then click and drag the mouse at the location where you wish to begin scrubbing.

To deactivate tape-style scrubbing:

• Release the mouse and Control key.

To control tape speed in tape-style scrubbing:

1. As you drag the mouse towards the right, scrubbing speed will increase.

2. As you drag the mouse toward the left, scrubbing will slow down.

3. If you drag the mouse to the left of the point where you started scrubbing, the scrub direction will change from forward playback to backwards playback.

The playback bar will show the scrubbing speed at the top of the playbar. Playback speed can vary from minus
Using the Edits Command to Undo a Series of Actions

Peak’s Edits command provides you with a second unique and powerful method of undoing virtually any number of editing actions performed on an audio document since you last saved it. You can think of the Edits command as a kind of “event list-based” undo with a list of all your editing actions since you last saved. Using this list, you can navigate back in time to the point at which you performed a particular edit, and if you wish, undo it. Once you have returned to an earlier state in the project, you are free to start editing from that point on.

Be aware that if you do go back to a past action and perform a different action at that state in the project, any edits that originally occurred after will be gone, and you won’t be able to redo them.

To use the Edits command to return to or undo an action:

1. Perform several edits. (Don’t use the Save command or you won’t be able to undo any edits that occurred before you saved.)

2. Choose Edits from the Edit menu. A dialog appears listing the edits you have performed since you last saved the document.

3. In the list, double-click on the description of the action you wish to return to (or click the Revert to Item button). Peak returns the document to the state it was in at the time of that edit.

4. If you wish to undo a particular action, locate the action that immediately precedes the one you wish to undo, and double-click it. Peak returns the document to that state.

5. When you have finished, click Done.

Please note that Peak will remain in the state of the action that you last selected in the Edits dialog. If you begin new edits from this point, you will change the original sequence of edits that followed this point in the editing session.
Essential Editing Functions

Peak supports all of the Macintosh’s essential editing functions such as cut, copy, and paste and provides several more specifically designed for audio editing. This section explains how to use each of these functions.

Because Peak allows you to have multiple audio documents open at the same time, it is possible to conveniently cut, copy, paste, and insert audio between documents. This makes combining material from several audio documents very fast and easy.

Scratch Disks

Because audio data can be very large, Peak utilizes a portion of your hard disk’s free space to hold audio data that has been cut or copied, as well as for temporary or scratch files for undo purposes. If you have more than one hard drive attached to your Macintosh, the Scratch Disks command in the Preferences menu allows you to choose the hard drives (or “scratch disks”) that you wish to use for these temporary files. Peak allows you to select which disk you want to have as your default, or “Primary” disk for this purpose—ideally you would select the disk that has the most free space. If you are connected to a file server, you can utilize available storage on the server by clicking the Allow Servers checkbox (that is if you have a very fast server connection). Any available servers will then appear in the Scratch Disks pop-up menu. This is recommended only if you have access to a high-speed Ethernet, Media Net, or other fast server.

Clearing the Clipboard to Reclaim Disk Space

If you no longer need the clipboard contents, you can free up the disk space occupied by the clipboard by choosing the Clear Clipboard command from the Edit menu.

Cutting Audio

The Cut command (⌘-X) allows you to cut a selected range out of a audio document. Audio that occurs after the cut slides over to fill in the gap. By cutting and pasting “pieces” of audio, you can freely rearrange material in an audio document. This can be a powerful tool for creating audio remixes for music-oriented applications, as well as an indispensable tool for general sound design tasks. When you cut a selection, the Macintosh holds the cut audio data in its internal memory (the Clipboard) in case you wish to paste it elsewhere. Because all real time editing you do with Peak is nondestructive, the audio isn’t actually removed from the original audio document until you finally save the file to disk with the Save command. At that time, all edits are saved and any changes that you have made are permanently saved to the audio document.
To cut a selection:
1. Click the cursor at the desired location in the audio document and drag to select the desired range.
2. Choose Cut from the Edit menu (⌘-X) or Toolbar.
3. The selected range is removed from the audio document(s) and held on the Clipboard. Audio occurring after the cut slides over to fill in the gap.

Deleting Audio
If you wish to remove a section of audio from an audio document without using the Cut command, you can use the Delete key, or the Delete button on the Toolbar. As with the Cut command and other editing functions, the audio isn’t actually removed from the original audio document until you save the file to disk.

To delete a selection:
1. Click the cursor at the desired location in the audio document and drag to select the desired range.
2. Press the Delete key, or click the Delete button on the Toolbar.
3. The selection is removed from the audio document. Audio occurring after the deleted section slides over to fill in the gap.

Copying Audio
The Copy command (⌘-C) copies the current selection to the Macintosh’s Clipboard (or internal memory buffer) so that you can paste it, insert it, or use it with optional “Clipboard-based” processing such as Add, Convolve, Mix, and Modulate. As with the Cut command, copying and pasting “pieces” of audio, allows you to freely rearrange material in a document. This can be a powerful tool for creating audio remixes for music-oriented applications, and an indispensable tool for sound design.

To copy a selection:
1. Click the cursor at the desired location in the audio document and drag to select the desired range.
2. Choose Copy from the Edit menu (⌘-C) or Toolbar.
3. The selection is copied to the Clipboard.

At this point, you can use either the Paste or Insert commands to place the copied audio into an audio document. Each of these commands are explained below.

Pasting Audio
The Paste command (⌘-V) allows you to paste the contents of the Clipboard into a location that you choose by placing an insertion point. Pasting audio deletes any selected audio and inserts the clipboard audio at the insertion point. Blending can be used with the Paste command if you have made a selection—the Pasted audio will be crossfaded with the audio on either side of the selection according to the Blending Envelope and Duration.

By cutting and pasting pieces of audio, you can freely rearrange material in an audio document. In musical applications, this gives you the freedom to entirely “rewrite” compositions by changing the order of things, repeating desired sections, and so on. In sound design applications, this gives you the power to “compose” with sound by creating audio collages.

To paste audio into an audio document:
1. Click the cursor at the point where you wish to paste the audio data in an audio document or make a selection of audio you want to delete and replace with the contents of the clipboard.
2. Choose Paste from the Edit menu (⌘-V) or Toolbar.

The Clipboard contents are pasted into the audio document(s), beginning immediately after the insertion point. Any selected audio at the location of the paste is overwritten when the pasted data is inserted into the audio document.
Replacing Audio
The Replace command allows you to paste audio data over existing audio—to paste audio into an audio document without pushing all data to the right of the insertion point farther to the right (later in time) to accommodate the newly pasted audio. The Replace command is useful for “laying over” a portion of audio while maintaining the timing of the original document.

To replace audio into an audio document:
1. Click the cursor at the point where you wish to replace the audio data in an audio document.
2. Choose Replace from the Edit menu or Toolbar. All data to the right of the replaced audio maintains their time position.

Inserting Audio
The Insert command (⌘-D) allows you to paste audio data into an audio document without overwriting any existing data at the insertion point. When you paste data with the Insert command, all data to the right of the insertion point or selection start is pushed farther to the right (later in time) to accommodate the newly pasted audio. The Insert command is one of Peak’s most useful tools for restructuring the contents of an audio document. It is particularly good for “composing on the fly” since it allows you to cut and insert pieces of audio—musical phrases, riffs, or simply textural sounds—to create a composition or soundscape.

To insert audio into an audio document:
1. Click the cursor at the point where you wish to insert the audio data in an audio document.
2. Choose Insert from the Edit menu (⌘-D) or Toolbar. All data to the right of the insertion point is pushed farther to the right (later in time) to accommodate the newly pasted range.

Cropping a Selection
The Crop command (⌘-) allows you to make a selection in an audio document and quickly and easily remove all other audio from the audio document except the selection. The Crop command is a particularly useful tool for editing material to be used as samples or sound effects, since it allows you to isolate and save just the desired portion of a recording.

To crop a selection:
1. Click the cursor at the desired location in the audio document and drag to select the desired range.
2. Choose Crop from the Edit menu (⌘-) or Toolbar.
All audio but the selection is removed from the audio document.

New Document from Selection
The New Document from Selection command will automatically create a new Audio Document containing the selected audio from the source document.

To create a new document from a selection:
1. Make a selection in any open audio document that you want to have as its own document.
2. Choose Document from Selection from the New submenu under the File menu (Control-⌘-N).
3. A new audio document will be created with the selected audio.

Silencing a Selection
The Silence command (⌘-E) replaces the selected audio in the audio document’s selection with silence. This feature is very useful for silencing nonessential portions of a recording that contain an unusual amount of noise. This can be used very successfully with spoken material such as dialog or narration to remove noise between words or during pauses in speech. It can also be used to remove pops or clicks that occur in such material.

To silence a selection:
1. Click the cursor at the desired location in the audio document and drag to select the desired range.
2. Choose Silence from the Edit menu (⌘-E) or Toolbar.

The selected audio is replaced with silence.

**Inserting Silence into a Document**

The Insert Silence command allows you to insert a specific amount of silence into an audio document at the current insertion point. This feature is very useful for inserting pauses of a desired duration into a recording, and can be particularly useful in adjusting the timing or rhythm of spoken material such as dialog or narration. When you choose this command, Peak will prompt you to enter the amount of silence you wish to insert. You can enter this value in samples, milliseconds, or seconds. All audio occurring after the insertion point is moved later in time by the amount of the silence that you insert.

![The Insert Silence dialog](image)

**To insert silence of a specific duration into a document:**

1. Click the cursor at the desired location in the audio document.
2. Choose Insert Silence from the Edit menu or Toolbar.
3. In the dialog that appears, enter the amount of silence that you wish to insert into the audio document.

Peak inserts the specified amount of silence into the document.

---

**Show Edits**

When you enable the Show Edits command Peak indicates areas of an audio document that you have edited by enclosing these areas with hatched lines. This provides you with a convenient visual reference to portions of the document that have been affected by your editing actions. Once you save a document, the edits are saved, and these indicators will no longer appear.

**To enable Show Edits:**

- Choose Show Edits from the Preference menu. A check next to this item indicates it enabled.

**To disable Show Edits:**

- Choose Show Edits again from the Preference menu. The absence of a check next to this item indicates it disabled.

---

**Using Crossfades and Blending to Smooth Edits**

Blending is an automatic crossfade function with a user-editable envelope. Peak can apply blending to areas of an audio document where they are modified by cutting, deleting, pasting, or other editing processes in order to smooth abrupt transitions between waveform amplitudes. It can be very useful for creating a smooth transition between edits that would otherwise sound too abrupt. If you are going to edit (i.e., Cut, Paste, Delete, etc.) a document, you may wish to enable blending to smooth things out a bit. You can toggle blending on or off by choosing the Blending from under the Preferences menu, or by clicking the Blend enable/disable button in the Cursor Palette (Caps Lock key) or in the Toolbar.
Be aware that Blending can interfere with certain DSP processes available under Peak's DSP menu, such as Fade In/Out and Normalize. You will typically only want to enable Blending only when you intend to make an edit which Blending may be desirable.

To enable blending and set blending parameters:
1. Choose Blending from the Preference menu or Toolbar, or Option-click on the Blending button in the Cursor Palette. The Blending dialog appears.
2. Click the Blending checkbox to turn this feature on.
3. Enter a value in milliseconds in the Duration field. Peak will apply a crossfade of this duration across the edit.
4. If you wish to edit the shape of the crossfade that the blending function applies, click the Edit Blending Envelope.
5. Peak’s Crossfades are calculated logarithmically to preserve volume levels for crossfaded material. If you want Peak to calculate the Blending Crossfade linearly, check the Linear Blend Calculations checkbox.
6. Click OK when you have finished.

To select and edit the blending envelope:
1. Choose Blending from the Preference menu and click the Edit Blending Envelope button. The Blending Envelope Editor appears. The envelope shape shown here represents the shape of the crossfade. Peak also comes with several commonly used preset envelopes that appear in the pop-up at the top of all of Peak's Envelope Editing windows (see also Editing a Fade In/Out Envelope). These are stored in the Peak Envelopes folder in your Peak folder.
2. Click anywhere on the line and a new moveable “breakpoint” will appear.
3. Drag the breakpoint to the desired location.
4. Continue creating and dragging breakpoints until you have created the envelope that you desire. If you wish to delete a breakpoint, click on it with the cursor and press the Delete key on your computer keyboard.
5. If you wish to reverse the shape of the envelope you have created, click the “<−>” button. This creates a mirror image of the envelope.
6. If you would like to save your custom envelope for
later use, click on the Save button before exiting the envelope editor. Your custom envelopes will be stored in the Peak Envelopes folder, and will appear in the pop-up at the top of the envelope editor.

7. When you are satisfied with your new envelope shape, click Change to confirm your edits and close the envelope editor. Peak will use this envelope until you change it again.

⚠️ Note that the Blending Envelope will only be applied to an edit if it is configured prior to making the edit.

⚠️ If Linear Blend Calculations is checked in the Blending dialog, the Equal Power X-fade envelope is very effective for a smooth crossfade that will not result in a dip in the energy of the audio data.

---

Creating Fade-ins and Fade-outs

Peak allows you to create fade-ins or fade outs at any point in an audio document. Fade ins/outs can be very useful for smoothly fading in or out of an audio document, or for fading out of one type of audio material into another. Very short fade ins can also be useful for smoothing or removing clicks and pops in a recording. Peak allows you to control the exact “shape” of the fade in/fade out by providing you with preset envelope shapes as well as very precise user-definable envelope controls for the fade. Peak also comes with several commonly used preset envelopes that appear in the pop-up at the top of the Envelope Editing windows. These are stored in the Peak Envelopes folder in your Peak folder.

**To create a Fade In:**

1. Click the cursor at the desired location in the audio document and drag to select the range you desire. The Fade In will be applied to the audio within this selection.

2. Choose Fade In Envelope from the Preference menu.

3. In the dialog that appears, you can use the default envelope, edit the envelope, or load any envelopes included with Peak or that you have created yourself. (“Editing Fade In/Fade Out Envelopes” is covered in the next section.)

4. Choose Fade In from the DSP menu. Peak applies the Fade In to the selection you have made in the audio document.

5. To hear the completed Fade In, press Option-Spacebar. You will hear the selected audio complete with your Fade In.

**To create a Fade Out:**

1. Click the cursor at the desired location in the audio document and drag to select the range you desire. The Fade Out will be applied to the selected audio.

2. Choose Fade Out Envelope from the Preference menu.

3. In the dialog that appears, you can use the envelope, create your own, or load any envelopes that you have saved to your hard disk. (“Editing Fade In/Fade Out Envelopes” is covered in the next section.)

4. Choose Fade Out from the DSP menu. Peak applies the Fade Out to the selection you have made in the audio document.

5. To hear the Fade Out, press Option-Spacebar. You will hear the selected audio complete with your Fade Out.

**Editing a Fade In/Fade Out Envelope**

Peak allows you to control the exact shape of Fade Ins/Fade Outs by providing you with controls for editing the Fade In/Fade Out envelope. These are found in the Fade In Envelope and Fade Out Envelope commands in the Preference menu.
To edit and save a Fade In/Fade Out envelope:

1. Choose Fade In Envelope (or Fade Out Envelope) from the Preference menu. The Fade Envelope Editor appears. The envelope shape shown here represents the shape of the fade, and overlays the selected audio to show where the curve is graphically applied to the waveform representation of the audio.

2. Click anywhere on the line and a new moveable “breakpoint” will appear.

3. Drag the breakpoint to the desired location on the envelope’s curve.

4. Continue creating and dragging breakpoints until you have created the fade envelope that you desire. If you wish to delete a breakpoint, click on it with the cursor and press the Delete key on your computer keyboard.

5. If you wish to reverse the shape of the envelope you have created, click the “<–>” button. This creates a mirror image of the envelope.

6. If you would like to save your custom envelope for later use, click on the Save button before exiting the envelope editor. Your custom envelopes will be stored in the Peak Envelopes folder, and will appear in the pop-up at the top of the envelope editor.

7. When you are satisfied with your new envelope shape, click Change to confirm your edits and close the envelope editor. Peak will use this envelope every time you apply a Fade In (or Fade Out) until you change it again.

Note that the Fade In/Fade Out Envelope will only be applied to a selection if it is configured prior to applying the Fade In/Fade Out DSP function.

To load a Fade In/Fade Out envelope:

1. Choose Fade In Envelope (or Fade Out Envelope) from the Preference menu. The envelope editor appears.

2. Click the Load button.

3. In the dialog that appears, locate and select the fade envelope that you desire, and click Open.

4. Click Change to confirm this new envelope and close the envelope editor. Peak will use this envelope until you change it again.

Creating and Using Markers

Peak has a very powerful set of features to control the placement and modification of markers. Markers are locations in an audio document that you define as important. By marking specific locations in a recording, you can navigate easily to a location for selection, editing or playback purposes.

Markers can also be made into as loops. Loops are used to sustain or repeat a section of audio. They can be used for material that you intend to transfer to a sampler, or simply for playback within Peak itself. Peak allows you to create one loop per audio file. Loops are covered in greater detail later in this chapter.
Creating Markers

As we’ll describe in detail on the next few pages, there are two ways to create markers: by dropping them “on the fly” during playback, or by defining them with the mouse when playback is stopped. Of the two, the mouse method is perhaps the more precise. However, since it is possible to fine tune the location of a marker at any time by dragging it (or by using the Edit Marker dialog, explained later). Both methods work equally well.

⚠️ Remember that if Auto Snap To Zero is enabled the insertion point will snap to the nearest zero-crossing. This will cause your marker be placed at the nearest zero crossing when you use the mouse to create or place a marker.

Once you have created a marker, you can assign or edit the marker’s attributes in the Edit Marker dialog. Double-click the triangular base of the marker to open the Edit Marker dialog.

The Edit Marker dialog

Text

You may wish to give markers meaningful names (up to 256 characters long) based on their locations in an audio document. Peak gives markers default numeric names based on the name of the audio document and the order in which the marker was defined. To name or rename a marker, simply type the new name in to the Text field of the Edit Marker dialog.

You can easily find any marker, region, or loop that you have named by simply typing the first few letters of its name. For example, if you want to locate a marker called “Solo,” just type s-o-l, and Peak will automatically scroll to the marker called “Solo.” If you hit Enter or Return after typing the characters, Peak will also automatically place the insertion point at that marker. If more than one marker matches the letters you type in, Peak will locate the first marker with that name. (Note that numerical marker name entries will only work from the keypad, not the numbers keys along the top of your keyboard.)

Marker Position

The Marker Position field allows you to move a marker to a specific time location in an audio document by entering the desired value. The pop-up menu to the right of this field allows you to choose a time format (samples, minutes:seconds:miliseconds, etc.) for the value that you enter in the Marker Position field.
Marker, Loop Start, and Loop End
These three radio-style buttons allow you to define whether the marker is a regular marker or a loop marker. If you choose to designate the marker as loop marker, you can define it as either the loop start or the loop end by clicking on the corresponding radio button. Remember, Peak allows only one loop per audio file.

Anchor To Sample
When you insert or delete audio that is near a marker, you may want the marker to move with that particular location on the waveform. This will compensate for the insertion or deletion, so that the marker remains with the particular portion of audio you want it to be associated with. By enabling the Anchor feature for a marker, you can assure that Peak will “tie” the marker to a location on a waveform, causing it to stay with that location even when audio is inserted or deleted into the document. By default, Peak enables this feature for markers, loops and regions.

Reference Point
By defining a marker as a reference point, you can use the marker as a reference when you make selections or move other markers. Selecting or dragging the marker will then automatically display the distance to the closest reference marker in whatever time format (samples or seconds) is currently selected in the Peak application. This may be useful, for instance, if you know that you want a particular sound event (such as a car door slam) to happen a certain number of seconds before or after another sound event (such as a tire squeal).

Delete Marker
The Delete Marker button allows you to remove the currently selected marker from an audio document.

The following section explains how to create markers and define their attributes.

To create a marker when playback is stopped:
1. Click the mouse at the desired location in the audio document. A dotted vertical line appears, indicating the insertion point.
2. Press ⌘-M on your computer keyboard or choose New Marker from the Action menu or Toolbar. Peak will drop a marker at that location.

To create a marker during playback:
2. At the desired point during playback, press ⌘-M on your computer keyboard. Peak will drop a marker at that location.
3. Repeat as desired as playback continues. Each marker will appear at the appropriate location in the audio document window.

To create a marker using dynamic scrubbing:
1. Hold down the Control key (or Control-Option for jog-type scrubbing) and drag the mouse across the desired location to scrub playback.
2. At the desired point during playback, release the mouse to stop scrubbing.
3. Press ⌘-M on your computer keyboard. Peak will drop a marker at that location.

To name a marker or set other marker attributes:
1. Double-click on the triangular base of the marker that you wish to edit. The Edit Marker dialog appears.
2. Enter a name for the marker.
3. Change other attributes of the marker as desired. For an explanation of each of these attributes, refer to the beginning of this section.
4. When you have finished, click OK to close the Edit Marker dialog. The marker now has the attributes you selected.
To move a marker to a new location:
1. Click on the triangular base of the marker and drag it to the desired location.
2. To make a marker's position snap to a zero-crossing (the point at which a waveform crosses the center phase line) as you drag it, hold down the Shift key while you drag.

To move a marker to a new location numerically:
1. Double-click on the triangular base of the marker. The Edit Marker dialog appears.
2. Choose the desired time units (samples, seconds, or milliseconds) from the time format pop-up menu.
3. In the Position field, enter the precise time location that you wish to move the marker to.
4. Click OK to close this dialog. Peak moves the marker to the location you entered in the dialog.

To nudge a marker or a selection of markers to a new location:
1. Make a selection that includes the marker (or markers) that you wish to nudge.
2. Choose Nudge Markers from the Action menu or Toolbar. The Nudge Markers dialog appears.
3. In the Nudge Markers by... field, enter the number of seconds (positive or negative) by which you wish to nudge the marker.
4. Click OK to close this dialog. Peak nudges the marker by the value you entered in the dialog.

To delete a marker:
1. Double-click the triangular base of the marker. The Edit Marker dialog appears.
2. Click the Delete button. The marker is deleted from the audio document.
3. Click OK to close the Edit Marker dialog.

To delete markers in a Selection:
1. Make a selection in the audio document that contains the markers you want to delete.
2. Choose Delete All Except Audio (Option-Delete) from the Action menu and all markers, regions, and loops in the selection will be deleted.

Regions

Regions are portions of an audio document defined by Region Markers using the New Region command from the Action menu (⌘-Shift-R) or Toolbar. Regions present in currently open audio documents will be listed in the Contents window.

Peak's use of Regions will be discussed further in the chapter on Playlists and CD Burning.

Regions can be saved only into AIFF and Sound Designer II files created by Peak. However, Peak will also read Regions stored from other programs in Sound Designer II files. The method Peak uses to store Regions in AIFF files is specific to Peak and is not necessarily supported by other software applications. If you are using Regions with other programs, you will want to store your files as Sound Designer II files.
To define a new Region:
1. Make a selection in an opened audio document.
2. Choose New Region from the Action menu (⌘-Shift-R) or Toolbar.
3. Type the name of the Region and click OK. The new Region will appear in the audio document.

To modify the length of the Region by changing the start or end:
• Drag the start or end marker of the Region in the audio document window.

To move a Region without changing its length:
• Hold down the Option key and drag either the start or end marker of the Region.

To edit a Region’s start, end, or length manually:
1. Double-click on either the start or end marker of the Region in the audio document window. The Edit Region dialog will appear.
2. Enter new values for Start, End, or Length times, then click OK.

Creating Loops

If you’re editing music or other rhythmically-based material, it is generally a good idea to test a selection to make sure it contains an even number of beats before you cut, copy, or paste it. A good way to do this is to loop the selection and listen to the loop as it plays. As described in the next section, Peak includes Loop Surfer, which can automate the process of finding a rhythmically “correct” length of audio to loop, assuming you know the tempo and the number of beats you wish to loop. You can also use the Loop Tuner, found in the DSP menu, to adjust the loop start and end points. The Loop Tuner is also described in the next section.
Loops are useful in material that you plan to transfer to a sampler. Loop markers created with Peak are recognized by samplers as sustain loops. Peak allows you to create only one loop per audio document.

To play a loop in Peak, select Use Loop in Playback command (⌘-L) from the Preference menu or click the loop button on the Cursor Palette, begin playback, and when Peak reaches the loop, it will continue to repeat until you stop playback. If Use Loop in Playback is not enabled, Peak will simply play right through the loop to the end of the audio document or selection.

**To create a loop from a selection:**
1. Click the cursor at the desired location in the audio document and drag to select the range you want.
2. Choose Loop This Selection from the Action menu (⌘-Shift-“-”) or Toolbar. Your selection is now looped. Loop markers appear at the beginning and end of the loop.
3. To listen to the loop, choose the Use Loop in Playback command (⌘-L) from the Preference menu (a check next to this menu item indicates it is enabled), or click the Loop button on the Cursor Palette, and start playback by pressing the Spacebar on your keyboard.
4. You can interactively fine tune a loop by dragging the loop start or end markers while loop playback is engaged. As you drag a loop marker to a new location, Peak will adjust the playback loop to reflect the changes you make. You can also use the Loop Tuner to call up a dialog that allows you to visually fine tune the loop, and even play the loop while adjusting it to listen to the changes.

**To change regular markers into loop markers:**
1. Create markers in a audio document.
2. Double-click on the triangular base of the marker that you wish to define as the loop start point. The Edit Marker dialog appears.
3. Click the Loop Start button and click OK. The marker becomes a Loop Start marker.
4. Double-click on the triangular base of the marker that you wish to define as the loop end point. The Edit Marker dialog appears.
5. Click the Loop End button and click OK. The marker becomes a Loop End marker. You have now defined a loop in your audio document.

**To move a pair of loop markers together:**
- Hold down the Option key and drag one of the loop markers to the desired location. Both markers move in tandem as you drag.

**To listen to the loop only:**
1. Choose Select Loop (⌘-“-”) from the Edit menu to select the loop.
2. Make sure loop playback is enabled using the Use Loop in Playback command from the Preference menu (a check next to this menu item indicates it is enabled), or by pressing the Loop button on the Cursor Palette.
3. Press the Spacebar to begin playing back the loop.

### Crossfading Loops

Peak allows you to crossfade the start and end points of a loop. Crossfading a loop can be very useful for smoothing the transition between the end of the loop and its beginning as it repeats. Peak allows you to control the envelope of the crossfade, the duration, and other parameters in the Crossfade Loop dialog.

**To Crossfade a Loop:**
1. Create a new loop or choose existing loop.
2. Select the loop by ⌘-clicking between the loop markers.
3. Choose Crossfade Loop... from the DSP menu or the Toolbar.

4. The Crossfade Loop dialog appears.

5. Choose where you want crossfades to be applied using the check boxes along the top of the Crossfade Loop dialog. Typically, the default for this works well.

6. Enter the Duration for the crossfade(s) in milliseconds.

7. Check whether or not you want the crossfade calculated logarithmically or not (i.e., linearly).

To edit a Crossfade Loop Envelope:

- Click on the Envelope button in the Crossfade Loop dialog and the Blending Envelope Editor appears.

2. Click anywhere on the line and a new moveable “breakpoint” will appear.

3. Drag the breakpoint to the desired location.

4. Continue creating and dragging breakpoints until you have created the envelope that you desire. If you wish to delete a breakpoint, click on it with the cursor and press the Delete key on your computer keyboard.

5. If you wish to reverse the shape of the envelope you have created, click the “<->” button. This creates a mirror image of the envelope.

6. If you would like to save your custom envelope for later use, click on the Save button before exiting the envelope editor. Your custom envelopes will be stored in the Peak Envelopes folder, and will appear in the pop-up at the top of the envelope editor.

7. When you are satisfied with your new envelope shape, click Change to confirm your edits and close the envelope editor. Peak will use this envelope until you change it again.

To hear the completed crossfade, choose Select Loop from the Edit menu, select Use Loop in Playback from the Preference menu or click the Loop button on the Toolbar, and press the Spacebar. You will hear the loop, complete with your crossfade.
Using Loop Surfer™

Peak’s Loop Surfer feature automates some of the steps for setting up loop points. Loop Surfer allows you to “Loop Surf” (adjust your loops during playback) quickly, easily and in a musically intuitive manner.

If you’re working with music, and know the music’s tempo in beats per minute, you can use Loop Surfer to create a loop which lasts for a rhythmically “correct” length of time.

To use Loop Surfer based on a musical tempo:

1. Place the cursor where you wish to begin the loop (it’s okay to place it approximately, rather than exactly, where you wish to start).

2. Choose Loop Surfer from the Action menu (⌘J). The Loop Surfer dialog appears.

3. Type in the music’s tempo. If you are not sure of the tempo, you can use the Tempo Calculator to determine the tempo. Simply select a portion of audio, and type in the number of bars and beats in the selection. The calculator will determine the tempo based on your selection. If you are unsure, and have used a drum machine or sequencer to create the music, you might wish to refer back to its settings determine the time signature and tempo. Additionally, you can use the Threshold command from the DSP menu to select a portion of audio that should correspond to the beat; see “To use Loop Surfer based on a selection” below.

4. Type in the number of beats that you wish the loop to last. The beats are based upon quarter-notes, in terms of musical time. For instance, if your song was in a 4/4 time signature, typing “4” beats would mean the loop would be one measure in length; if the song were in 7/4 time, typing “14” would mean the loop would be two measures in length. (If you are interested in exploring syncopations, however, there’s no reason why you can’t type a beat value that doesn’t correspond to the time signature, such as “5” if the music is actually in “3/4” time.)

5. If you then select the Start Surfing button (the default), Peak will automatically:
   a) close the Loop Surfer dialog box;
   b) extend the selection from the cursor insertion point to a calculated length, based upon the tempo and number of beats;
   c) change the cursor insertion point to a Loop Start marker;
   d) drop a Loop End marker at the end of the newly calculated selection;
   e) turn on (if it hasn’t already been turned on) the Use Loop In Playback option under the Preference menu.
   f) begin looped playback of the audio selection, stopping only once you hit your keyboard’s Spacebar or press Stop on the Toolbar.

6. If you select the Make Loop button, Peak will automatically:
   a) close the Loop Surfer dialog box;
   b) extend the selection from the cursor insertion point to a calculated length, based upon the tempo and number of beats;
   c) change the cursor insertion point to a Loop Start marker;
   d) drop a Loop End marker at the end of the newly calculated selection;
e) turn on (if it hasn’t already been turned on) the Use Loop In Playback option under the Preference menu.

f) At this point, you must start playback manually using the Spacebar or the Toolbar if you wish to begin Loop Surfing.

While you’re Loop Surfing (adjusting your loop during playback), you’re free to perform all of the standard looping functions as described in the previous section, including adjusting the Loop Start and End points during playback. Most importantly, however, since you’ll now have a selection that lasts for a period of time that matches the beat, you can freely move the markers in tandem, by holding down the Option key and clicking and dragging one of the loop markers to the desired location with the mouse. You’ll find it’s a great way to set up interesting rhythms and syncopations! Peak’s interactive editing capabilities also allow you to use the Loop Surfer dialog while a loop plays to adjust the tempo, beats and so on.

If you’re not working with music (or if you simply don’t know the tempo of the music you’re working with), you might choose to Loop Surf based upon a selection (or use the Threshold feature), rather than starting at a cursor insertion point.

**To use Loop Surfer based on a selection:**

1. Place the cursor where you wish to begin the loop, and using the mouse, select the portion of audio you wish to loop. (You can make your selection in a variety of other ways, also, as described earlier, including selecting between markers by Ô-clicking with the mouse).

2) Select Loop Surfer from the Action menu. The Loop Surfer dialog appears.

3) If you check the Use Selection box and select either the Start Surfing or Make Loop button, Peak will automatically:

   a) close the Loop Surfer dialog box;
   b) extend the selection from the cursor insertion point to a calculated length, based upon the tempo and number of beats;
   c) change the cursor insertion point to a Loop Start marker;
   d) drop a Loop End marker at the end of the newly calculated selection;
   e) turn on (if it hasn’t already been turned on) the Use Loop In Playback option under the Preference menu;
   f) begin looping and playing. The selection will begin looped playback (if you have selected Start Surfing); or
   g) wait for you to start playback manually using the Spacebar or the Toolbar if you wish to begin Loop Surfing (if you have selected Make Loop).

**LE Loop Surfer is not available in Peak LE.**

**Using the Guess Tempo and Threshold commands to find tempo**

If you are working with music and don’t know the tempo—and your music has a relatively pronounced or obvious beat—you can use the Guess Tempo command to have Peak automatically guess the tempo of a selection. Make a selection and choose Guess Tempo from the Action menu. There will be a pause while Peak scans your selection and calculates the tempo for you. A dialog will then appear showing you the estimated tempo in BPM, or beats per minute. You can then enter the estimated tempo in BPM in the Loop Surfer dialog’s Tempo field or in the Audio Information dialog’s Tempo field.

You can also use the Threshold command (described later in this chapter) to define a number of markers or Regions based on amplitude peaks. If you then select audio with start and end points that correspond to these sections, you should have a selection that precisely matches the musical beat. Using Loop Surfer, you could then automate the process of looping the selection by following the steps described directly above.

Guess Tempo works best with audio selections that contain one full measure of audio with pronounced attacks on the beats, which appear visually on the waveform as taller sections of the audio. Using the Normalize feature on the selection prior to Guess Tempo can improve the accuracy of its deduction.
Guess Tempo is not available in Peak LE.

Using the Loop Tuner

Peak’s Loop Tuner provides a way to visually line up the start and end points of your loop to get a smooth transition at the loop points. Loop Tuner also allows you listen to the effects of these adjustments as you make them. If you wish to “tune” a loop you’ve made, simply select Loop Tuner from the DSP menu or Toolbar, and a dialog will appear. The waveform display in the Loop Tuner dialog shows the Start and End points of the loop, which you can visually adjust with the scroll bars at the bottom of the window. The two zoom buttons—magnifying glass icons—in the upper left of the Loop Tuner dialog allow you to adjust the vertical zoom up of the waveform. The two zoom buttons in the lower left hand corner of the Loop Tuner dialog allow you to adjust the zoom view in and out all the way down to the sample level. You can listen to the effects of the adjustments as you make them by clicking on the Play button. To exit this dialog, click on OK to accept the changes, or Cancel to leave the original loop unaffected.

Exporting Regions

If you have placed markers or Regions in an audio document, Peak’s Export Regions command allows you to export those regions from the source document save each of these regions as a separate audio document. This feature is very convenient if you wish to divide a larger file into regions and transfer them as samples into a sample playback instrument, or divide a live concert record into regions and export those regions as separate files. Furthermore, you can use Peak’s Batch File Processor to process a file’s regions with any of Peak’s DSP functions and third party plug-ins during the automatic exporting of regions into new files.

To export regions from an audio document:

1. Select the regions that you wish to export. (You can use the Tab key, Shift-Tab, or if you wish to select the entire document, press §§-A.)
2. Choose Export Regions from the File menu.
3. In the Export Regions dialog, choose the parameters that you wish to use for selecting the regions to export.
4. Using the Region Detection options, choose which regions are to be exported.
5. Using the Output Format options, choose the format and resolution you wish for the exported regions.
6. Using the Output Directory options, choose the destination for the exported regions.
7. If you wish the newly exported regions to appear as new open Peak documents, choose Output to new windows.
8. To save the exported regions to disk, select Save To Disk and choose whether you would like to save the regions into the same folder as the source files, or to a different folder. If you prefer to save
to a new folder, use the Set Path button.

9. To export the regions, click Begin. Peak exports each of the regions into its own audio document.

The Export Regions dialog

**Region Detection area**

To export all regions in an audio document, click the Export Regions button. To export audio between adjacent markers, click the Export Audio between Markers button. To export only regions that are bounded by specific marker names, click the Only Regions button and enter the parameters that you wish to use to select the desired regions. For instance, if you wish to export only regions bounded by markers with the word “hit” in them, click the pop-up menu, choose containing, and type the word “hit” in the field next to the pop-up. Conversely, if you wish export all regions except those with the word “hit” in them, click the pop-up menu, choose not containing, and type the word “hit” in the field next to the pop-up menu.

**Output Format area**

Choose the file format, bit depth resolution, and Stereo or Mono from these pop-up menus for the resulting exported audio documents. You can set the Sample rate in kHz for the resulting files in the Rate field (please note that this will not do sample rate conversions). You can also designate whether the resulting audio documents contain Regions or Markers or not.

**Output Directory area**

Resulting audio documents can either be output to new open audio document windows or saved to the hard drive. Choose Output to new windows if you want to have the resulting audio documents open in Peak or choose Save To Disk if you just want to write the new audio files to disk without opening them in Peak. If you Save To Disk, you can simply choose to use the original audio document’s folder or you can specify another folder on your hard drive(s) to save the resulting audio documents by choosing Set Path.... The Name Prefix field allows you to include a specified prefix to all the resulting audio documents. The default prefix is the name of the file. Each and every one of the resulting audio documents will be named with the prefix plus the name of the individual region.

*Be aware that the Name Prefix plus the name of the region being exported cannot exceed the maximum number of characters for a file name allowed by the Mac OS or Peak will return an error and the Region will not be saved.*

Another exciting feature of the Export Regions function is that you can Export Regions through Peak’s Batch File Processor. First configure that Batch File Processor and turn it on, then, go to Export Regions and check the Use Batch File Processor checkbox. When you begin exporting regions, each region exported will be processed by the DSP processes you choose in the Batch File Processor dialog (see Chapter 7: DSP & Plug-Ins).

*Do not save the output of the Batch File Processor to input directory (i.e., a folder that is or is inside a folder of files that are being Batch Processed).*
Export Regions is not available in Peak LE.

Editing QuickTime Soundtracks in Peak

Peak allows you to edit QuickTime movie soundtracks. While you cannot edit QuickTime video in Peak, you can use Peak as a full-featured audio post-production tool for QuickTime movies. This makes Peak an ideal tool for editing and cleaning up soundtracks, as well as adding sound effects or music to QuickTime movies.

The Peak Movie Window

How to open and edit QuickTime soundtracks in Peak:

1. Select Open from the Edit menu (⌘-O) or Toolbar.

2. In the dialog that appears, locate the QuickTime movie that you wish to open.

3. Click the Open button, and Peak will open the QuickTime movie in a movie window, and open the movie’s audio track in an audio document window. Use the Quicktime Sound Tracks from the Preferences menu to Enable or Disable the movie’s other audio tracks. You can also use this dialog to toggle multiple soundtracks contained in a movie on and off to check balances or “solo” certain tracks. Click on the Set button to accept the changes, or Cancel to leave the movie unaffected. To toggle the Movie Window on or off, choose Movie from the Window menu. A check next to this item indicates it is enabled.

4. You may now edit the movie’s audio track as you would any other audio document. The movie will “scrub” along with the audio, and the placement of the insertion point in the audio document window will also scroll the movie to that point.

5. When you are finished editing the QuickTime sound track, use Peak’s “Save As” command to save the movie with its new sound track.

Peak will not allow you to import QuickTime movies that have no audio tracks. If you want to add audio to a QuickTime movie that has no audio tracks, use MoviePlayer first to add audio tracks (even empty ones) to the movie, save the movie, and then open the movie in Peak.

Be Careful not to change the duration of the audio using cut, delete, or insert, as this will cause the audio and video to fall out of sync.

QuickTime Movie support is not available in Peak LE. Peak LE can open and edit QuickTime audio, but it will not open the QuickTime Movie window.
Conclusion

You have now learned how to manipulate audio with Peak’s various editing tools, including how to work with Markers, Loops, and Regions. In the next chapter you will learn more about the use of Regions in Playlists.
Chapter 6
Playlists and Audio CD Burning
Chapter 6: Playlists and CD Burning

Introduction

This chapter explains how to use Peak’s Playlist feature to sequence audio events. A Playlist is a list of Regions strung together in a specific order. The Peak Playlist is merely a set of instructions that tell the hard disk which playlist regions to “read” in what order. Playlist editing does not permanently alter the original audio data on your hard disk. No matter how many changes you make, your original recordings remain intact. This type of nondestructive editing is one of Peak’s most significant and powerful features.

When you edit an audio file within Peak’s Playlist window you are not really deleting, moving, replacing, and adding actual audio as you would if you were cutting and splicing analog tape. Instead, Peak is merely creating a “map” of your audio file. This map, or “playlist,” simply describes the order in which you want portions of the recording to be played. If you’d like to hear the middle of a song first, the end next and the beginning last, then so be it. Peak will read (e.g., play) from the hard disk (where the audio data is stored) from any number of possible points designated by Region markers, and these Regions can be auditioned in the Playlist in any number of possible arrangements.

Playlist editing allows you to adjust and re-sequence segments of audio (e.g., Regions) with fluidity and ease. Edits can be heard as soon as you perform them. In addition, Peak allows you to apply Premiere-format audio plug-ins to playlist events in real-time! Peak’s Playlist offers a fast, flexible, and powerful approach to editing and processing digital audio.

Peak also lets you burn Track At Once (TAO) and Disk At Once (DAO) audio CDs from Playlists using Roxio Toast™ (Roxio Toast Lite comes bundled with Peak). You can also use Peak’s Playlist to create a Jam Image file for burning DAO, audio CDs using Roxio’s JAM™ (JAM is sold separately). Please consult Roxio for compatible CD-Burners using either Toast or JAM. You can also bounce (i.e., write to disk) your Peak Playlist as a Sound Designer II file and then import the Playlist Events as Regions into Digidesign’s MasterList CD or Emagic’s WaveBurner.

Regions

The audio events that are played back in a Playlist are Regions—portions of an audio document defined using the New Region command from the Action menu (⌘-Shift-R) or Toolbar. A Region is defined by Region Markers in the audio document window. All Regions defined in open audio documents will also be listed in the Contents Palette.

Two of the main windows you will use to organize Regions are the Contents Palette and the Playlist. The Contents Palette is available under the Window menu, and will show all of the regions in open audio documents at a glance. You can drag and drop Regions names from the Contents Palette into the Playlist. To display all of the regions in open documents, click on the left “tab” of the named Audio Document listed in the Contents Palette. If you drag and drop an Audio Document’s name from the Contents Palette into the Playlist, it will add all the Regions in that Audio Document to the Playlist.
Regions can only be saved in AIFF, Sound Designer II, and JAM Image file formats created by Peak. However, Peak will also read Playlist Regions stored from other programs in Sound Designer II files. The method Peak uses to store Regions in AIFF files is specific to Peak and is not supported by other software applications. If you are planning to use Regions created with Peak in other programs, you will usually want to save your files in Sound Designer II file format.

To define a new Region:
1. Make a selection in an opened audio document.
2. Choose New Region from the Action menu or Toolbar. The Edit Regions dialog will appear.
3. Type the name of the Region and click OK. The new Region will appear in the audio document.

To modify the length of the Region by changing the start or end:
• Drag the start or end marker of the Region in the audio document window.

To move the start and end points of the region together:
• Option-drag on the start or end marker of the Region.

To change the name of a Playlist Region:
1. Double-click on either the start or end marker of the Region in the audio document window, or Option-double-click on the Region name in the Contents Palette. The Edit Regions dialog will appear.
2. Type the new name of the Region into the dialog and click OK.

To move a Region without changing its length:
• Hold down the Option key and drag either the start or end marker of the Playlist Region.

To edit a Region’s start, end, or length manually:
1. Double-click on either the start or end marker of the Playlist Region in the audio document window or Option-double-click on the Region name in the Contents Palette. The Edit Region dialog will appear.
2. Enter new values for Start, End, or Length times, then click OK.

To locate a Region:
• Double-click the Region you wish to locate in the Contents Palette. The audio document will scroll automatically to display the region and
the Playlist Region will become the current selection in the audio document.

---

**Creating a Playlist**

**To create a new Playlist:**

- Select Playlist Document from the New... submenu under the File menu (⌘-Shift-P). An empty playlist document will appear. The top of the playlist has category titles for each column of information. The bottom of the playlist shows total duration of the playlist.

**To add an item to the playlist:**

1. Make sure the Playlist is the front-most document in Peak (⌘-P). Select the Contents Palette from the Window menu if it is not already open.

2. Drag and drop the names of the Regions in the Contents Palette into the Playlist to add Regions to the Playlist. Each Region you add to the Playlist becomes a Playlist Event. The center of the Playlist window shows Playlist Events as a sequential list. You may use Regions from multiple audio documents. Any audio documents containing Regions used in the current Playlist must be open in Peak to be available to the Playlist.

---

---

All audio documents referenced by the Playlist must have the same sample rate, number of channels (i.e., mono or stereo), and bit-depth.

The controls along the top of the Playlist window give you access to most of the Playlist functions. There are transport controls at the top right of the window that allow you to audition the Playlist from the currently selected Region, or Playlist Event. There is a time display in the middle of the window. From left to right, the icons in the upper left of the Playlist window are Crossfade Select, Delete, Nudge Regions, Burn CD, and Bounce Playlist buttons.

---

A playlist event has several properties that can be modified: crossfade in, gap time, crossfade out, gain, and up to four DSP plug-ins. Since the transitions between one audio event to another can be abrupt, a playlist crossfade can be used to smooth the transition from one audio event to another.
Crossfades between Playlist Events fade out the first region while fading in the next region. Each Playlist Event has separate controls for crossfade in, crossfade out, crossfade-in time, and crossfade-out time. The curve stored in crossfade in is used to fade in the current region. The curve stored in crossfade out is used to fade out into the next region.

Crossfades are stored on disk and are computed before playback. When a crossfade is being calculated, the watch cursor may appear.

The illustration above shows how crossfades are used in playlist events. The audio material from each region overlaps beyond the region boundaries. Overlapping areas are darker in the illustration above. The white diagonal lines correspond the crossfade in and out curves. As the first region ends, the next region’s audio material begins to fade in. When the next region begins playing, the first region continues to fade out.

It is very important to understand that the Region marker in the referenced Audio Document is the exact midpoint of the fade. Consequently, there must be sufficient audio date on either side of the Region marker. That is, if you have a 60 second crossfade between two Playlist Events, there must be at least 30 seconds of audio data following the end Region marker of the first Playlist Event and at least 30 seconds of audio data proceeding the begin Region marker of the second Playlist Event.

Using the separate crossfade in and crossfade out curves, Peak provides you with the flexibility to create many common crossfade types. These include “Linear Crossfade,” “Equal Power Crossfade,” “Slow in but fast out Crossfade,” “Fast in but slow out crossfade,” and “Overlap transition.” Peak is also flexible in allowing you to control crossfade in and crossfade out durations separately. All crossfades are based on overlapping audio from the previous or subsequent regions and then mixing the overlapping material after applying the crossfade curves.

A linear crossfade actually sounds like an equal power crossfade (i.e., no loss of energy in the audio signal), since Peak playlist crossfades are calculated logarithmically.

A Playlist event’s gain setting can be used to control the balance of the event in a Playlist. You may need to raise the volume or lower the volume of some Playlist events to maintain a proper balance of volume levels. You can make adjustments to the gain of individual Playlist Events as you playback the Playlist.

Be careful not to set a Playlist event’s gain too high as you may overload the signal and cause clipping to occur. You may also introduce clicks between Playlist events if the difference in gain between the two playlist events is too large. Crossfades can help smooth these transitions.

To select items in the Playlist:

- Click on the item in the Playlist that you wish to select. You may use the Shift key to select several items in the Playlist.

To insert items into the playlist:

- To hear your playlist, use the Play button in the Playlist window. The Playlist will begin playback from the current selected playlist event.

To preview transitions between playlist regions

1. Select the playlist event in which you wish to hear the transition.

2. Use the Playlist’s Play button or press the Spacebar while holding down the Command key (⌘). The pre-roll setting from the Auditioning... dialog
under the Preference menu will be used to audition from the end of the previous playlist event through the transition into the selected playlist event.

To scrub in the Playlist window:

- While playing audio in a Playlist, hold down the control key and press the forward or reverse buttons in the playlist. The audio will advance "CD-style" in larger increments. Release the mouse when you find the spot you wish to hear. This is useful for moving around quickly in the Playlist's audio to test gain levels and DSP effects for potential clipping. You can also click and drag right or left in the Playlist Window's Time Display.

To select next or previous Playlist event:

- With the Playlist as the front-most window (⌘-P), you can use the arrow keys (up and down arrows) to select the next or previous playlist event. While playing audio in a Playlist, you can use the arrow keys to move playback to the next or previous event in the Playlist during playback. Note that the arrow keys don’t work with the control key to scrub during playback. You can also use the Tab key to select the next Playlist event, even during playback.

Modifying Playlist Events

To move items in the playlist:

- Click and drag the Playlist event to the new location. A green line will indicate the new position for the playlist event. Release the mouse button when the green line is at the location you wish to place the event.

To delete items in the Playlist:

1. Select the Playlist event you wish to delete by clicking on it.

2. Press the Delete key on your keyboard, or click on the Trash Can icon in the Playlist window. The event will be removed from the playlist, and the audio events below the event will move up. This operation will, of course, decrease the length of the Playlist.

To edit a crossfade in or out:

- Double-click on the Playlist event’s Crossfade In or Crossfade Out icon. The Fade Envelope Editor dialog will appear, where you may edit the Fade Envelope for that particular Playlist Event’s Fade In or Fade Out.

To change Crossfade In or Out duration

- Double-click on the Playlist event Crossfade In time or Crossfade Out time. A dialog will prompt you to enter the duration in seconds for the Playlist Event’s Crossfade In or Out.

Crossfades are not available in Peak LE Playlists.

The default setting for crossfade duration in Peak Playlists is 0.

To modify the gap time:

- Double-click on the Playlist event Gap Time (i.e., the time between the beginning of one Playlist Event and the end of the previous one). A dialog will prompt you to enter the desired Gap Time for the selected Playlist Event.
The Nudge Regions Dialog

The Nudge Regions function is useful for fine-tuning the start and end times of Regions in the Playlist as well as adjusting the crossfade times. Access the Nudge Regions dialog by clicking on the icon in the Playlist window. In this dialog you can dynamically adjust start and end times of selected regions by scrolling in the windows, and listen to the changes as you make them by clicking on the Play button.

The Nudge Regions dialog

You can set the Pre-roll and Post-roll in seconds for auditioning the crossfade. If the Preserve Timing checkbox is checked, the duration between the Region markers will remain fixed. If the Preserve Timing checkbox is not checked, the Region markers can be moved independently of one another. The Zoom tools at the left of the window allow you to zoom in to the sample level, or out for a larger view. You can also allocate region Pre-roll and post-roll times in this dialog. By clicking and dragging in the window, you can adjust the fade times for the Fade Out (on top) and the Fade In (on the bottom).

Applying Plug-In Effects to Playlist Events

You may apply up to four Premiere plug-in effects processes per Playlist Event. This powerful feature allows you to place different effects on different events that are processed in real-time. This is very useful, especially for creating remixes. Peak will also let you process Playlist audio with any active VST plug-ins. However, VST plug-ins will process the entire Playlist and cannot process Playlist Events independent of one another.

Please note the number of effects you can use is limited to the CPU speed of your Macintosh. Some effects, such as Waves TrueVerb™, may not be able to run in real-time on slower CPU’s. In addition, performance of Playlist effects is reduced when other applications are open, or if File Sharing is in use during playback.

To add a Plug-In DSP effect to a Playlist event:

1. Click on first unused DSP effect box on the playlist event. You may select DSP effect boxes on multiple events by holding down the Shift key while you select DSP effect boxes.

2. Choose a desired Premiere format plug-in from the Plug-Ins menu.

3. Configure the plug-in settings, and click OK or Process, depending on the plug-in.

4. Peak will turn on the orange LED light for each selected DSP effect box, indicating that they are enabled.

To remove a DSP effect to a playlist event:

1. Click on the DSP effect box in the playlist event that you wish to remove. You may select multiple DSP effect boxes on multiple events by holding down the shift key while you select DSP effect boxes.
2. Press the Delete key on your keyboard. Peak will turn off the LED lights for the selected DSP effect boxes indicating that they are disabled.

**To change the settings of a DSP effect on a playlist event:**

1. Double-click on the DSP effect box in the playlist event that you wish to re-configure.
2. Configure the plug-in settings and click OK or Process, depending on the particular plug-in.

Plug-In DSP effects not available in Peak LE Playlists.

---

**Creating a New Audio Document from a Playlist**

After you have created a finished Playlist, you may wish to “bounce” the Playlist (i.e., write to disk) as a new audio document, including all the Playlist’s DSP effects and crossfades. In other words, the new audio document will be the equivalent of digitally recording the output of a playlist into a new document. Additionally, Peak automatically places markers or regions into the new document that correspond to each Playlist event boundary with names that match the name of the source region.

**To create a new Audio Document from the playlist:**

1. Shift-click to select the playlist events you wish to turn into a new audio document, or use the Select All command from the Edit menu (⌘-A).
2. Choose New Document from Playlist under the File menu’s New submenu (Shift-⌘-B), or click the Bounce Playlist button in the Playlist window. The following dialog will appear:

3. In the resulting dialog, select whether you want to bounce the playlist to a new AIFF file, a new Sound Designer II file, or a JAM Image file. Use the radio buttons to select whether you want Playlist Events to appear in the new document defined by Regions, Markers, or Nothing.

4. A new audio document, with DSP effects and crossfades will be generated from the selected playlist events. Peak automatically places markers into the audio document that correspond to each playlist event boundary. The markers have names that match the name of the source playlist region. For full compatibility with Roxio’s JAM, choose “Regions.”

---

**Exporting the Playlist as a Text Document**

If you wish to keep a text record of your playlist, you may export the playlist into a new text document. The text document will show the playlist events, times, crossfade times, and gain levels.

**To export a playlist as text:**

1. Open the playlist document you wish to save as a text file.
2. Choose Export as Text from the File menu. The Save dialog appears.
3. Enter a name to save the playlist under and a location to store the file, and click Save.
Saving and Opening Playlists

To save a playlist:

1. Choose Save from the File menu. If the playlist has not yet been saved, it will prompt you to save it and name it when you close the Playlist.

2. Alternatively, you can save a copy of the playlist with the Save As... command.

To open a playlist:

- Choose Open from the File menu. Select the playlist you wish to open with the Open File... dialog. Peak will automatically open any audio documents that the playlist refers to. If the audio documents that the playlist refers to are deleted, you will be unable to use the playlist document. If Peak is unable to locate the audio document containing a referenced Region, you will be prompted to locate it.

- If you remove the regions used in a playlist, you may not be able to use the playlist that refers to those regions. If you delete a file that a playlist refers to, you also will not be able to use the playlist.

Burning Audio CDs from Peak Playlists

Peak will also let you burn audio CDs directly from the Playlist using Roxio Toast, which comes bundled with Peak. Peak Playlist Events will be written as Audio tracks on the resulting audio CD. You can also use Peak Playlists to create a Jam Image file to create audio CDs using Roxio JAM (JAM sold separately). If you want to do PQ subcodes, ISRC codes, and other more specific tasks in producing a CD master, you should use JAM. Most CD burners are supported, but check with Roxio for any specific questions regarding compatible CD Burners.

Peak’s Playlist and Toast

To burn an Audio CD, Track-at-Once, directly from Peak’s Playlist, select the Playlist Events you want to burn as Tracks to CD, or simply select All from the Edit menu (c-A) if you want all of the Playlist Events to appear as tracks on the audio CD. Then, click the Burn Audio CD button at the top of the Playlist window and Peak will write an Apple Script that will launch your Playlist in Toast and begin to burn an audio CD.

Be sure that you have Roxio Toast installed, and that you have a working CD burner attached to the SCSI chain of your computer. Consult the documentation that came with your CD burner.

Please note that the gap time between tracks is not script-able with Toast, so your audio CD will have the default two second gap time between tracks. However, you can press cancel when Toast prompts you to begin burning the CD and then manually set the gap times for each CD track manually in Toast. Once you have manually set the gap times in Toast, you can also choose to burn Disc-at-Once rather than Track-at-Once.

Toast 5.0 or later can burn Disc-at-Once audio CDs. Be sure to enable the Prefer Disc-at-Once preference in Toast to change from the default Track-at-Once.

To burn an audio CD from a Peak Playlist:

1. Create a Playlist with the tracks as you want them to appear on the CD.

2. In Peak, click on the Burn Audio CD button in the Playlist window.

3. Peak will bounce the playlist with your effects and launch Toast. If Toast is not found, Peak will prompt you to find Toast.

4. Once Toast has been informed by Peak about the
CD tracks to burn, a dialog appears instructing you to insert a blank CD into your CD Burner.

5. Insert a blank CD and click OK. Toast will burn your Peak Playlist as an audio CD.

⚠ Playlists burned from Peak using versions of Toast prior to 5.0 should not use crossfades between playlist events since Toast burns audio CD tracks one-at-a-time with a predefined 2 second gap between tracks. If you need seamless transitions between tracks, use the instructions below for burning playlists with JAM.

**Regions and the JAM Image file format**

A JAM Image file represents an entire CD to the CD-writing software JAM from Roxio. When you create a JAM image with Peak, JAM will interpret the Regions created in Peak as CD tracks. Any audio between one region’s end and the next region’s start will be interpreted as gap times. Finally, any markers you create in a JAM image file will become indexes in JAM.

You can assign Peak as the external waveform editor for JAM in JAM’s preferences. You can also open JAM Image file created by Peak back into Peak for further editing as needed. By using these features, assembling and editing a CD in Peak prior to burning with JAM is both easy and versatile.

**To burn an audio CD from a JAM Image File:**

1. Create a Peak Playlist with each track as you want them to appear on the CD.

2. Use the Select All command from the Edit menu (⌘-A) or Toolbar.

3. Choose New Document from Playlist under the File menu’s New submenu, or click the Bounce Playlist button in the Playlist window. The Bounce Playlist dialog will appear.

4. In the pop-up at the top of the Bounce Playlist dialog, select Jam Image. Use the radio buttons to select Playlist events to appear in the new document as Regions.

5. A new audio document, with DSP effects and crossfades will be generated from the selected playlist events. Peak automatically places regions into the audio document that correspond to each playlist event boundary. The regions have names that match the name of the source playlist region.

6. Close the new audio document (a JAM Image file format) and open it with JAM to burn a red-book format, Disk-at-Once, audio CD.

---

**Conclusion**

You have now learned about creating Regions and Playlists, as well as how to create new mixes, splice together multiple takes, bounce Playlists as new audio documents, and how to create audio CDs using Playlists. In the next chapter, you will learn about the native DSP (digital signal processing) functions in Peak.
Chapter 7
DSP
Chapter 7: DSP

Introduction
Peak allows you to transform your audio with a variety of powerful Digital Signal Processing (DSP) tools. You can apply these tools at any time by first making a selection in an audio document and then choosing the desired menu command from the DSP menu.

Processing Audio with Peak’s DSP tools
The following general procedure describes how to process a selection in an audio document, or the entire document, with a particular DSP function. The specific capabilities and parameters of the DSP function will vary.

To process audio with a DSP function:
1. Select the portion of the audio that you wish to process with the DSP function. If no selection is made, the entire document will be processed.
2. Select the type of process you wish to use from the DSP menu.
3. A dialog appears allowing you to set the parameters for the DSP function.
4. Set the parameters for the DSP function as desired and click OK. Peak processes the selection with the DSP function or plug-in.

Note that if no selection is made, Peak will apply processing to the entire audio document.

Peak’s Audio Processing Tools
Peak’s DSP capabilities provide composers and professional sound designers with many interesting audio effects and processing tools. Peak’s DSP functions include Add, Change Duration, Change Gain, Change Pitch, Convert Sample Rate, Convolve, Crossfade Loop, Invert, Fade In, Fade Out, Find Peak, Gain Envelope, Loop Tuner, Mono to Stereo, Stereo To Mono, Mix, Modulate, Normalize, Panner, Phase Vocoder, Rappify™, Repair Click, Repair Clicks, Remove DC Offset, Reverse Boomerang™, Reverse, and Threshold. The following sections explain how to use each of these functions.

Add
The Add command adds any selection of audio copied to the clipboard into the audio document at the selection point. To use the Add command, you must first copy a selection of audio. The copied material can then be mixed into the target audio material.

To use the Add command:
1. Select the audio that you wish to Add to another audio document and choose Copy from the Edit menu (⌘-C) or Toolbar.
2. Select the audio that you wish to mix the copied material into.
3. Choose Add from the DSP menu or Toolbar.
4. In the dialog that appears, use the slider to adjust the amount of the copied signal that you wish to add into the target audio document. Be careful not to adjust too high an amount which can potentially clip the signal.
The Add dialog

5. Click OK. Peak mixes the two signals together.
6. To hear the results, press the Space bar.

\(\text{LE} \) Add is not available in Peak LE.

Amplitude Fit Envelope editor

Amplitude Fit

Amplitude Fit provides granular normalization of an audio selection on a grain-by-grain basis. Grains are small groups of samples, often around 30ms. As each grain is read in, it is normalized according to the Amplitude Fit Envelope—each normalized grain crossfaded with the previous grain and written out as the result. Amplitude Fit can be used to maximize the volume level of an audio selection, or to make quiet passages as loud as louder passages.

To apply the Amplitude Envelope to an audio selection:

1. Select the audio material you wish to process.
2. Choose Amplitude Envelope... from the DSP menu.
3. Draw the amplitude envelope you wish to apply to the audio selection in the envelope editor. Points above and below the 0% line will normalize the selected audio using the grain-by-grain normalization technique.

\(\text{LE} \) Amplitude Fit is not available in Peak LE.

Change Duration

The Change Duration command allows you to slow down or speed up the selected material by a specified amount without changing its pitch. You can specify the change in duration by a value in seconds, a percentage of the original, or, for rhythmically-oriented material, beats per minute. A change in duration by a reasonable amount, about 85% to 115%, can be very convincing. Exaggerated time stretching, 200% or more, can result in some very interesting granular textures. Try experimenting with the Change Duration function on drums, rhythm loops, speech, sampled instruments or sound effects to achieve a wide variety of useful effects.

Change Duration dialog

To change the duration of a selection:

1. Select the portion of the audio that you wish to process.
2. Choose Change Duration from DSP menu. The Change Duration dialog appears.

3. Click the radio button for one of the following fields, and enter the value that you wish for the change in duration:

- In the Seconds field, type the new duration in seconds.
- In the Percentage field, type the percentage you wish to slow down or speed up the selected audio. For example, typing “50%” will slow down the selection to half its original duration, typing “200%” will slow down the selection to twice its original duration.
- In the Beats per minute field, type the old tempo for the selected audio and then the desired new tempo, and Peak will compute the correct new duration. Use this field to change the duration of rhythmically-oriented material.

4. If you wish to adjust the quality of the pitch change, click on the Prefs button. The DSP Preferences dialog will appear, allowing you to choose the size of the Time Shifting Window that will be used in processing. A lower value is best for simpler, monophonic sounds, while a higher value yields the best results for more complex, polyrhythmic sounds. One you have set these preferences to your liking, click OK to exit the DSP Preferences dialog.

5. Click OK when you have finished. Peak changes the duration of the selection according to the settings that you chose.

\[ \text{Change Duration is not available in Peak LE.} \]

**Change Gain**

The Change Gain function changes the gain (i.e., amplitude) of a selection. You can specify the amount of gain change either in decibels (dB) or as a percentage. If you wish to double the volume of a sound, you must apply approximately 6dB of gain change, or add 200%. Enable the Clipguard checkbox in the Change Gain dialog to protect against the possibility of clipping. Clipguard will search through the audio document or selection for the maximum peak in amplitude, and then limit the Change Gain slider’s range based on the maximum peak it finds in the audio document or selection.

![The Change Gain dialog](image)

**To change the gain of a selection:**

1. Select the portion of the audio that you wish to process.

2. Choose the Change Gain command from the DSP menu or from the Toolbar. The Change Gain dialog appears.

3. Enter the number of decibels or percentage by which you wish to change the amplitude of the selection by.

4. If you wish to protect against the possibility of clipping, enable the Clipguard checkbox.
clipping, enable Clipguard by checking the Clipguard checkbox.

5. Click OK when you have finished. Peak will change the gain of the signal by the amount you specified.

**Change Pitch**

Peak’s Change Pitch function allows you to alter the pitch of an audio selection by as much as an octave. The Change Pitch dialog uses a pitch slider that allows you to choose a new pitch by musical interval, and "fine tune" the pitch change by smaller increments called “cents.” (Cents are divisions of a musical octave—one octave is equivalent to 1200 cents—thus, 100 cents is a semi-tone, 50 cents a quarter-tone, etc.) You can also choose to alter the length, or duration, of the selection just as you would by slowing down or speeding up analog tape, or you can choose to preserve the duration of the selection (something not possible with analog tape!). You can even preview the pitch change by clicking on the Play button at the bottom of the Change Pitch dialog.

**To change the pitch of an audio selection:**

1. Select the portion of the audio that you wish to process.

2. Choose Change Pitch from the DSP menu or from the Toolbar. The Change Pitch dialog appears.

3. Select the interval of transposition up or down by entering a positive or negative value in cents in the “Change Pitch” field or by using the pitch slider. Fine tune the interval of transposition by entering a positive or negative value in cents in the “Fine Tune by” field or by using the Fine Tune slider. If you wish to audition the transposition, click on the Play button to preview the results of the pitch change in real time. Check on the Preserve Duration checkbox to retain the original duration of the selected audio.

4. If you wish to adjust the quality of the pitch change, click on the Prefs button. The DSP Preferences dialog will appear, allowing you to choose the size of the Time Shifting Window that will be used in processing. A lower value is best for simpler, monophonic sounds, while a higher value yields the best results for more complex, polyrhythmic sounds. One you have set these preferences to your liking, click OK to exit the DSP Preferences dialog.

5. Click OK when you have finished. Peak transposes the pitch of the selected audio up or down by the amount you specified.

*LE* Change Pitch is not available in Peak LE.

**Convert Sample Rate**

The Convert Sample Rate command allows you to change the sample rate of a sound without changing its pitch. This feature is very useful for converting audio material into lower or higher sample rates as required by other applications. Please note that sample rate conversion is applied to an entire document. It cannot be applied to just a selection within a document. Refer to Chapters 3 and 4 for an explanation of commonly used sample rates.
To change the sample rate of a document:
1. Choose Convert Sample Rate from the DSP menu or Toolbar. The Convert Sample Rate dialog appears.

2. Type in the sample rate that you wish to convert the audio document to, or click the down arrow to select from a pop-up of commonly used sample rates.

3. Click OK. Peak converts the entire audio document to the selected sample rate.

![Convert Sample Rate dialog](image)

The Convert Sample Rate dialog

The Apple Sound Manager is limited to sample rates from 11kHz to 44.1kHz. Allowable sample rates with ASIO will depend on the particular sound card and its ASIO driver. Digidesign’s DAE is restricted to sample rates of 44.1kHz and 48kHz.

Convolve

The Convolve command is a unique and powerful sound design tool that allows you to apply the sonic (e.g., spectral) characteristics of one sound onto another. Convolution works by multiplying the frequency spectrum of the impulse contained in the clipboard and that of the target audio document, reinforcing the frequencies that are in common between the two. The results are always interesting and often quite unlike anything you’ve heard before. This is especially true when the character of the two sounds are very different, and when the clipboard impulse is harmonically rich (imagine, for example, convolving a rainfall sample with piano tinkling!). To use the Convolve DSP command, you must first copy a selection of audio. The copied material will provide the spectral “character” that you will apply to the target audio material. Convolution can be very useful not only for creating new and unusual sound, but also for giving an audio selection a sense of space—try copying a small amount of room noise to the clipboard and then Convolve it with a selection of audio and the convolved audio will sound like is being played in that room.

⚠️ Because the clipboard contents that provide the spectrum for this process must be held in RAM, small clipboard impulses should be used, unless a large amount of RAM has been allocated to Peak. This process can use a lot of RAM!

To use the Convolve:
1. Select the audio with the characteristics you wish to apply and choose Copy from the Edit menu (⌘-C) or Toolbar.

2. Select the audio that you wish to modify with the copied audio impulse.

3. Choose Convolve from the DSP menu. Peak applies the spectral character of the copied material to the selection.

4. To hear the results, press the Spacebar.

![Convolve is not available in Peak LE.](image)

Convolve is not available in Peak LE.

Crossfade Loop

The Crossfade Loop function applies a “smoothing” effect to loops made in Peak audio documents. Crossfade Loop fades the end of the loop into the beginning of the loop to make the loop sound smoother. (It uses the Blending envelope you’ve set in Peak’s Preference menu’s Blending... dialog.) Use the Crossfade Loop dialog to select the length of the crossfade in milliseconds.

To create a crossfade loop:
1. Create a loop using one of the techniques
explained earlier in this chapter.

2. Choose Crossfade Loop from the DSP menu.

3. In the Crossfade Loop dialog that appears, enter a
duration for the crossfade-in milliseconds and click
OK.

4. To hear the completed crossfade, choose Select
Loop from the Edit menu, select Use Loop in
Playback from the Preference menu (⌘-L) or click
the Loop button on the Toolbar, and press the
Spacebar. You will hear the loop, complete with
your crossfade.

To dither down the bit-depth of an audio file:
1. Choose Select All under the Edit menu (⌘-A).
2. Choose Dither from the DSP menu.
3. Choose the bit-depth you wish to dither to and
click OK. For example, if you have a 24-bit file and
you want to dither it down to 16-bit, choose 16-bit.

The Dither dialog

4. Choose Save As... (Shift-⌘-S) from the File menu
and choose to Save As the new bit-depth. For
example, if you have dithered a 24-bit file down to
16-bit, choose to Save As a 16-bit.

Crossfade Loop is not available in Peak LE.

Dither

Dither... allows you to use Waves IDR™ noise shaping
and dithering, built-in to Peak. Typically you would
pick your destination dithering bit-depth, click OK,
then save to that bit-depth. The IDR available in Peak
contains a fixed type of dither (type 1), and a fixed
amount of noise shaping (normal mode for sample
rates over 32Khz, moderate mode for sample rates
under 32kHz, no noise shaping below 22Khz).

To invert the phase of a selection:
1. Select the portion of the audio that you wish to
invert.

2. Choose Invert from the DSP menu. Peak inverts
the phase of the selected audio.

Fade In & Fade Out

The Fade In and Fade Out commands allow you to
apply an amplitude envelope to an audio selection.
The Fade In and Fade Out DSP functions, and the
Fade Envelope Editor dialog are described at length in
Chapter 5.

To create a Fade In:
1. Click the cursor at the desired location in the
audio document and drag to select the audio you
want to fade. The Fade In will be applied to the
audio within this selection.

Dither is not available in Peak LE.
2. Choose Fade In Envelope from the Preference menu.

3. In the Fade Envelope Editor dialog that appears, you can use the default envelope, edit the envelope, or load any envelopes included with Peak or that you have created yourself.

4. Choose Fade In from the DSP menu. Peak applies the Fade In to the selection you have made in the audio document.

5. To hear the completed Fade In, press Option-Spacebar. You will hear the selected audio complete with your Fade In.

**To create a Fade Out:**
1. Click the cursor at the desired location in the audio document and drag to select the audio you want to Fade. The Fade Out will be applied to the selected audio.

2. Choose Fade Out Envelope from the Preference menu.

3. In the dialog that appears, you can use the envelope, create your own, or load any envelopes that you have saved to your hard disk.

4. Choose Fade Out from the DSP menu. Peak applies the Fade Out to the selection you have made in the audio document.

5. To hear the Fade Out, press Option-Spacebar. You will hear the selected audio complete with your Fade Out.

**Find Peak**

The Find Peak operation will place the insertion point at the sample with the maximum amplitude value that it locates in the audio selection.

**To find the maximum amplitude point in an audio selection:**
1. Select the audio in which you wish to locate the maximum amplitude.
2. Choose Find Peak from the DSP menu.
3. A dialog will appear telling you what the peak value is, and where it is located. The insertion point will be placed at the sample where the greatest amplitude was located.
4. Press the left arrow to bring the insertion point into view or the Shift key to the view of the insertion point at the sample level

![Warning]

The maximum value is at location 03:13.633, with a value of 23595, or 72 percent, or -2.84 dB.

**Gain Envelope**

The Gain Envelope operation allows you to enter an amplitude envelope to be applied to an audio selection. The selected audio’s amplitude will be boosted and/or attenuated according to the envelope you draw in the Gain Envelope editor. It is easy to cause samples to clip when using this feature, so use it carefully.

**To apply variable gain and attenuation to an audio selection:**
1. Select the audio material you wish to process.
2. Choose Gain Envelope... from the DSP menu.
3. Draw the gain envelope you wish to apply to the audio selection in the envelope editor. Points above the 0% line will amplify the selected audio. Points below the 0% line will attenuate the selected audio. Note that the waveform display in the Gain Envelope editor will change according the envelope you draw.
4. To process the audio selection using the gain envelope, press Change.

---

**LE**  Find Peak is not available in Peak LE.
The Gain Envelope dialog

**Loop Tuner**

Peak’s Loop Tuner provides a way to visually line up the start and end points of your loop and listen to the effects of these adjustments as you make them. If you wish to “tune” a loop you’ve made, simply select Loop Tuner from the DSP menu or Toolbar, and a dialog will appear. The waveform display in the Loop Tuner dialog shows the Start and End points of the loop, which you can visually adjust with the scroll bars at the bottom of the window to achieve a natural transition at the loop point by carefully adjusting the slope alignment. The arrows of the slider will move the loop markers sample by sample and clicking in the body of the slider will move the loop markers to the next zero crossing. The two zoom buttons—magnifying glass icons—in the upper left of the Loop Tuner dialog allow you to adjust the vertical zoom up of the waveform. The two zoom buttons in the lower left hand corner of the Loop Tuner dialog allow you to adjust the zoom view in and out all the way down to the sample level. You can listen to the effects of the adjustments as you make them by clicking on the Play button. To exit this dialog, click on OK to accept the changes, or Cancel to leave the original loop unaffected.

**Mono To Stereo/Stereo To Mono**

These two DSP commands may be used to easily convert an audio document between one and two channel formats.

To change an audio document from mono to stereo

1. Select the entire audio document with the Select All command from the Edit menu (⌘A).
2. Choose Mono To Stereo from the DSP menu or Toolbar.
3. In the dialog that appears, adjust the slider to adjust the left and right-channel balance in the mix.

---

*LE* Loop Tuner is not available in Peak LE.
Mono to Stereo Conversion dialog

4. Click OK. Peak converts the mono document to a stereo document.

To change an audio document from stereo to mono

1. Select the entire audio document with the Select All command from the Edit menu (⌘-A).
2. Choose Stereo To Mono from the DSP menu or Toolbar.
3. In the dialog that appears, adjust the slider to adjust the left- and right-channel balance in the mix.

Stereo to Mono Conversion dialog

4. Click OK. Peak converts the stereo document to a mono document.

Mix

The Mix command allows you to mix material that you have copied to the clipboard with a target selection. This function can be used as a kind of “sound-on-sound” capability for mixing audio tracks together, or for blending sound elements. The Mix command is similar to the Add command, but it does not have the potential to clip because the target and clipboard contents are attenuated before mixing. To use the Mix command, you must first copy a selection of audio. The copied material can then be mixed into the target audio material.

To use the Mix command:

1. Select the audio you wish to mix into another audio document and choose Copy from the Edit menu or Toolbar (⌘-C).
2. Select the audio that you wish to mix the copied material into.
3. Choose Mix from the DSP menu.
4. In the dialog that appears, use the slider to adjust the amount of the copied signal that you wish to mix into the target audio document.

The Mixer dialog

5. Click OK. Peak mixes the two signals together.
6. To hear the results, press Option-Space bar.

Mono To Stereo/Stereo To Mono is not available in Peak LE.
**Modulate**
This Modulate command functions as a “ring modulator” which multiplies two audio signals together (e.g., the material copied to the clipboard and the currently selected audio). The resulting audio includes the sum and difference tones of the frequency components of the modulated audio and the modulating audio. These are generally very complex timbres that often have a “metallic” (i.e., inharmonic) character to them.

⚠️ Try using generated tones, like sine, swept sine, square, or saw-tooth waves with the Modulate command.

**To use the Modulate command:**
1. Select the desired source audio and choose Copy from the Edit menu or Toolbar (or press `⌘-C`).
2. Select the destination audio.
3. Choose Modulate from the DSP menu.
4. In the dialog that appears, use the slider to adjust the amount of the copied signal that you wish to use to modulate the destination audio document.
5. Click OK. Peak processes the two signals.
6. To hear the results, press the Space bar.

⚠️ Modulate is not available in Peak LE.

**Normalize**
This command allows you to optimize the volume of a selection or an entire audio document so that it is at its maximum possible amplitude without clipping. The normalize function is very useful for boosting the volume of material that was recorded at too low a level, or if used on multiple audio documents, for making sure that the amplitude of each of the documents is uniform.

⚠️ Note that because normalization uniformly changes the amplitude of a selection (i.e., the proportions between loud and soft stay the same), it does not have the same effect as compression/limiting (which makes the soft parts louder and does not allow the loud part to exceed a specified amplitude).

**To normalize a selection:**
1. Select the audio that you wish to normalize. If you wish to normalize the entire audio document, choose Select All from the Edit menu (`⌘-A`).
2. Choose Normalize from the DSP menu.
3. In the dialog that appears, use the slider to adjust the percentage of normalization from the maximum level.
4. Click OK. Peak normalizes the selected audio.
**Panner**

The Panner allows you to adjust the panning, or left-to-right movement, of a stereo document by drawing an envelope in the Panner dialog. Left is at the top of the graph, and right is at the bottom.

**To adjust the panning of a selection:**

1. Select the stereo document that you wish to adjust. If you wish to select the entire document, choose Select All from the Edit menu (⌘-A).
2. Choose Panner from the DSP menu.
3. In the Panner editor dialog that appears, use the envelope to “draw in” the panning you desire.
4. Click OK. Peak will change the panning of the document to reflect the changes you’ve made.

**Phase Vocoder**

The Phase Vocoder is a type of audio spectrum analysis/resynthesis that allows you to modify the duration and/or pitch of an audio selection.

**To use the Phase Vocoder:**

1. Select the audio that you wish to process. If you wish to select the entire document, press ⌘-A.
2. Choose Phase Vocoder from the DSP menu. The Phase Vocoder dialog appears.

3. In the Change Duration field, you can enter a new duration for the selection by typing the time in seconds.
4. In the Change Pitch field, you can change the pitch of the selection by entering a new value in cents. (Cents are divisions of a musical octave—one octave is equivalent to 1200 cents.) Common musical intervals are stored in the interval pop-up menu, allowing you to enter a major third, octave, or other intervals. Use the direction pop-up menu to control whether the pitch is shifted upward or downward.
5. In the Analysis Settings field, select the number of bands and FFT (Fast Fourier Transform) size to determine the quality of the output. The Phase Vocoder works by analyzing the frequency content of the audio selection and placing the found frequencies into tracks. These tracks are then used to control an oscillator-based resynthesis that uses the pitch and duration modifications you enter. In general, using a smaller FFT size brings less smearing of the audio output than higher FFT sizes. Using a larger number of bands setting used increases the accuracy while tracking of harmonic content of the source sound. In general, setting the FFT size larger than the number of bands will

---

*Phase Vocoder dialog*

**LE** *Panner is not available in Peak LE.*
give undesirable results. Due to the nature of the Phase Vocoder's algorithm, optimum results are achieved when it is used with solo instruments and steady state sounds (such as a voice or solo flute line) rather than complex tones (such as an orchestra playing).

6. Click OK. Peak processes the audio. To hear the results, initiate playback.

**Warning** Phase Vocoder is not available in Peak LE.

**Rappify**
The Rappify command applies extreme dynamic filtering to a selection. As one Peak user described it, "Rappify can turn your hi-fi into lo-fi!" If the target material has a pronounced beat, this has the effect of reducing the material to its most essential rhythmic components. Try using this function with a variety of different music material for some surprising and exciting results.

**To Rappify a selection:**

1. Select the audio that you wish to process. If you wish to select the entire document, press ⌘-A.
2. Choose Rappify from the DSP menu.
3. In the dialog that appears, select the amount of "rappification" you wish to mix back into the original, with 100% being entirely rappified and 0% being unchanged.
4. Click OK. Peak processes the audio. To hear the results, initiate playback.

**Rappify is not available in Peak LE.**

**Repair Click**
The Repair Click command will eliminate a selected click or "spike" in the waveform using the setting designated in the Repair Clicks dialog (explained next).

**To repair a single click:**

1. Place the Insertion Point located the click you wish to repair.
2. Choose Zoom To Sample Level from the action menu (Shift-Left arrow).
3. Select the click in the waveform. Please be sure that your selection is no more than 100 samples.
4. Choose Repair Click from the DSP menu.

**Repair Click is not available in Peak LE.**

**Repair Clicks**
The Repair Clicks command allows you to find and repair pops or clicks in an audio document. The Repair Clicks dialog automates the process of finding and removing clicks (usually indicated by a sharp "spike" in a waveform), much like a search and replace dialog in a word processor.

The Repair Clicks operation works by looking for discontinuities from sample to sample. For example, a sample value of -100 followed by a sample value of 10,000 is likely to be a click. Once the area of the click is identified, a smoothing technique is used to maintain the original shape of the area being repaired.

If you are working with mostly digitally induced clicks, the Repair Clicks dialog will become an indispensable tool. Extremely damaged signals such as those of a scratching and popping vinyl record will require more careful repair in addition to using the Repair Clicks dialog, such as Change Gain, Delete, and the Pencil
Tool. Clicks such as those of a scratching and popping vinyl record loose their detectability once they are sampled using Analog to Digital converters.

---

**Smoothing Factor**

Smoothing Factor determines how much smoothing is applied to the click. Material with high frequency information may require lower smoothing factors to preserve the high frequencies. In general, a setting of 40-60 percent will repair most clicks.

**Detection Setting**

The Detection Setting value determines how the clicks are located. Higher values locate only the most severe clicks, while lower values will detect less severe clicks. Note that lower values such as 10% also have a greater chance of misjudging audio for a click. In general, a setting of 40-80% works well.

**Repair Size**

The Repair Size setting affects how many samples around the click are used in determining the new shape of the repair. Repair size can vary from 5 to 100 samples, with a repair size of 50 samples working well in most circumstances. Peak will then interpolate what the correct waveform should be, and repair the click.

Buttons along the bottom of the Repair Clicks dialog allow you to control repairing, auditioning, and undoing click repairs:

- Click the Repair button when you wish to repair a click found by the Next Click button.
- Use the Next Click button to search for the next potential click in the audio selection.
- Once a click is located, you may listen to the click using the Audition button. The Audition button plays the click using the Pre-roll and Post-roll settings from the Auditioning... dialog under the Preference menu.
- If you repair a click and are unsatisfied with the results, simply click on the Undo button.
- If you would like to repair all of the clicks in the audio document’s selection without having to repair each one individually, click the Repair All button.

Be sure not to confuse repair size with the size of the selection containing the audio you want to scan and repair. The repair size refers to the size of each individual repaired click.

**To repair multiple clicks in an audio document**

1. Select the entire audio document or the area in the audio document you wish to repair click.
2. Choose Repair Clicks from the DSP menu.
3. Click the Next Click button. Peak will search for any clicks. If none are found, you can try again with a lower detection setting.
4. Audition the click using the Audition button. The click should sound in the middle of the auditioned area.
5. Once the click is found, click the Repair button. Click the Audition button to make sure the click was adequately repaired. If it was not adequately repaired, use the Undo button, modify the smoothing factor or repair size and click the Repair button again.
6. Proceed from step 3 until all clicks are removed, or simply click the Repair All button. If you wish to stop the Repair All process, press %-period.

**To repair a single click from an audio document:**

1. Select the area around the click, centering the click in the selection.
2. Choose Repair Clicks from the DSP menu or use Repair Click and skip step 3.

3. Click the Repair button. Then click the Audition button to make sure the click was adequately repaired. If it was not adequately repaired, use the Undo button, modify the smoothing factor or repair size and click the Repair button again.

You may need to lower the detection setting in the Repair Clicks dialog to find some clicks, depending upon their severity. Be careful not to lower the detection setting dramatically — lower it gradually for the best results.

Remove DC Offset

This function allows you to remove any DC Offset in your audio file. Peak scans the audio for DC offset and then removes it. Peak will scan the left and right channels of a stereo file independently. DC Offset is usually caused by problems in the analog to digital conversion process. The result is that the waveform is not centered on the base line—it is offset either higher or lower than the center line. The Remove DC Offset function is particularly useful for preparing audio for processing with the RealAudio Encoder.

To use Remove DC Offset:
1. Select the audio that you wish to process. If you wish to select the entire document, choose Select All from the Edit menu (⌘-A).
2. Choose Remove DC Offset from the DSP menu. Peak will scan the audio, and automatically remove any DC offset that might be present.

Remove DC Offset is not available in Peak LE.

Reverse Boomerang

The Reverse Boomerang command mixes a reversed copy of the selected audio with the original. This creates a variety of interesting and useful results. Try using Boomerang on drum loops, voice, and sound effects.

To use Reverse Boomerang:
1. Select the audio that you wish to process. If you wish to select the entire document, choose Select All from the Edit menu (⌘-A).
2. Choose Reverse Boomerang from the DSP menu.
3. In the dialog that appears, select the amount of reversed sound you wish to mix back into the original, with 100% being entirely reversed, and 0% being unchanged.

To reverse a selection:
1. Select the audio that you wish to reverse. If you wish to select the entire document, choose Select All from the Edit menu (⌘-A).
2. Choose Reverse from the DSP menu. Peak reverses the selected audio. To hear the results, start playback.
Swap Channels

The Swap Channels command reverses the left and right channels in a stereo selection.

To swap channels for a stereo selection:

1. Select the audio that you wish to reverse. If you wish to select the entire document, choose Select All from the Edit menu (⌘-A), or place the insertion point at the beginning of the stereo audio document.

2. Choose Swap Channels from the DSP menu. Peak swaps the left channel for the right channel and the right channel for the left channel. To hear the results, start playback.

**LE** Swap Channels is not available in Peak LE.

Threshold

The Threshold command allows you to split up an audio document into its component parts by analyzing the amplitude levels in the audio document and setting a cutoff or threshold amplitude. For instance, you might use the Threshold command on an audio document that contains successive notes from a musical instrument to split them up, or on a drum loop to break it up into its component parts. You can save the segments with Markers, or as Regions.

To use the Threshold command:

1. Select the audio you wish to process and choose Threshold from the DSP menu. After Peak analyzes the amplitudes in the selection, the Threshold dialog will appear, allowing you to select a threshold amplitude for both attack and release values.

2. Drag the threshold indicator left or right to set the threshold amplitude. As you drag the indicator, new markers will appear in the audio document forming markers or regions, depending on your settings. The Offset sliders allow you to “nudge” the onsets of markers or regions by plus or minus 0 to 512 samples.

3. Select Create Regions to create regions instead of markers. The separate Release Threshold, attack and sludge settings affect the region end points, allowing you to eliminate silence from the region end points.

4. Adjust the Attack value. This setting sets the amount of time that audio must stay above the given threshold to qualify as a new marker or region.

5. When you have finished, click OK.

6. After the audio document has been “thresholded” to your satisfaction, you can use the Export Regions command in the File menu to export the separated regions into new windows or files.

7. To select and play regions in order from left to right, press the Page Up key on your computer keyboard. To select and play regions in order from
right to left, press the Page Down key.

⚠️ **User Tip:** Use the Threshold command to create several looping points. To convert a marker to a Loop Start or Loop End point, double-click on the marker and change it to “Loop Start” or “Loop End” in the Edit Marker dialog. Also, try rearranging the regions generated by the Threshold function in the Playlist or by using Cut and Paste to create new interesting compositional and rhythmic ideas!

⚠️ **LE** Threshold is not available in Peak LE.

---

**Conclusion**

You have now learned how to manipulate and process audio using Peak’s native DSP capabilities. In the next chapter, you will learn how to use third-party Premiere, AudioSuite, TDM, and VST plug-ins with Peak.
Chapter 8: Plug-Ins

Introduction
Peak supports a number of plug-in formats for third-party DSP plug-ins. Peak supports Premiere, AudioSuite, TDM, and VST format plug-ins. Peak, like many host audio software applications, relies on third-party plug-ins for noise reduction, equalization, reverberation, etc.

Processing Audio with Premiere and AudioSuite Plug-Ins
The following general procedure describes how to process a selection in an audio document, or the entire document, with third-party Premiere and AudioSuite plug-ins. The specific capabilities and parameters of the plug-in will vary.

1. Select the portion of the audio that you wish to process with the Premiere or AudioSuite plug-in.
2. Select the plug-in you wish to use from the Plug-Ins menu.
3. A dialog appears allowing you to set the parameters for the plug-in. Most plug-ins allow you to preview the effect of the processing from this dialog. The preview time is dependent on the amount of RAM that has been allocated to Peak.
4. Set the parameters for the plug-in as desired and click OK. Peak processes the selection with the plug-in.

Adobe Premiere Format Plug-Ins
Adobe Premiere is one of the most popular digital video and multimedia authoring programs. Adobe Premiere publishes a list of specifications for their Audio Plug-In format, which allows third-party companies to create and market software which adds audio-related features to Premiere. BIAS Peak also supports the Adobe Premiere Audio Plug-In format, which means that many of these same third-party programs can be used to enhance the capabilities of Peak.

Not all Adobe Premiere Audio Plug-Ins may be supported by Peak. For a complete listing of supported plug-ins, please see you authorized BIAS dealer, or contact us directly. To ensure full compatibility with Peak, please check with the plug-in developer or BIAS before purchasing the plug-in.

Compatible plug-ins are currently available from BIAS, Arboretum, Waves, DUY, and others. Plug-ins enhance Peak’s editing capabilities by offering features such as advanced equalization (tone control), noise reduction, filtering, reverberation, compression, and more.

Installing Adobe Premiere Plug-ins
Adobe Premiere Plug-ins are essentially separate software packages that can be installed on your hard drive and placed in the Peak Plug-Ins folder. The installed software will then appear in the Plug-Ins menu in Peak under the Premiere submenu. You can then use the software within Peak at any time by first making a selection in an audio document and then choosing the software plug-in from the Plug-Ins menu.
To install an Adobe Premiere format plug-in, simply drag it into the Peak Plug-Ins folder (located at the same hard disk directory level as the Peak application), restart Peak, and the plug-in will appear in the Plug-Ins menu. As with all editing functions, audio processing with plug-ins is applied non-destructively until you save a document.

Premiere Plug-in Memory Settings

When using third party plug-ins, you may need to set aside some RAM for the plug-in. The Plug-In Memory dialog under the Preference menu allows you to set this memory reserve (this is separate from the Plug-In Preview Time described in the next section). Generally, for the best results, this preference should be set between 512k and 2038k (the default is 1024k). Since plug-ins from different manufacturers have different needs, check with the manufacturer of the plug-in for suggested memory requirements.

Premiere Plug-In Preview Time

Peak allocates preview time based upon how much RAM is available to Peak. Peak will allow the plug-in to preview with as much audio as it can with the available RAM. To increase the amount of RAM allocated to the Peak application, quit Peak, find the Peak program icon and select it by clicking on it once. Now use the Finder’s Get Info feature (⌘-I) to change Peak’s RAM allocation by typing the amount of RAM you would like to allocate to the Peak application into the Preferred Size field. To find out how much RAM your Macintosh has available to applications, choose About This Macintosh under the Apple menu from the Finder.

Premiere format Plug-Ins must reside in the Peak Plug-Ins folder

LE Peak LE only supports up to 3 Premiere format plug-ins. Peak LE will only load the first 3 Premiere format plug-ins installed in the Peak Plug-Ins folder in alphabetical order.

Premiere Plug-In Memory Settings

When using third party plug-ins, you may need to set aside some RAM for the plug-in. The Plug-In Memory dialog under the Preference menu allows you to set this memory reserve (this is separate from the Plug-In Preview Time described in the next section). Generally, for the best results, this preference should be set between 512k and 2038k (the default is 1024k). Since plug-ins from different manufacturers have different needs, check with the manufacturer of the plug-in for suggested memory requirements.

Premiere Plug-In Preview Time

Peak allocates preview time based upon how much RAM is available to Peak. Peak will allow the plug-in to preview with as much audio as it can with the available RAM. To increase the amount of RAM allocated to the Peak application, quit Peak, find the Peak program icon and select it by clicking on it once. Now use the Finder’s Get Info feature (⌘-I) to change Peak’s RAM allocation by typing the amount of RAM you would like to allocate to the Peak application into the Preferred Size field. To find out how much RAM your Macintosh has available to applications, choose About This Macintosh under the Apple menu from the Finder.

LE Peak LE limits previews to three seconds.
RealTime Premiere Plug-In Processing

Peak allows you to use any Premiere format audio plug-ins in real-time. This allows you to apply any Premiere format plug-in to an audio selection skipping the processing step.

To apply a Premiere format plug-in in real time:
1. Select RealTime from the Plug-Ins menu. A checkmark will appear next to this item to indicate that the RealTime Plug-In feature is enabled.

2. Select the Prime RealTime function from the Premiere Plug-Ins menu to “prime” or clear the plug-in buffer by sending silence through it before playback.

3. Select any plug-in from the Premiere submenu in the Plug-Ins menu.

4. Configure the plug-in’s settings to your liking and click OK or Process.

5. Play the audio file by hitting the Spacebar to hear the Premiere format plug-in process the audio in real time. To bypass the plug-in, click and hold the mouse button on the title bar of the audio document.

6. You can choose to apply the effect permanently by disabling the RealTime function. A dialog will appear asking you whether you want to process the audio file. Click OK to apply the plug-in effect to the file, or Cancel to disable the RealTime plug-in.

You can also process through Premiere format audio plug-ins in real-time while recording is in progress (see Chapter 4).

Premiere Envelope
Peak allows you to apply third-party Adobe Premiere plug-in effects gradually according to a specified envelope. This is useful for applying affects gradually over time.

To apply a Premiere Plug-In variably over time:
1. Make a selection of the audio material you wish to process with the plug-in.

2. Choose Premiere Envelope... from the Preference menu.

3. A dialog appears allowing you to draw the curves or lines that control how much of the Plug-In’s effect is applied, over time. Points at the top of the graph represent 100% effect, while points at the bottom of the graph represent 0% of the effect.

The Premiere Envelope editor

4. When you are finished drawing an envelope, click Change.

5. Select the Premiere Plug-In you wish to use from the Plug-Ins menu.

6. Configure the Premiere plug-in and click OK if you decide to process the sound. Note if you are previewing the effect in the plug-in, you will not hear the effects of the Premiere envelope yet, but rather the 100% effect amount your Premiere envelope will use when the selection is finally processed using the Premiere envelope.
Record Through Premiere Plug-In

If you have Premiere-format audio plug-ins installed in your Peak Plug-Ins folder, you can record through them in real-time. This is useful if you want to use a noise reduction, equalizing, or dynamics plug-in during recording.

**To configure Peak to record through a Premiere-format audio Plug-In in real-time:**

1. Open a Peak audio document that has the number of channels you plan to record.
2. Select Record Settings... from the Audio menu. The Record Settings dialog will appear.
3. Click and hold on the Record Through Plug-In pop-up. All of the plug-ins you have installed in your Peak Plug-Ins folder will appear in the pop-up.
4. Scroll to the plug-in you wish to record through and select it. The plug-in’s dialog will appear.
5. Configure the plug-in to your liking, then click OK or Process to close it’s dialog, and select Record from the Audio menu (⌘-R) or Toolbar. You are now ready to record audio through the plug-in.

**To record through a Premiere format plug-in, you must open an audio document with the same number of channels you plan to record before configuring the Record Settings plug-in parameters.**

TDM Plug-Ins

If you are using Digidesign TDM hardware and running DAE 3.4.x or later, Peak-TDM will access your TDM plug-ins, providing a range of exciting real-time effects such as EQ, reverberation, compression, etc. You can chain up to 5 TDM plug-ins in real-time using Peak as long as you have enough DSP horsepower (e.g., additional DSP Farm cards, etc.).

TDM plug-ins are installed in the Plug-Ins folder in the DAE Folder in your System Folder. TDM Plug-ins are *not* installed in the Peak Plug-Ins folder. To install a TDM plug-in, consult the documentation that came with your TDM plug-in.

**To insert a TDM plug-in:**

1. Be sure that Peak is using DAE 3.4 or later. To use your TDM plug-ins in Peak you must be using the DAE option in the Sound Out submenu under the Audio menu.
2. Select a TDM plug-in under Peak’s TDM Plug-Ins menu. The TDM plug-in will appear.
3. Press space or the play button on the Toolbar to hear the audio processed and played with the TDM plug-in.
4. You can hide the TDM plug-in by clicking in the close box of the plug-in. The plug-in will remain active, however, until you remove it, as described below.

**To remove a TDM plug-in:**

- Under the insert menu where the TDM plug-in was assigned, change the menu option to None. The TDM plug-in on that insert will no longer be active.

**To mute or bypass a TDM plug-in**

- Click on the mute or by buttons at the top of the TDM plug-in’s window.

**To insert multiple TDM plug-ins to a Peak audio document:**

1. Select a TDM plug-in under Peak’s TDM Insert menu, under the Plug-Ins menu. The TDM Plug-in will appear in a floating window. The TDM plug-in will appear.
2. Press space or the play button on the Toolbar to hear the audio processed and played with the TDM plug-in.
3. Select another TDM plug-in under the next TDM Insert menu, under the Plug-Ins menu. The TDM Plug-in will appear in a floating window, and the
audio will be processed by the first plug-in in step (1), then by the new plug-in you assigned in (3). Repeat this process to assign additional plug-ins.

**Note:** If you try to assign more plug-ins than your TDM hardware allows (based on the plug-in DSP requirements and the number of DSP chips available in your Digidesign equipment), Peak will not be able to assign additional TDM plug-ins.

**Note:** The TDM plug-ins you enable will be applied to all the playlists or audio documents you play with Peak. In other words, the TDM plug-ins are not specific to a single Audio Document or Playlist.

**Warning:** Peak will display a TDM error message if you try to chain a mono-to-mono plug-in after a mono/stereo or stereo/stereo plug-in, if you try using a mono/mono plug-in on a stereo document, or if you try using a stereo/stereo plug-in on a mono document.

**Bouncing your TDM plug-in assignments**

Once you have the right settings for your TDM plug-ins, you will probably want to apply the effects to the audio document. This changes the audio data stored on disk, allowing you to use the Save command to permanently apply the processed audio to your audio document. Bounce the audio file to process the audio document with any active TDM plug-ins.

**To bounce TDM plug-ins:**

1. Select Bounce under the TDM submenu under Peak's Plug-Ins menu. The TDM plug-ins are applied to the audio document. This process may take a while, depending on the number of TDM Plug-Ins you are applying and also depending on who large the audio file is.

2. If there are no additional audio documents you wish to bounce the TDM effects to, remove the TDM plug-in assignments as described previously in this chapter. Otherwise, playing back the audio after the bounce will sound like you are processing the audio through the TDM plug-ins twice.

3. You can now save the audio document using the Save command under Peak's File menu, or you can undo the bounce using the Undo command under the Edit menu.

**Peak LE does not support DAE or TDM Plug-Ins.**

**Using TDM plug-ins with the Batch File Processor**

Peak will let you use your TDM plug-ins with the Batch File Processor (see Chapter 9: Batch File Processor & Apple Events from more detail on the Batch File Processor). This can be a very powerful and timesaving processing option if you need to apply the same TDM plug-ins to many audio files.

**To use TDM plug-ins with the Batch File Processor:**

1. Open a mono or interleaved stereo file, depending on the file channel format of the files you intend to batch file process.

2. Open and configure the TDM plug-ins you want to use in the batch file process.

3. Choose the Batch Processor from under the File menu.

4. Choose any other processes you want to use for the Batch File Processor and Set the Batch File Processor's Output directory folder.

5. Add Bounce from the Available Processes to the list of Selected Processes for Batch.

6. Be sure that the Batch File Processor is configured to process only Mono Files or only Stereo Files, depending on the settings of your TDM plug-ins (i.e., m/m or s/s).

7. Turn the Batch File Processor On and click OK.

8. Go to the Finder and drag and drop the Audio Files/Folders that you want to batch process over the Peak icon.
9. Peak will batch process these files and save them to the designated directory folder.

\[ \text{\textit{Peak LE does not support Batch File Processing.}} \]

---

**AudioSuite Plug-Ins**

If you are using DAE 3.4.x, Peak provides you with access to AudioSuite plug-ins, providing a range of exciting effects such as EQ, reverberation, compression, etc.

AudioSuite plug-ins are installed in the Plug-Ins folder in the DAE Folder in your System Folder. AudioSuite Plug-ins are not installed in the Peak Plug-Ins folder.

To install an AudioSuite plug-in, consult the documentation that came with your AudioSuite plug-in.

**To process your selection with an AudioSuite plug-ins:**

2. Press the Preview button on the AudioSuite plug-in to preview the plug-in.
3. When you have configured the plug-in to your liking, click the Process or OK button for the plug-in. The audio you have selected in your audio document is processed by the AudioSuite plug-in.

The application of an AudioSuite plug-in under Peak is simply an edit action, and can be undone like any other editing action.

\[ \text{\textit{Peak LE does not support DAE or AudioSuite Plug-Ins.}} \]

---

**VST Plug-Ins**

Peak supports VST 1.0 format plug-ins. VST is a standard audio plug-in technology developed by Steinberg Software und Hardware, GmbH. VST plug-ins offer an exciting array of real-time effects by companies like Steinberg, Cycling ’74, Arboretum, Waves, and others. You can chain up to 5 VST plug-ins in real-time using Peak as long as you have a fast enough CPU in your Macintosh—VST plug-ins are real-time, host-based audio plug-ins that are dependent on the host processor (i.e., your Mac’s CPU).

VST plug-ins are installed in the VstPlugIns folder in the Peak folder. VST Plug-ins are not installed in the Peak Plug-Ins folder, rather the Peak VstPlugIns folder.

To install a VST plug-in, consult the documentation that came with your VST plug-in.

**To insert a VST plug-in:**

1. Select a VST plug-in under Peak’s VST Plug-Ins menu. The VST plug-in will appear.
2. Press space or the play button on the Toolbar to hear the audio processed and played with the VST plug-in.
3. You can hide the VST plug-in by clicking in the close box of the plug-in. The plug-in will remain active, however, until you remove it, as described below. To make a hidden active VST plug-ins reappear, select it from the Window menu.

**To remove a VST plug-in:**

- Under the insert menu where the VST plug-in was
assigned, change the menu option to None. The VST plug-in on that insert will no longer be active.

**To insert multiple VST plug-ins to a Peak audio document:**

1. Select a VST plug-in under Peak’s VST Insert menu, under the Plug-Ins menu. The VST plug-in will appear.

2. Press space or the play button on the Toolbar to hear the audio processed and played with the VST plug-in.

3. Select another VST plug-in under the next VST Insert menu, under the Plug-Ins menu. The VST Plug-in will appear, and the audio will be processed by the first plug-in in step (1), then by the new plug-in you assigned in (3). Repeat this process to assign additional plug-ins.

**Note:** If you try to assign more VST plug-ins than your CPU can handle, audio may begin to playback erratically.

**LE** Peak LE does not support VST plug-ins.

**Bouncing your VST plug-in assignments**

Once you have the right settings for your VST plug-ins, you will probably want to apply the effects to the audio document. This changes the audio data stored on disk, allowing you to use the Save command to permanently apply the processed audio to your audio document. Bounce the audio file to process the audio document with any active VST plug-ins.

**To bounce VST plug-ins:**

1. Select Bounce VST Effects under the VST submenu under Peak’s Plug-Ins menu. The VST plug-ins are applied to the audio document. This process may take a while, depending on the number of VST Plug-Ins you are applying and also depending on how large the audio file is.

2. You will be prompted to disable all VST Plug-Ins after bounce. If there are no additional audio documents you wish to bounce the VST effects to, click Yes. Otherwise, click No. Note that playing back the audio after the bounce will sound like you are processing the audio through the VST plug-ins twice.

3. You can now save the audio document using the Save command under Peak’s File menu, or you can undo the bounce using the Undo command under the Edit menu.

**Compensation of VST plug-in delays**

To compensate for VST plug-in delays when bouncing VST effects on a selection, hold down the Option key when choosing Bounce VST Effects and enter the delay compensation you want in samples.

**The Bounce VST Effects dialog**

**To determine VST delay compensation:**

1. Bounce VST effects.

2. Measure the silence inserted by the bounce.

3. Undo the bounce.

4. Hold down the Option key while choosing Bounce VST Effects.

5. Enter the VST delay compensation amount from step 2.

6. Click OK or press Return.

**Recording through VST plug-ins**

Peak will let you use record through your VST plug-ins. This can be a very useful and timesaving step for
processing audio.

**To record through VST plug-ins:**
1. Open an Audio Document.
2. Open and configure the VST plug-ins you want to record through.
3. Choose the Record Settings from under the Audio menu.
4. Enable Record Through VST Plug-in in addition to any other Record Settings you want. Click OK.
5. Go to the Record dialog and begin recording.

**Using VST plug-in with the Batch File Processor**
Peak will let you use your VST plug-ins with the Batch File Processor (see Chapter 9: Batch File Processor & Apple Events for a detailed description of the Batch File Processor). This can be a very powerful and timesaving processing option if you need to apply the same VST plug-in(s) to many audio files.

**To use VST plug-ins with the Batch File Processor:**
1. Open an Audio Document.
2. Open and configure the VST plug-in(s) you want to use in the batch process.
3. Choose the Batch File Processor from under the File menu.
4. Choose any other processes you want to use for the Batch File Processor and Set the Batch File Processor’s Output directory folder.
5. Add Bounce VST Effects from the Available Processes to the list of Selected Processes for Batch.
6. Turn the Batch File Processor On and click OK.
7. Go to the Finder and drag and drop the Audio Files/Folders that you want to batch process over the Peak icon.
8. Peak will batch process these files and save them to the designated directory folder.

*Peak LE does not support Batch File Processing.*

---

**Conclusion**

You have now learned how to manipulate and process audio using third-party plug-ins with Peak. In the next chapter, you will learn how to use Peak’s powerful Batch File Processor as well as how to use Apple Events with Peak for file management.
Chapter 9:  
Batch File Processor and Apple Events

Introduction

Peak allows you to process any number of audio files at once with any number of possible process using the Batch File Processor. Peak also supports Apple Events, which allows you to manage whole libraries of audio files quickly and easily with database applications such as FileMaker Pro™.

Batch File Processor

Peak’s Batch File Processor is one of the most powerful, versatile, and useful features in Peak. Using the Batch File Processor, you can integrate any series of Peak processes (called a batch script), and apply these scripts to any number of audio files.

⚠️ The currently open audio document and selection you make will be used for previewing processes sequenced into your batch script.

To use Batch File Processing, go to the File menu and select Batch Processing. The Batch File Processor dialog appears.

Peak’s Batch File Processor is split into three areas: Input, Process, and Save Changes. Sequence a series of steps for Peak to execute in the Process section, then set your output file settings in the Save Changes area. Once Peak’s Batch File Processor is configured, you may turn on the Batch File Processor in the Input area.

Once the Batch File Processor is configured and turned on, any files you drop onto the Peak application’s icon (or an alias) will be batch processed according to your settings. You can even drop folders or disks onto Peak’s icon and all of the supported audio contents will be batch processed. You can continue to dropping files, folder, or disks, onto the Peak icon for batch processing while the Batch File Processor is turned on. All subfolders within folders or disks you drag onto the Peak application for Batch File Processing will be recreated in the Batch File Processor’s output directory, preserving all organization of your files. Audio documents opened using the...
Open command from the File menu will not be batch processed.

You can also have the Batch File Processor run in the background while you continue work in Peak or any other application. An icon will flash in the upper left corner of your screen to let you know that the batch processing is enabled.

Supported contents include all file formats that Peak can read, including AIFF, Sound Designer II, QuickTime™, Raw, JAM image files, System 7 Sound, .snd, .au, and WAVE files.

New audio documents created with the Batch File Processor will have the same file name as the original input audio document or with a suffix.

**Input Area**

The Input Area allows you to enable or disable batch file processing. Once the Batch File Processor is configured, you may turn it on with the On button. If you have finished batch processing and no longer need to batch process files, you can use the Off button to disable batch file processing.

You can include/exclude mono or stereo files from the batch process by using the Process All Files, Only Mono Files, and Only Stereo Files buttons. Process All Files is the default setting. To have Peak's batch processor only work with mono files, click the Only Mono Files button. Similarly, to only process stereo files (excluding mono files), engage Only Stereo Files.

**Process Area**

The Process Area shows two lists. The list on the left, labeled Available Processes allows you to select processes that will be used in your batch script. Almost every process or plug-in available in Peak will appear in this list. The list on the right is labeled Selected Processes For Batch and contains the Peak processes in the current batch script.

Double-click on a process in the Available Processes list to add it to the Selected Processes for Batch list. Alternatively, click on a process in the Available Processes list and then click the Add >> button. To remove items from the Selected Processes for Batch list, click on the items and then click on the << Remove button.

When you add a process to the Available Processes list, you may be required to supply settings for the process. The front-most audio document and selection will be used for any previewing the process may support. Peak's batch processor allows you to use multiple instances, or occurrences, of a single process—each with its own settings.

You may also specify which part of the file to apply the process to. Once a process has been added to the Selected Processes for Batch list, you may use one of the buttons Entire File, Apply Just To First x Seconds, or Apply Just To Last x Seconds. Use these buttons to configure how to apply the selected process to an audio document. For instance, if you are using a Fade
In process and only wish to apply it to just the first three seconds of the audio document, click the Fade In process from the Selected Processes for Batch list and then type a “3” into the Apply Just to First x Seconds edit text field. All processes are applied by default to Entire File unless you configure the process otherwise.

If you want the output audio files of your Batch Process to be appended with a suffix, such as .WAV, simply enter the suffix you want appended in the File Name Suffix field. All resulting audio file names will be appended with the suffix you specify.

Save Changes Area

Use the Save Changes Area to configure how your audio documents will be stored after they have been saved using your batch script. Click the Set... button to specify the output document format and settings.

After clicking Set... you will be asked to provide the output file format, bit depth, and compression options using the Save As... dialog described in Chapter 4. Choose which folder to save the processed audio files into with the Save As... dialog.

You can create a text Log File during batch processing to keep track of which files have been processed. This is useful for lengthy batch processing sessions where the possibility of a power failure or other circumstance could prevent the batch process from completing. Click on the Log File... checkbox to specify that a log file should be created for the batch process. After turning the Log File... feature on, Peak will ask you to specify a destination for the log file. The log file can be viewed using SimpleText or any application that can view text files. The Batch File Processor will divert any error messages to the log file if it is enabled. This is useful because any errors Peak encounters during batch file processing will not require user attention during processing. However, Peak will issue a System Beep sound if an error occurs during Batch File Processing. If this happens, check the log file for errors.

Save Script

Peak allows you to save your batch script into a settings file that can be recalled later. This feature is useful if you frequently process files using a specific sequence of processes. After configuring the Batch File Processor, click Save Script... to save your batch sequence into a Batch Script file. You will be prompted for a saving location and name for the batch script. The settings file holding your batch script will store the processes, each process' settings, and output file format.

Load Script

To recall a batch script settings file that was stored using the Save Script feature (as described above), click this button. For example:

To convert a folder of files into AIFF IMA 4:1 files Normalized to 95% with a Log:

1. Choose the Batch Processor command from the File menu.
2. Double-click the Normalize item in the Available Processes list. Enter “95” in the following normalization settings dialog.
3. Click Set... in the Save Changes Area of the Batch File Processor. Choose AIFF from the File Format pop-up menu. Choose IMA 4:1 from the Compression pop-up menu.
4. Choose the folder to save the output files into. Click Save.
5. You will be back in the Batch File Processing dialog. Click Log... and choose the output folder to save the log file into.

6. Click the On button in the Input Area of the Batch File Processor. The Batch File Processor is now turned on.

7. Click OK to close the Batch File Processor dialog.

8. Switch to the Finder, and drag and drop a folder full of audio documents onto the Peak application’s icon.

9. Peak will process all audio files in the folder that was dropped onto the Peak application icon.

10. Once the files have been processed, open an audio document, choose the Batch Processor command from the File menu. You may then turn off the Batch File Processor by clicking Off in the Batch Processing dialog.

**Errors and Cancelling Batch Processes**

Any errors during Batch File Processing will produce a System Beep to notify you of the trouble. If an error occurs during Batch File Processing, Peak will not place an error dialog on the screen. This happens so that processing can continue. If you have specified that you wish to create a log file, errors messages that would appear in an error dialog will appear in the log file indicating where in the batch file process the error occurred.

Once the batch file processor has started, it will continue to process files as quickly as possible. If you find it necessary to halt the batch process, press 

Press 

A dialog will appear allowing you to cancel the batch process. If you choose to cancel the batch process, Peak will finish processing the current file and then ignore any other files to be processed. Once batch processing has been cancelled, Peak will turn the batch file processor Off.

Batch File Processing is not available in Peak LE.

---

**Peak’s Audio Librarian Tools**

Peak’s Audio Librarian Tools are ideal for anyone who maintains a large number of sound effects and other audio files. Through Apple Events, the Peak allows users to catalog and audition sounds from ordinary database applications, such as FileMaker Pro (several ready-made templates are included). Peak also includes Batch Region Processing (via the Export Regions command in the File menu).

**Apple Events™ Support**

Peak understands a vocabulary of Apple Events. Apple Events can automate procedures for you, such as triggering the playback of an audio document.

The standard suite of Apple Events that System 7 “savvy” applications must understand includes the “odoc” (open document) event. For example, when you double-click on a Microsoft Word document, the Macintosh Finder sends an “odoc” Apple Event to the application Microsoft Word. Unfortunately, “odoc” requires the complete document path of the document you wish to open. You can use “odoc” with Peak, but Peak has another feature that makes opening and playing your documents much easier: simplified document descriptions instead of entire document paths. To illustrate this difference, compare the following:

**Full Document Path:**


**Simplified Document Path:**

*Volume Name: John’s HD*

*Document Name: C5-A6.aiff*

Using the simplified document path, Peak searches the indicated volume for the first occurrence of a document matching the name described (called a Find
File operation). Once it is found, it is opened up and ready for playback.

“Savvy” Core Suite of Apple Events (event class = ‘aevt’)

**odoc**

Open Document

The “odoc” event instructs Peak to open an audio document with the document path provided in the data following the event.

**quit**

Quit Peak

The “quit” event Quits Peak.

Peak has its own class of events that it understands, all of which have the ID “furp.” This class descriptor must be present for Peak to understand the events you send to it.

**Peak events (event class = ‘FURP’)**

**sff**

Set FindFile Volume

The “sffv” event tells Peak to use the data following the event (a string of text) as the Volume name to search when providing a simplified document path. When specifying volumes, don’t use colons in the name of the volume.

**sfff**

Set FindFile File

The “sfff” event tells Peak to use the data following the event as the name of the document to find when specifying a simplified document path.

**offf**

Open the FindFile File

The “offf” event tells Peak to find the document on a volume specified by the most recent “sfff” and “sffv” events. If the document is found, it is opened in a window. If the document is not found, Peak will beep once.

**stop**

Stop any currently playing audio

The “stop” event takes no additional data and instructs Peak to stop playing any audio that is currently playing.

**clos**

Close the front-most window

The “clos” event takes no additional data and instructs Peak to close the front-most window, if one exists.

**play**

Play the front most window

The “play” event initiates playback of the front most opened audio document. Use the “stop” event to stop playback, or wait till the document completes it’s playback.

**Example Scripts**

The Filemaker Pro™ documents included in the Peak Extras folder are intended to illustrate Peak’s functionality in an audio document database environment. To try out the scripts, open one of the Filemaker Pro documents, type in the Volume Name (the exact name of the hard disk the audio document resides on) and Document Name for an audio document on one of your hard drives, hit Enter and press the graphic play button. If the document is found, Peak will play the audio document. You can type in new records with the ⌘-n keystroke from Filemaker Pro to get a new empty record.

Below is an example Script Definition from Filemaker Pro that might be used to create a Play Button. There are six steps to this Script Definition:

1. Stop any currently playing audio documents (STOP).
2. Close any open digital audio windows (CLOS).
3. Pass the FindFile Volume name to Peak from some Filemaker Pro field (SFFV).

4. Pass the FindFile File name to Peak from some Filemaker Pro field (SFFF).

5. Tell Peak to find and open the document described by steps 3 and 4, above (OFFF).

6. Tell Peak to Play the front-most audio document (PLAY) (most likely opened in step 5).

Sample Script Definition from Filemaker Pro

Apple Events are not supported in Peak LE.

Conclusion

You have now learned how to batch process audio using Peak’s Batch File Processor as well as using Apple Events to manage whole libraries of audio files with database software such as FileMaker Pro™. In the next chapter, you will learn how to use Peak to edit and transfer samples with Samplers.
Chapter 10: Samplers

Introduction

Peak allows you to import samples directly from compatible samplers, edit or process the audio using all of Peak’s powerful editing and processing functions, and then send the modified sample back to the sampler, all in the digital domain. This capability allows you to use Peak as a powerful sample editing and sound design tool, giving you access to audio processing capabilities far more advanced than those typically found on sample playback instruments.

Peak directly supports the Roland S-760, Ensoniq EPS16+, ASR-10 and ASR-X, and AKAI S1000, S2000 and S3000 series samplers (requires a MIDI interface and Opcode’s OMS). Peak also supports SMDI samplers, including the Kurzweil K2000 and K2500 series, the Peavey SP/SX, and several E-mu samplers, including the ESI-32, the E-64, and the E-IV (requires a SCSI cable between the sampler and the Macintosh).

The following sections explain how to transfer audio documents between your sampler and your Macintosh.

Note: Sampler support is not available in Peak LE, but is available in Peak SE.

Warning: Some samplers have a different interpretation of loop points than Peak does. To compensate, you may need to use the Sampler preference dialog to adjust loop points forward or backward by plus or minus one sample. You may enter independent settings for sending and receiving loop points, as well as loop start and loop end offsets for each. To adjust loop points, select Sampler from the Preference menu.

Working with SMDI Samplers

Peak’s SMDI Sampler Support makes it possible to transfer several audio documents at once to or from your SMDI sampler.

SMDI Samplers supported in Peak (at time of printing):

- E-mu - E-IV, ESI-32, ESI-4000, E-64, E5000
- ENSONIQ - ASR-X
- KURZWEIL - K2000, K2500, K2600
- PEAVEY - SP/SX
- YAMAHA - A3000, A4000, A5000

SMDI Samplers

SMDI Samplers, such as the Kurzweil K2500 or the E-mu E-IV, use SCSI to transfer samples between devices. SMDI is substantially faster than MIDI for transferring sample data. In order to transfer samples between the Macintosh and your sampler using SMDI, you must connect a SCSI cable between your Macintosh and the sampler. Consult your sampler’s owner’s manual for instructions on how to connect the cable to your Macintosh with proper termination. Always use high-quality SCSI cables to avoid data transmission errors.

Warning: Peak allows the user to turn fast Asynchronous SCSI transfers On or Off in the Sampler dialog. Turn Asynchronous transfers OFF if you are...
having trouble transmitting samples to a SMDI or Roland device, or if your Macintosh does not support Asynchronous SCSI transfers.

Ultra-Wide SCSI cards may need to have the SMDI use new: SCSI manager option enabled in the Sampler dialog under the Preference menu.

To use the SMDI Sampler dialog:

1. Choose SMDI Sampler or the name of your sampler from the Sampler menu. The SMDI Sampler Transfer dialog appears.

The SMDI Sampler Transfer dialog

List of Samples
This dialog features a list of samples stored in the SMDI device. Since there are hundreds of sample locations in a SMDI device, an exact range of samples to display is used. You may click on items in the list to view detailed information about the sample in the Info portion of the SMDI Sampler Transfer dialog. You may also Shift-click or Command-shift-click to select multiple items in the list of samples.

Update
The Update button rebuilds the list of samples shown in the SMDI Sampler Transfer dialog. Peak will scan the SMDI device starting at the sample number indicated in the Start edit text field until the number of samples entered in the # Items edit text filed have been scanned.

SMDI Device
Any SMDI devices Peak detects attached to your Macintosh will show up in this pop-up menu. Choose the device using the pop-up menu. Peak will scan the device for sample information starting at the sample number indicated in the Start edit text field.

Start
Enter the first sample number stored in your sampler that you wish to view in the list of samples. If you change this value, you must click on the Update button for the list of samples to be updated. Some SMDI samplers start their samples at sample number zero, others start at 200. Refer to your SMDI Sampler’s manual for information on how samples are stored in your particular device.

# Items
The # Items edit text field controls how many samples are displayed in the list of samples. If you change this value, you must click on the Update button for the list of samples to be updated.

Send
To send the front-most Peak audio document to the SMDI Sampler, click on the sample in the list of samples that you wish to send the sample to and press the Send button. If a sample already exists at the chosen location in the SMDI Sampler, it will be replaced.

To send multiple opened Peak audio documents to the SMDI Sampler, shift-click or click to select multiple destinations in the list of samples and click the Send button. Peak audio
documents will be sent to the selected destinations in the order that they appear under Peak's Windows menu.

Receive
To receive a sample from the SMDI sampler, click on the sample in the list of samples that you wish to receive and press the Receive button.

To receive multiple samples from your SMDI Sampler, shift-click or ⌘-click multiple destinations in the list of samples and click the Receive button.

To send an audio document to your SMDI sampler:
1. Choose Open from the File menu to locate and open the audio document you wish to send to your SMDI sampler. Alternatively, open the audio document by double-clicking it in the Finder.
2. Choose the SMDI Sampler command from the Sampler menu. If Peak finds a SMDI sampler connected to your Macintosh, the SMDI Sampler Transfer dialog appears.
3. Make sure the correct SMDI device is selected in the SMDI Device pop-up menu.
4. Click on the sample in the List of Samples that you wish to replace.
5. Click Send. Peak will send the sample to your SMDI sampler.
6. When you are finished using the SMDI Transfer dialog, click the close box of the dialog or click the Cancel button.

To send a SMDI sample to Peak:
1. Choose the SMDI Sampler command from the Sampler menu. If your SMDI sampler is properly connected to the Macintosh SCSI chain, you will see the SMDI Sampler Transfer dialog appear.
2. Make sure the correct SMDI device is selected in the SMDI Sampler pop-up menu.
3. Click on a sample in the List of Samples that you wish to receive.
4. Click the Receive button. Peak will transfer the sample you identified to the Macintosh and place it into a new audio document window. Audio documents created by bringing samples over from a SMDI device are not saved until you use the Save command from the File menu.
5. When you are finished, click the SMDI Sampler Transfer dialog’s close box or click the Cancel button.

To browse through samples stored in your SMDI device:
• Click on a sample in the List of Samples. If your SMDI device has a sample stored at this sample number location, Peak will retrieve the information about the sample including its sample rate, size, bit depth, stereo/mono format, and loop points and display the information in the Info area of the SMDI Transfer dialog. If there is not a sample stored in the SMDI device with the sample number, “(Empty)” will appear in the sample Info area of the SMDI Transfer dialog.

SMDI Sampler Error Messages & Troubleshooting
If a SMDI device cannot be found connected to your Macintosh, Peak will display the message “No SMDI devices could be found connected to this Macintosh.” If this happens, and your SMDI device is connected to your Macintosh with a SCSI cable, try the following:
• Make sure your SCSI cables are properly connected. SCSI cables can come loose if they are not tightened down using the cable’s connector screws. Make sure you connect the SCSI cables to your Macintosh only when it is turned off.
• Make sure there is not another SCSI device connected to your Macintosh using the same SCSI ID as your SMDI device. Consult your SMDI device’s owner manual for information on how to change the SCSI ID of your SMDI device.
• You may need to turn on your SCSI devices in the correct order. Turn all of the SCSI devices connected to your Macintosh on first, then turn on the Macintosh and launch the Peak application.

A note about the Yamaha A3000
Peak supports the Yamaha A3000 digital sampler. You can access the A3000 sampler using either the Yamaha A3000 or SMDI menu selection under Peak’s Sampler menu. Please note the A3000 cannot replace existing samples, and any transfers to the A3000 will be placed in at the next available empty sample in RAM, regardless of where you instruct Peak to place the sample. When “BulkProtect” is turned on, the A3000 does not respond to SMDI messages. “BulkProtect” is at UTILITY mode, MIDI function, Bulk page. BulkProtect is always ON after you turn on the A3000, so you will need to turn it off before you can do SMDI transfers.

The Sampler Preferences dialog
You can access the Sampler Preferences from under Peak’s Preference menu to set Loop Offsets, Asynchronous SCSI transfer, and SCSI Management preferences.

Working with the Roland S-760 Sampler
The Roland S-760 digital sampler is fully supported in Peak. Direct support for Roland in Peak makes it easy
for you to transfer samples back and forth between Peak and your S-760 sampler. Peak will also transfer loop information along with sample data.

To set up a SCSI connection between your computer and the S-760:

1. Turn off all devices, including your Macintosh, before connecting SCSI cables.
2. Connect the sampler to your SCSI chain, being sure to use high-quality SCSI cables no more than 6 feet in length.
3. Make sure the SCSI ID number on the sampler is different from that of any other SCSI devices attached to your Macintosh, and that it is internally terminated. Consult your S-760 owner’s manual for specific information on how to set the SCSI ID number and internal termination of the sampler.
4. Be sure the sampler is physically the last device in the SCSI chain.
5. You must also have a MIDI connection between your computer and the sampler. Peak uses Opcode’s OMS system to communicate with the sampler via MIDI. Refer to your OMS user’s guide for instructions on how to connect your sampler to a MIDI interface, and how to configure OMS on your Macintosh.
6. Power up the devices in this order:
   - Sampler
   - Any other SCSI devices
   - Your Macintosh

If the Info region of the Roland dialog reports that the Roland sampler could not be found, check your SCSI and MIDI connections and cables, SCSI ID pop-up menu, OMS device pop-up menu, or SYSEX ID number. If you have found and corrected a mistake, click on Update.

To browse Roland S-760 samples in Peak:

1. Choose Roland S-760 from Peak’s Sampler menu.
2. Click on any sample in the sample list. Peak will display information about the sample, including loop points, sample length, root key, and sample rate.

Transferring samples from the S-760 to Peak:

1. Choose Roland S-760 from Peak’s Sampler menu. Choose the SCSI ID number that your sampler is set to using the pop-up menu, enter the SYSEX ID number and the OMS device, and click on Update. Peak will display a list of all the samples currently stored in your sampler’s RAM. Refer to your Roland owner’s guide for instructions on how to set your sampler’s SYSEX ID. Usually this number will be 0 or 1.
2. Highlight the samples in the sample list that you wish to transfer to Peak.
3. Press the Receive button. Peak will transfer the samples into new audio document windows where you may edit, play, or save them.

Sending samples from Peak to the S-760:

1. Open the audio documents that you wish to transfer using Peak’s Open command. If you only wish to send one audio document, make sure it is the front-most document in Peak.
2. Choose Roland S-760 from Peak’s Sampler menu.

Roland sample transfers require the Roland S-760 Operating System 2.24 or newer. The Roland S-760 will only enable sample transfers when in Performance Mode. Consult your Roland owner’s guide for more information on how to switch modes on your sampler.

To access your Roland S-760 from Peak, select Roland S-760 from Peak’s Sampler menu. Choose the SCSI ID number that your sampler is set to using the pop-up menu, enter the SYSEX ID number and the OMS device, and click on Update. Peak will display a list of all the samples currently stored in your sampler’s RAM. Refer to your Roland owner’s guide for instructions on how to set your sampler’s SYSEX ID. Usually this number will be 0 or 1.

If the Info region of the Roland dialog reports that the Roland sampler could not be found, check your SCSI and MIDI connections and cables, SCSI ID pop-up menu, OMS device pop-up menu, or SYSEX ID number. If you have found and corrected a mistake, click on Update.

To browse Roland S-760 samples in Peak:

1. Choose Roland S-760 from Peak’s Sampler menu.
2. Click on any sample in the sample list. Peak will display information about the sample, including loop points, sample length, root key, and sample rate.

Transferring samples from the S-760 to Peak:

1. Choose Roland S-760 from Peak’s Sampler menu. Choose the SCSI ID number that your sampler is set to using the pop-up, and click Update. Peak will display a list of samples stored in your S-760’s RAM.
2. Highlight the samples in the sample list that you wish to transfer to Peak.
3. Press the Receive button. Peak will transfer the samples into new audio document windows where you may edit, play, or save them.

Sending samples from Peak to the S-760:

1. Open the audio documents that you wish to transfer using Peak’s Open command. If you only wish to send one audio document, make sure it is the front-most document in Peak.
2. Choose Roland S-760 from Peak’s Sampler menu.

To access your Roland S-760 from Peak, select Roland S-760 from Peak’s Sampler menu. Choose the SCSI ID number that your sampler is set to using the pop-up menu, enter the SYSEX ID number and the OMS device, and click on Update. Peak will display a list of all the samples currently stored in your sampler’s RAM. Refer to your Roland owner’s guide for instructions on how to set your sampler’s SYSEX ID. Usually this number will be 0 or 1.

If the Info region of the Roland dialog reports that the Roland sampler could not be found, check your SCSI and MIDI connections and cables, SCSI ID pop-up menu, OMS device pop-up menu, or SYSEX ID number. If you have found and corrected a mistake, click on Update.

To browse Roland S-760 samples in Peak:

1. Choose Roland S-760 from Peak’s Sampler menu.
2. Click on any sample in the sample list. Peak will display information about the sample, including loop points, sample length, root key, and sample rate.

Transferring samples from the S-760 to Peak:

1. Choose Roland S-760 from Peak’s Sampler menu. Choose the SCSI ID number that your sampler is set to using the pop-up menu, enter the SYSEX ID number and the OMS device, and click on Update. Peak will display a list of samples stored in your S-760’s RAM.
2. Highlight the samples in the sample list that you wish to transfer to Peak.
3. Press the Receive button. Peak will transfer the samples into new audio document windows where you may edit, play, or save them.

Sending samples from Peak to the S-760:

1. Open the audio documents that you wish to transfer using Peak’s Open command. If you only wish to send one audio document, make sure it is the front-most document in Peak.
2. Choose Roland S-760 from Peak’s Sampler menu.

To access your Roland S-760 from Peak, select Roland S-760 from Peak’s Sampler menu. Choose the SCSI ID number that your sampler is set to using the pop-up menu, enter the SYSEX ID number and the OMS device, and click on Update. Peak will display a list of all the samples currently stored in your sampler’s RAM. Refer to your Roland owner’s guide for instructions on how to set your sampler’s SYSEX ID. Usually this number will be 0 or 1.

If the Info region of the Roland dialog reports that the Roland sampler could not be found, check your SCSI and MIDI connections and cables, SCSI ID pop-up menu, OMS device pop-up menu, or SYSEX ID number. If you have found and corrected a mistake, click on Update.
Supported AKAI samplers include the S1000, S1100, S2000, S2800, S3000, S3000XL, S3200, S3200XL, CD3000, and CD3000XL. Direct support for AKAI samplers in Peak makes it easy for you to transfer samples back and forth between Peak and your AKAI sampler. Peak will also transfer loop information along with sample data.

To set up a SCSI connection between your computer and the AKAI sampler:

1. Turn off all devices, including your Macintosh, before connecting SCSI cables.

2. Connect the sampler to your SCSI chain, being sure to use high-quality SCSI cables no more than 6 feet in length.

3. Make sure the SCSI ID number on the sampler is different from that of any other SCSI devices attached to your Macintosh. Consult your AKAI owner’s manual for specific information on how to set the SCSI ID number of your AKAI sampler.

4. If your sampler is internally terminated, it will need to be the last device in the SCSI chain. Consult your AKAI owner’s manual for specific information on how to set the internal termination of the sampler.

5. Power up the devices in this order:
   - Sampler
   - Any other SCSI devices
   - Your Macintosh

To access your AKAI sampler from Peak, select AKAI Sampler from Peak’s Sampler menu. Choose the SCSI ID number that your sampler is set to using the pop-up menu and click on Update. Peak will display a list of all the samples currently stored in your sampler’s RAM.

If the Info region of the AKAI dialog reports that the AKAI sampler could not be found, check your SCSI connections and cables and SCSI ID pop-up menu. If you have found and corrected a mistake, click on Update.

Working with AKAI samplers

The Akai sampler dialog
AKAI samplers require that samples be numbered in successive order, with no empty samples occurring between existing samples. Therefore, the sampler may automatically renumber any samples you transfer to it in order to conform to its own numbering system.

AKAI samplers also require that each sample have a unique name. When sending an audio file to a new empty location in the sampler, Peak may append the name of the new sample with a numeral (e.g., “Sax 1,” “Sax 2,” “Sax 3,” and so on) if the name of the incoming sample is currently in use in the sampler.

Stereo samples stored in the AKAI sampler will be split into two channels, and AKAI samplers require that the names have “-L” or “-R” at the end of each sample’s name. Peak will automatically append “-L” or “-R” to the left and right channels of the sample when transferring a stereo sample to the AKAI sampler.

AKAI samplers use only two sample rates, 22,050Hz and 44,100Hz. To have Peak automatically perform a sample rate conversion on any audio documents not already in these two formats, check the Auto SRC checkbox. Peak will perform a sample rate conversion to the closest sample rate the AKAI support before sending the sample to the sampler.

To select more than one item in the sample list, shift-click or command-click while selecting.

The Adaptec 2906 SCSI card is recommended for use with Akai samplers on G3 and G4 Macintoshes.

MIDI Sample Dump Standard

A large number of sampling instruments and older sampling instruments support transferring samples between samplers or computers using a method called MIDI Sample Dump. Peak allows you to transfer samples to and from these instruments if you have a MIDI connection.

MIDI Sample Dump Standard works only with mono audio documents.

This guide assumes you are familiar with how to connect MIDI Cables, configure your Open Music System (OMS) software, and understand how your sampler integrates with audio samples sent through MIDI.
Once a sample is sent to the sampler, it may need to be assigned to a patch, preset, layer, or voice before you can play back the sample.

Refer to your MIDI sampler instrument’s Owner’s Guide for information on how to display and set the instrument’s Sysex ID.

Because different samplers store samples differently, you should refer to the Owner’s Guide of your particular sampler to understand how samples are numbered and stored in your sampler. There may be important information in the manual on how to use MIDI Sample Dump with your sampler.

There are two methods of connecting the MIDI cables from your computer to the sampler to do a MIDI Sample Dump. Peak uses the closed loop configuration, where you must connect the MIDI IN jack to the OUT jack of your MIDI Interface, then connect the MIDI OUT jack from your sampler to the IN jack of your MIDI Interface.

In order to use MIDI Sample Dump, you will also need to install Opcode’s OMS software. If you do not have OMS installed, you can download it from the Opcode World Wide Web site at http://www.opcode.com, or call Opcode directly to receive the software on floppy diskette.

Peak sends and receives all MIDI Sample Dumps as 16-bit resolution samples. Depending on your particular sampler, the 16 bit resolution may be reduced to a lower resolution to match the sampler’s capabilities. MIDI Sample Dump does not support stereo audio documents, so you may need to separate your stereo audio documents into left and right mono documents using the Export Dual Mono... command in the File menu. You can then send the mono documents separately to the sampler.

To send an audio document to a sampler using MIDI Sample Dump Standard:

1. Open the audio document you wish to send to the sampler instrument.
2. From the Sampler menu, choose the MIDI Sample Dump command.
3. Select the OMS device corresponding to the sampler that you wish to send the sample to.
4. Enter the Sysex ID that the sampler is set to.
5. Enter the sample number you wish to assign the sample to in the sampler and press the Send button. Peak will transfer the sample to the sampler over the MIDI connection.

To receive an audio sample from a sampler using MIDI Sample Dump Standard:

1. From the Sampler menu, choose the MIDI Sample Dump command.
2. Select the OMS device corresponding to the sampler that you wish to receive a sample from.
3. Enter the Sysex ID that the sampler is set to.
4. Enter the sample number you receive from the sampler and press the Receive button. Peak will receive the sample into a new audio document.

MIDI Sample Dump Standard Error Messages & Troubleshooting

You may only send mono audio documents to the sampler. If you wish to send a stereo audio document to the sampler, you will need to create two separate mono files to send to the sampler corresponding to the left and right channels of the audio document using the Export Dual Mono... command in the File menu.

MIDI Sample Dump Standard works only with mono audio documents.

“The MIDI device timed out.”

• The device failed to communicate with Peak as
expected. This error can be caused by a break in the MIDI connection during the transfer.

“The MIDI device returned an error.”
- This error message can occur when the sample transfer is aborted from the front panel of the MIDI sampler.

“The MIDI device did not respond.”
- This error message can occur when Peak sends a message and no response is sent back. Check the Sysex ID of the sampler and make sure it matches the one you entered in the MIDI Sample Dump dialog.

“The MIDI transfer was aborted because there were errors during transmission.”
- This error message indicates that there may be a bad MIDI cable or connection between the sampler and the MIDI Interface. Check the MIDI cables for damage.

“The transmission timed out.”
- This error message can occur when Peak is waiting for information from the sampler and too much time elapses without a response. Check your MIDI connection and try again.

“Peak does not have enough RAM to use MIDI Sample Dump Standard. MIDI SDS Receive could not be completed because Peak ran out of memory.”
- The Peak software has run out of memory when this error message occurs. Try closing some audio document windows or allocating more RAM to the Peak application using the Finder’s Get Info dialog.

“Peak was unable to initialize OMS. Make sure OMS is installed on your Macintosh and try again.”
- This message appears when OMS is not installed on your Macintosh. Make sure it is not disabled in your Extensions Manager or other System Software management utilities. If you have not installed OMS, you can download it from the Opcode World Wide Web site at http://www.opcode.com or by contacting Opcode directly.

---

Working with Ensoniq EPS16+ and ASR-10 Samplers

Owners of Ensoniq Samplers will find the Peak Ensoniq Sampler dialog an indispensable tool for transferring samples between their Macintosh and an Ensoniq EPS16+ or ASR-10 Sampler. As a part of the Peak digital audio editor software, the Ensoniq Sampler dialog provides several operations beyond wavesample transfer, including instrument, layer and wavesample renaming, creation, and deletion.

Note: The Ensoniq ASR-X is a SMDI sampler (see Working with SMDI Samplers at the beginning of this chapter).

The following sections assume you are familiar with the procedures for operating your Ensoniq Sampler as detailed in its owner’s guide. Please consult your owner’s guide for details on how to connect your sampler to your audio system and MIDI interface.

How Samples are stored in Ensoniq Samplers

The Ensoniq family of digital samplers organize wavesamples (a sample) into layers that are contained by instruments. A layer can contain several samples, each having its own characteristics such as volume, panning location, and the specific keyboard notes that trigger the sample, or keyrange. Ensoniq Samplers number all of these structures “Wavesample 1”, “Layer 4”, and “Instrument 3,” referring to specific and unique items stored in the sampler’s memory.

Ensoniq Samplers create layers in order, therefore you cannot create layer 2 if layer 1 has not been created. You must first create layer 1. Ensoniq Samplers also create wavesamples in order, therefore you cannot not
create wavesample 3 if wavesamples 1 and 2 have not been created. You must first create wavesamples 1 and 2.

The Ensoniq Sampler dialog maintains a list of instructions to execute with your Ensoniq Sampler, according to your directions. For instance, you may wish for the Ensoniq Sampler dialog to send a wavesample, create new layers on an instrument, rename instruments, and then receive a wavesample to your Macintosh. Use the List menu in the Ensoniq Sampler dialog to add and remove items in the Ensoniq Sampler dialog to execute these instructions.

The Ensoniq Sampler dialog

Ensoniq Sampler Dialog Basics

The Ensoniq Sampler dialog displays your Ensoniq Sampler’s instruments, layers and wavesamples in a Finder-like interface that Macintosh users will find familiar. A convenient twist-down list allows you to customize your display of instruments, layers, and wavesamples. By clicking on the triangles next to an item in the Ensoniq Sampler dialog’s list, you can expand or collapse a list item, such as an instrument or layer. Instruments, layers, and wavesamples also show their item number as represented on the Ensoniq Sampler. For instance, Instrument number three on an Ensoniq Sampler with the name “TROMBONE” will show up as a list item with the name “Inst 3:TROMBONE.”

Instruments, layers, and wavesamples can be in one of three states to the Ensoniq Sampler dialog software: “existing,” “empty,” or “unknown.” All instruments, layers, and wavesamples are unknown until the Ensoniq Sampler dialog software is synchronized with the Ensoniq Sampler by using the Update menu command in the Ensoniq Sampler dialog’s Info menu. If an instrument, layer, or wavesample is found with a name, the name changes from “unknown” to the instrument name, layer name, or wavesample number in the Ensoniq Sampler dialog window. Any other instruments, layers, or wavesamples are EMPTY, which means they don’t exist yet on the Ensoniq Sampler.

The Ensoniq Sampler dialog cues up a list of actions to carry out with the Ensoniq Sampler and carries out the list when you click on the Begin button in the Ensoniq Sampler dialog. In addition, you can save the list of instructions as a file on the Macintosh and recall it later so that lengthy transfers can easily be automated.

Most operations use a simple sequence of actions to record instructions into the Ensoniq Sampler dialog:

1. Select one or more list items by clicking or shift clicking on items in the Ensoniq Sampler dialog list.

2. Choose a command from one of the Ensoniq Sampler dialog menus: List, Info, or Options. You can scroll through the list by using the vertical slider on the right side of the Ensoniq Sampler dialog list. Expand or collapse instruments or layers by clicking on the triangle next to the instrument or layer name.

User Tip: You can Shift-click on list items to select more than one list item to apply a command to.

When you click on a wavesample represented in the Ensoniq Sampler dialog list, the wavesample’s name, size, panning, and keyrange will be retrieved from the Ensoniq Sampler. When the information is complete,
The Ensoniq Sampler dialog will display the information in the area below the Ensoniq Sampler dialog list.

### Auditioning Wavesamples already in the Ensoniq Sampler

To hear a wavesample stored on the Ensoniq Sampler, double-click on the list item in the Ensoniq Sampler dialog list that represents that wavesample. The Ensoniq Sampler dialog will play back the sample using MIDI.

### Changing Parameters and Keyranges

You can change the keyrange or panning of a wavesample that already exists on the Ensoniq Sampler.

**To change the keyrange or panning of a wavesample:**

1. Click on the wavesample that you wish to modify in the Ensoniq Sampler dialog list. The current keyrange, panning, size, and name of the sample will be retrieved by The Ensoniq Sampler dialog and displayed in the area below the Ensoniq Sampler dialog list.

2. Click on the pan slider to change the wavesample's panning, or click on the Ensoniq Sampler dialog graphic keyboard to change the wavesample's keyrange.

3. Click a key on the Ensoniq Sampler dialog keyrange display to change the low key of the wavesample's keyrange.

4. Hold down the Shift key and click on the Ensoniq Sampler dialog keyrange display to change the high key of a keyrange.

5. Hold down the Option key and click on a key in the Ensoniq Sampler dialog keyrange display to change the root key of the wavesample's keyrange.

You can also change the keyrange of the samples you are sending to the Ensoniq Sampler. These items are displayed in the dialog's list with a green right-arrow. The keyrange and panning info for these samples are set to default values read from the sound file that you are transferring. Use the same procedure described above to change the keyrange of samples marked for transfer to the Ensoniq Sampler.

### Ensoniq List Menu

The following section describes commands found in the List menu within the Ensoniq Sampler dialog.

#### Make New

Use the Make New menu item to change EMPTY instruments, layers, or wavesamples into existing ones.

To create the first new wavesample to send an audio document to on the sampler:

1. Open the instrument by clicking on its triangle.

2. Open the layer you wish to place the new wavesample onto by clicking on its triangle, or skip to step 3 if it is an empty layer.

3. Choose New from the List menu. If the layer was “EMPTY,” it will change to “New.” Repeat steps 3 and 4 to create the first new wavesample in the layer. The layer can now be opened by clicking on its triangle, revealing the new wavesample.

To create additional new wavesamples in a layer that already has samples in it:

1. Open the instrument by clicking on its triangle.

2. Open the layer you wish to place the new wavesample onto by clicking on its triangle.

3. Select any one of the wavesamples that appear in the layer by clicking on a wavesample.

4. Choose New from the List menu. A new wavesample will appear in the list of wavesamples belonging to that layer.

#### Send Sample

To send a sample from the Macintosh to the Ensoniq Sampler:

1. Select the wavesample that already exists or has been marked as “New” in the Ensoniq Sampler dialog list.
2. Select Send Sample from the List menu.

3. The standard Get File Macintosh file dialog will appear allowing you to select a sample for transfer into the selected instrument, layer, and wavesample. Select the sample to send and click Open. The Ensoniq Sampler dialog will change the name of the wavesample you have chosen to the name of the file you picked to send to the Ensoniq Sampler.

4. To begin transfer of the sample to the Ensoniq Sampler, click Begin in the Ensoniq Sampler dialog.

If the sample you wish to send to the Ensoniq Sampler is a stereo sample, the Ensoniq Sampler dialog will automatically detect this when you choose a sample to send in the above procedure. Keep in mind that stereo samples must have the left channel on an odd layer, while the right channel of the sample resides on an even layer. Instruct the Ensoniq Sampler dialog to send stereo samples to odd layers of an instrument. If you have not created a right channel layer on the instrument, the Ensoniq Sampler dialog will warn you and ask if you wish to have one created. If you have not created a new wavesample on an adjacent even layer, the Ensoniq Sampler dialog will warn you and ask if you wish to create one.

Your Macintosh must have enough RAM to read in the entire sample you are sending to or receiving from the Ensoniq Sampler. Otherwise, a memory error dialog will appear informing you that you must allocate more RAM to the Peak application.

The Ensoniq Sampler dialog will tell you how much more RAM you must allocate to the Peak application to successfully transfer the sample to the Ensoniq Sampler. If this occurs, you must quit the Peak application and allocate more memory to the Peak application. To do this, select the Peak application icon in the Finder and select Get Info from the Finder’s File menu. Increase the Preferred Size to the appropriate amount of RAM and close the Get Info dialog box. You may then open the Peak application from the Finder and send the sample to the Ensoniq Sampler using the Ensoniq Sampler dialog. (Open audio document windows also use up RAM available for Peak.)

You may not send a sample to an Ensoniq Sampler dialog wavesample list item that is unknown—you must first create the new wavesample using the New command in the List menu. Additionally, you must create the instruments, layers, and wavesamples in the following order: instruments, a new layer belonging to the new instrument, then new wavesamples belonging to the new layer. Using the Make New operation on an empty instrument, layer, or wavesample changes the name in the Ensoniq Sampler dialog to “New.”

To receive a sample from an Ensoniq Sampler:
1. Click on the wavesample that exists in the Ensoniq Sampler dialog to select it.
2. Select Receive Sample from the List menu. The item representing the wavesample you have chosen to import to your Macintosh will be marked with a blue left-arrow graphic.
3. To begin transfer of the sample to the Macintosh, click Begin in the dialog.

If the sample you have selected from the Ensoniq Sampler dialog list is a stereo sample (available on the ASR sampler only), the Ensoniq Sampler dialog will automatically retrieve both sides of the stereo sample.

Delete

To delete items from the Ensoniq Sampler directly, click or shift-click items to delete in the Ensoniq Sampler dialog list, then choose Delete from the List menu.

Remove From List

The Ensoniq Sampler dialog maintains a list of instructions to carry out with your Ensoniq Sampler.
until you click the Begin button. To remove one of the instructions, such as a sample transfer or a rename, click on the item with the instruction and choose Remove From List from the List menu.

**Save Set**

Once you have created a list of instructions for Ensoniq Sampler dialog to carry out, you can save this list of items as a Macintosh document that can be recalled later.

**To save a set of instructions:**

1. Create a list of instructions using the Ensoniq Sampler dialog,
2. Choose Save Set from the List menu to save the list as a document. Make sure you use the Save Set command before you click Begin in the Ensoniq Sampler dialog.

**Load Set**

You can recall a list of instructions using the Load Set command in the List menu. A standard Get File dialog will appear, prompting you to pick an instruction set document. This loads the set of instructions for the Ensoniq Sampler dialog to execute. To save a set of instructions for your Ensoniq Sampler using the Ensoniq Sampler dialog, see the Save Set description, above.

**Clear Set**

To clear the entire set of instructions you have instructed the Ensoniq Sampler dialog to carry out, choose Clear Set from the List item. All instructions (sending samples, receiving samples, and renaming samples) that are currently stored in the Ensoniq Sampler dialog will be permanently deleted. You cannot undo this operation.

**Ensoniq Info Menu**

**Update**

Since the Ensoniq Sampler dialog cannot continually update its internal list of the editing actions you perform from the front panel of your Ensoniq Sampler, you may periodically need to update its link to your Ensoniq Sampler. This will update the names of the instruments, layers, and wavesamples. To do this, select the instrument or layer item that you wish to update by clicking on it and choose Update from the List menu.

**Update Names**

To retrieve only the current names of the instruments stored in your Ensoniq Sampler, choose Update Names from the Info menu.

**Rename**

To rename an instrument, layer, or wavesample, select or Shift-click select items from the Ensoniq Sampler dialog list and choose Rename from the Info menu. You will then be prompted to enter the new name for each item that was selected in the Ensoniq Sampler dialog list.

**Ensoniq Options Menu**

**Use SCSI**

The Power Macintosh SCSI bus is not compatible with Ensoniq ASR-10 or EPS16+ samplers. All transfers must be done over MIDI.

**Clear After Done**

To remove all items from the Ensoniq Sampler dialog from the list of instructions after it is finished with the list, choose the Clear After Done command the Options menu. If Clear After Done is enabled, the Ensoniq Sampler dialog will erase your list of instructions after it completes them.

**Ensoniq Error Messages and Troubleshooting**

If the Ensoniq Sampler dialog encounters an error condition while communicating with your Ensoniq Sampler, a warning dialog similar to the one shown in the illustration that follows will appear. When the warning dialog appears, you can either attempt to continue the current operation by clicking continue, abort the current operation by clicking abort, or Quit.
Peak itself by clicking Exit To Finder. The warning dialog usually appears if your MIDI connection to the Ensoniq Sampler is not properly configured.

**Here are some common Ensoniq configuration mistakes:**

- Choosing the wrong OMS device in the Ensoniq Sampler dialog’s OMS device selection pop-up menu.

- Your Ensoniq Sampler is set to “MIDI SYSEX=OFF.” To verify that this is the problem, press EDIT then press the SYSTEM button until you see “MIDI-SYSEX=OFF.” Turn MIDI-SYSEX=ON by pressing “ENTER/YES” on the Ensoniq Sampler. You may save this as a “default setting” using the “SAVE GLOBAL PARAMETERS” option from the COMMAND/SYSTEM page of your Ensoniq Sampler.

- Forgetting to turn on your MIDI interface.

- Forgetting to turn on your Ensoniq Sampler.

- MIDI cables connected incorrectly.

- A bad MIDI connection.

- Having AppleTalk on when your MIDI interface is configured to communicate with the Ensoniq Sampler through the Printer serial port. Either re-configure your MIDI interface connections, or turn AppleTalk off using the Chooser under the Apple menu.

The warning dialog will also appear if you attempt to initiate a procedure on the Ensoniq Sampler that is not valid.

**Here are some common mistakes:**

- Making a new wavesample and/or sending a wavesample to an instrument onto a new layer when the previous layers do not exist. Remember, you may not work with “Layer 4” unless layers 1, 2, and 3 exist.

- Failing to use the Update command in Ensoniq Sampler dialog to keep the Ensoniq Sampler dialog software current with any editing you might have done since your last Update. Remember, the Ensoniq Sampler dialog cannot constantly automatically update itself. It needs your help. To do this, select the instrument or layer item that you wish to update by clicking on it and choose Update from the List menu.

---

**Conclusion**

You have now learned how to import samples directly from compatible samplers (to edit or process the audio using all of Peak’s functions) and send the modified samples back to the sampler. In the next and final chapter, you will find detailed descriptions of every Peak menu item.
Chapter 11: Peak Menus

This chapter explains each of the commands found in Peak’s menus. For step-by-step instructions on implementing these commands, refer to the index, and go to the appropriate chapter where use of the command is covered. There you will learn how to apply the functions described here.

File Menu

This menu contains all of the standard Macintosh commands for opening, closing, and saving files, as well as several additional commands specific to the Peak application.

New
This command allows you to create a new Peak audio document. When you choose this command, a submenu menu appears which allows you to choose either a mono or stereo format for the new audio document, or to create a playlist document or a new audio document from an open playlist document.

Mono Document
Choosing Mono Document (⌘-N) creates a mono (one channel) audio document.

Stereo Document
Choosing Stereo Document (Shift-⌘-N) creates a stereo (two channel) audio document.

Document From Selection
Choosing Document From Selection (Control-⌘-N) creates a new audio document from any selected audio in an open audio document.

Playlist Document
Choosing Playlist Document (Shift-⌘-P) creates a new playlist document.

Document From Playlist
Choosing Document From Playlist (Shift-⌘-B) creates a new audio document from an open playlist document.

Open...

The Open command (⌘-O) allows you to locate and open an audio document. Peak can open audio documents in a variety of formats including, AIFF, Sound Designer II, QuickTime, Raw, WAVE, .au, .snd, System 7 Sound, and MP3 (requires QuickTime 4 or later) audio format. The Open command also allows you to audition AIFF, SDII, QuickTime, .au, and
System 7 Sounds files by selecting the file in the dialog and clicking the Play button in the QuickTime-style movie controller on the center left of the open dialog. Peak allows you to have as many documents open at the same time as RAM permits. The more free memory that you can allocate to Peak, the more documents you will be able to open and work with simultaneously.

The Open dialog

**Close**

The Close command (⌘-W) closes the currently active Peak audio document. If you haven’t saved changes, Peak will prompt you to do so before it closes the document. If you have many documents open and don’t wish to save any of the changes you’ve made, option-click on the prompt dialog’s Don’t Save button.

**Close All**

The Close All command (Option-⌘-W) closes all open Peak audio documents. If you haven’t saved changes, Peak will prompt you to do so before it closes the documents. If you don’t wish to save any of the changes you’ve made, option-click on the prompt dialog’s Don’t Save button.

**Save**

The Save command (⌘-S) saves the current audio document. Peak can save audio documents in a variety of audio file formats including:

- **AIFF**: This is Apple’s Audio Interchange File Format. It is also Peak’s default file format and is supported by many Macintosh software applications.

- **Sound Designer II**: This is Digidesign’s audio file format for its digital audio products. Use this format if you wish to use an audio document in a Digidesign audio application.

- **.au**: This file format is commonly used on the World Wide Web and in Java audio applets. It is supported by many platforms and programs.

- **WAVE**: This is Microsoft’s Windows Audio File Format. It is supported by many Windows’ software applications and some Macintosh applications. The WAVE format is best if you plan to use an audio document in an application that supports or requires WAVE format files.

- **QuickTime**: This is Apple’s audio file format for QuickTime-based multimedia. It is supported by all Macintosh software applications that support QuickTime. The QuickTime format is best if you plan to use an audio document in multimedia applications that support QuickTime, such as Adobe Premiere™ or Macromedia Director™.

- **Raw**: This is the headerless raw file format that may be useful for some game platforms.

- **RealAudio**: This is the file format for RealNetworks RealAudio 5.0, 3.0 and 2.0 Encoders, used for preparing audio for streaming over the internet.

- **System 7 Sounds**: This the Apple audio file format used for Macintosh Operating System Sounds.

- **JAM image files**: This is the JAM audio image file format. JAM audio image files may be created in Peak and used in Roxio JAM for burning audio CDs. (See Chapter 6: Playlists & CD Burning for more information.)

- **Sonic AIFF**: The file format used by Sonic Solutions audio workstations.

- **.paf**: This is the file format used by E-mu’s Paris audio system.

- **Shockwave**: This is the file format used by Macromedia’s Shockwave format, for preparing audio for streaming over the internet. (Requires the SWA Export Extra.)
**MP3**: Saves audio as MP3 encoded audio. (Requires the SWA Export Extra.)

Different formats allow different information to be stored with the file. If you open a file created in a format other than Peak's default AIFF format, Peak will preserve any format-specific information unless you save the file into a different file format. Saving a file in a different format than its original format, however, may cause some information stored in the file to be discarded. For instance, Sound Designer regions cannot be stored in QuickTime, .au, System 7, MPEG-3, Shockwave, or RealAudio files. Nor can copyright, author, or other file format-specific information be saved in a format which doesn't support it.

**Save As...**

The Save As (Shift-⌘-S) command allows you to save a copy of the current audio document under a different name, in a different location on your hard drive, or in a different audio file format. The saved copy will become the active open audio document. You can save the document with a variety of audio compression schemes — see Chapter 3 for detailed instructions on using this feature.

**Save A Copy As...**

The Save A Copy As command (Option-⌘-S) allows you to save a copy of the currently active open audio document under a different name without replacing the active open audio document.

**Import CD Track**

The Import CD Track command allows you to import audio from an audio CD if you own a Macintosh computer that is equipped with a compatible CD-ROM drive and Apple's Sound Manager software (version 3.3 or later). For more detail on importing CD audio with Peak, see Chapter 4: Playback & Recording.

**Import CD Audio dialog**

**To import tracks from an audio CD:**

1. Insert an audio CD in your CD-ROM drive.
2. Choose Import CD Track from the File menu.
3. In the dialog that appears, select the CD track that you wish to import and click Mark. You may mark multiple tracks for import. If you wish to import all of the tracks on the CD, click on the Mark All button.
4. To Name a selected CD track, click on Name...
button, or, if you are online, you can use the online CD Data Base by checking the Get CD Info from CDDB checkbox.

5. To select only a portion of the track, click on Set Import Times button or double-click on the track in the list. The Audio CD Import Options dialog will appear.

4. In this dialog that appears, select the desired sample rate, resolution, and format. By adjusting the Start and End time controls at the bottom of this dialog you can import the entire CD track, or just specific portion of the track. The slider in this dialog assists you in locating start and end times. Click Play to audition the CD track (or selected portion of the CD track). Click OK when you are happy with the selection.

5. Click the Import button in the Import CD Audio dialog to import the selected tracks and the Save dialog appears. Use the pop-up menu at the top of the dialog to navigate to the hard drive where you wish to save the audio file. Click Save to save the file(s) to disk. Peak will saves the file(s) in the AIFF audio format.

---

**Import Dual Mono**

The Import Dual Mono command lets you import two mono files and create an interleaved stereo file. Certain audio applications, such as BIAS Deck and Digidesign’s Pro Tools do not directly support stereo interleaved files, and instead use “dual mono” files, which comprise the right and left channels of stereo material. Peak allows you to open such dual mono files, and in the process creates a new stereo audio document. Because Peak actually writes a new stereo audio file to disk, this conversion process requires hard disk space equivalent to the two original mono files.

**To open a dual mono file:**

1. Choose Import Dual Mono from the File menu.
2. In the dialog that appears, locate the desired files.
3. Select either half of the dual mono file and click Open. Peak imports the first file and then prompts you for the second.
4. Select the second audio file and click Open. When Peak has finished creating the new stereo audio document you can begin editing.

**LE** Import Dual Mono is not available in Peak LE.

**Export Dual Mono**

The Export Dual Mono command allows you to save a stereo audio document as separate mono digital audio documents. This feature is convenient if you intend to use the audio document in a multitrack audio application, such as BIAS Deck or Pro Tools, which does not directly support stereo audio files. When you choose this command Peak will prompt you to name both the left and right sides with a Save dialog. If you intend to use the exported audio with a Digidesign application, you should save it in either the AIFF or Sound Designer II format. The Sound Designer II format is Digidesign’s native audio file format.

**Export Regions**

If you have placed markers or Regions in an audio
document, Peak’s Export Regions command allows you to save each of these regions as a separate audio document. This feature is very convenient if you wish to divide a larger file into regions and transfer them as samples into a sample playback instrument, or divide a live concert record into regions and export those regions as separate files. Furthermore, you can use Peak’s Batch File Processor to process a file’s regions with any of Peak’s DSP functions and third party plug-ins during the automatic exporting of regions into new files.

**To export regions from an audio document:**

1. Select the regions that you wish to export. (You can use the Tab key, Shift-Tab, or if you wish to select the entire document, press ⌘-A.)

2. Choose Export Regions from the File menu.

3. In the Export Regions dialog, choose the parameters that you wish to use for selecting the regions to export using the region detection options to choose which regions are to be exported.

4. Using the Output Format options, choose the format and resolution you wish for the exported regions.

5. Using the Output Directory options, choose the destination for the exported regions. If you wish the newly exported regions to appear as new open Peak documents, choose Output to new windows.

8. To save the exported regions to disk, select Save To Disk and choose whether you would like to save the regions into the same folder as the source files, or to a different folder. If you prefer to save to a new folder, use the Set Path button.

9. To export the regions, click Begin. Peak exports each of the regions into its own audio document.

**Export as Text...**

If you wish to keep a text record of your playlist, you may export the playlist into a new text document. The text document will show the playlist events, times, crossfade times, and gain levels.

**To export a playlist as text:**

1. Open the playlist document you wish to save as a text file.

2. Choose Export as Text from the File menu. The Save dialog appears.

3. Enter a name to save the text file under and a location to store the file, and click Save.

**Batch Processor...**

Peak’s Batch File Processor is one of the most powerful, versatile, and useful features in Peak. Using the Batch File Processor, you can integrate any series of Peak processes (called a batch script), and apply these scripts to any number of audio files.
To use Batch File Processing, go to the File menu and select Batch Processing. The Batch File Processor dialog appears.

### Batch File Processor

Peak’s Batch File Processor is split into three areas: Input, Process, and Save Changes. Sequence a series of steps for Peak to execute in the Process section, then set your output file settings in the Save Changes area. Once Peak’s Batch File Processor is configured, you may turn on the Batch File Processor in the Input area.

Once the Batch File Processor is configured and turned on, any files you drop onto the Peak application’s icon (or an alias) will be batch processed according to your settings. You can even drop folders or disks onto Peak’s icon and all of the supported audio contents will be batch processed. You can continue to dropping files, folder, or disks, onto the Peak icon for batch processing while the Batch File Processor is turned on. All subfolders within folders or disks you drag onto the Peak application for Batch File Processing will be recreated in the Batch File Processor’s output directory, preserving all organization of your files. Audio documents opened using the Open command from the File menu will not be batch processed.

**LE** Batch File Processor is not available in Peak LE.

### Recently Opened Documents

Peak automatically remembers the last several audio documents or playlists that you have opened and keeps a list of these at the bottom of the File dialog. This allows you to easily select a document’s name and reopen it without having to search for it on your hard drive. Peak can find and open a document even if you have changed its location on your hard drive, too. And if you change the name of the file, the next time you open Peak, Peak will automatically update the name in its internal list.

**Recently opened documents are listed at the bottom of the File menu**

### Quit

The Quit command (⌘-Q) quits the Peak application. If you haven’t saved changes to a currently open audio document, Peak will prompt you to do so before quitting.
Edit Menu

This menu contains all of the standard Macintosh commands for cutting, copying, and pasting as well as several additional commands specific to Peak.

<table>
<thead>
<tr>
<th>Edit</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Y</td>
</tr>
<tr>
<td>Edits...</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td>X</td>
</tr>
<tr>
<td>Copy</td>
<td>C</td>
</tr>
<tr>
<td>Paste</td>
<td>V</td>
</tr>
<tr>
<td>Replace</td>
<td></td>
</tr>
<tr>
<td>Insert</td>
<td></td>
</tr>
<tr>
<td>Insert Silence...</td>
<td></td>
</tr>
<tr>
<td>Silence</td>
<td>E</td>
</tr>
<tr>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td>Delete except Audio</td>
<td></td>
</tr>
<tr>
<td>Crop</td>
<td></td>
</tr>
<tr>
<td>Clear Clipboard</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td>A</td>
</tr>
<tr>
<td>Insertion Point at Selection Start</td>
<td></td>
</tr>
<tr>
<td>Insertion Point at Selection End</td>
<td></td>
</tr>
<tr>
<td>Set Selection...</td>
<td></td>
</tr>
<tr>
<td>Select Loop</td>
<td>-</td>
</tr>
<tr>
<td>Previous Selection</td>
<td>-r</td>
</tr>
<tr>
<td>Next Selection</td>
<td>-t</td>
</tr>
</tbody>
</table>

The Edit Menu

Undo

The Undo command (⌘-Z) undoes the last action that you performed. Since Peak features unlimited undo and redo capability, repeatedly choosing this command will undo each action that you have performed on your audio document. If you wish, you can continue undoing actions until you return to the original state of the audio document. When there are no actions left to undo, the Undo command will be unavailable and appear grayed out.

Redo

The Redo command (⌘-Y) “undoes” the undo command. If you wish, you can continue redoing actions until there are no items left to redo. In this case, the Redo command will be unavailable and appear grayed out. The only limitation in using the Redo command is that if you insert a new action when a redo action is available, you will no longer be able to redo. In other words, as soon as you perform an editing action other than Undo, Redo is no longer available.

Edits...

The Edits command provides you with a second unique and powerful “unlimited undo” feature. You can think of the Edits command as a kind of “random access” undo with a list of all your editing actions since you last saved. Using this list, you can navigate back in time to the point at which you performed a particular edit, and if you wish, undo it. Once you have returned to an earlier state in the project, you are free to start editing from that point on, if you wish.

Be aware that if you do go back to a past action and perform a different action at that state in the project, any edits that originally followed will be gone and you won’t be able to redo them.

The Edits dialog

Cut

The Cut command (⌘-X) cuts selected data from an audio document and a copy of it on Peak’s Clipboard. Once you have cut a portion of an audio document, you can paste it or insert it at another location on the same document or a different document.

Copy

The Copy command (⌘-C) copies selected audio in
Peak’s Clipboard. Once you have copied a portion of an audio document, you can paste it or insert it at another location the same document or a different document.

**Paste**
The Paste command (⌘-V) allows you to paste the contents of the Clipboard into a location that you choose by placing an insertion point. Pasting audio deletes any selected audio and inserts the clipboard audio at the insertion point.

**Replace**
The Replace command allows you to paste audio over existing audio—to paste audio into an audio document without pushing all data to the right of the insertion point farther to the right (later in time) to accommodate the newly pasted audio.

**Insert**
The Insert command (⌘-D) allows you to paste audio into an audio document without overwriting any existing data at the insertion point. When you paste data with the Insert command, all audio to the right of the insertion point or selection start is pushed farther to the right (later in time) to accommodate the newly pasted audio.

**Insert Silence**
The Insert Silence command allows you to insert a specific amount of silence into an audio document at the current insertion point. When you choose this command, Peak will prompt you to enter the amount of silence you wish to insert. You can enter this value in samples, milliseconds, or seconds. All audio occurring after the insertion point is moved later in time by the amount of the silence that you insert.

**Silence**
The Silence command (⌘-E) replaces the selected audio in the audio document’s selection with silence.

**Delete**
The Delete command (the Delete key) allows you to cut an audio selection without transferring it to the Clipboard.

**Delete Except Audio**
The Delete Except Audio command (Option-Delete) allows you to easily remove all markers, region markers and loops in the current audio document selection without removing the audio.

**Crop**
The Crop command (⌘-`) allows you to remove all other audio from the audio document except the selection.

**Clear Clipboard**
Peak utilizes a portion of your hard disk’s free space to hold audio that has been cut or copied. The Clear Clipboard command allows you to free up disk space occupied by the contents of the clipboard if you no longer need the audio contained there.

**Select All**
The Select All command (⌘-A) selects all audio in the audio document.
**Insertion Point at Selection Start/End**
The Insertion Point at Selection Start command (Up Arrow) places the insertion point at the beginning of a selection. The Insertion Point at Selection End command (Down Arrow) places the insertion point at the end of a selection.

**Set Selection**
The Set Selection command allows you to precisely edit the length, start and end times of an audio selection by entering numerical values on the Set Selection dialog. Use the Units pop-up menu at the top of the dialog to select the time units you want, and use the radio buttons to select whether you want to affect the Start or End of the selection.

![The Set Selection dialog](image)

**Select Loop**
The Select Loop command (**) will automatically select the audio within the loop start and loop end markers, if you have defined a loop in a document.

**Previous Selection/Next Selection**
If you have made a selection in an audio document, then made another selection, you can use Previous Selection (Left Arrow) to jump back to the previous selection. You can then use Next Selection (Right Arrow) to jump ahead again. This works for multiple selections.

---

**Action Menu**
This menu provides several commands for zooming in and out of the audio document window, creating loops, markers and regions, and navigating to specific locations in an audio document.

![Action Menu](image)

**Zoom Out**
The Zoom Out command (\[) zooms the waveform view out allowing you to see more of the entire waveform, but in less detail. The Zoom Out command is useful for obtaining a better “big picture” view of audio material. To zoom progressively out from a waveform, select this command repeatedly or press \[ repeatedly on your computer keyboard.

**Zoom In**
The Zoom In command (\]) zooms the waveform view in so that you can view audio data in greater detail. The Zoom In command is essential when you wish to select and edit audio with great precision. To view a waveform in progressively greater detail, select this command repeatedly or press \] repeatedly on your computer keyboard.
your computer keyboard. Holding down the Option key while you make a selection will zoom the waveform view in so that your selection fills the audio document window after you release the mouse button.

**Increase Vertical Zoom**

The Increase Vertical Zoom command (Control-Up Arrow) makes the waveform “taller,” or increases the vertical zoom. The Increase Vertical Zoom command is useful for obtaining a better “big picture” view of quieter audio material.

**Decrease Vertical Zoom**

The Decrease Vertical Zoom command (Control-Down Arrow) makes the waveform “shorter,” or decreases the vertical zoom.

**Fit Selection**

The Fit Selection command (Shift-[]) will zoom the view so that your selection fills the audio document window.

**Zoom Out All the Way**

The Zoom Out all the way command (Shift-[]) zooms the audio document window to show an overview of the entire audio document.

**Zoom at Sample Level**

The Zoom at Sample Level command (Shift-Left Arrow) zooms the audio document window to the single-cycle level, allowing you to view the waveform a single sample at a time. This is useful for drawing on the sample with a pencil tool, or fine-tuning loops and markers.

**Zoom at Sample Level (End)**

The Zoom at Sample Level (End) command (Shift-Right Arrow) zooms the audio document window to the single-cycle level and places the insertion point at the end of the audio selection.

**Snap Selection to Zeros**

The Snap Selection to Zeros command will cause the beginning and end of the current selection to move to the nearest zero-crossings.

**Loop This Selection**

The Loop This Selection command (Shift-“.”) automatically creates a loop from the current selection by placing loop markers on either side of the selection. Since Peak supports a single loop per audio document, choosing this command in a document with a loop already defined will cause the loop markers to move to the current selection.

**Nudge Loop Backward**

The Nudge Loop Backward command (Option-Left Arrow) pushes, or “nudges,” the loop point backward. This allows you to fine-tune the loop.

**Nudge Loop Forward**

The Nudge Loop Forward command (Option-Right Arrow) pushes, or “nudges,” the loop point forward. This allows you to fine-tune the loop.

**New Marker**

The New Marker command (M) creates a new marker at the current insertion point in an audio document. Markers are locations in an audio document that you define as important. By marking specific locations in a recording, you can navigate easily to a location for selection, editing or playback purposes.

Once you have defined a marker, you can assign or edit a number of its attributes with the Edit Marker dialog that appears when you double-click the marker. This dialog and the attributes contained within are explained in Chapter 5: Editing.
The New Region command (Shift-⌘-R) defines a selection as a new region and adds it to the Regions menu. Locate a region by double-clicking the name of a Region in the Contents Palette. The audio document will automatically scroll to display the selected region, and the region will become the current selection in the audio document. For more detail on using Regions in Peak, see Chapter 6: Playlists & CD Burning.

Markers to Regions

The Markers to Regions command will convert any markers in a selection to Regions. If you make a selection containing two markers, they will be converted to one Region with the name of the first marker. If you make a selection containing three or more markers, the markers will be converted to contiguous, butt-spliced Regions. For example, if you have three markers named “Foo 1”, “Foo 2”, and “Foo 3” and select them and apply Markers to Regions, the resulting two regions will be named “Foo 1” and “Foo 2”—wherein the first marker has become the begin Region marker of Region “Foo 1”, the second marker has become the end Region marker of Region “Foo 1” and the begin Region marker of “Foo 2”, and the third marker has become the end Region marker of Region “Foo 2”.

Alternatively, hold down the option key down when selecting the Markers To Regions command to make each marker a region that ends at the next marker.

Nudge

The Nudge command allows you to nudge all marker, loops and regions in the current audio document selection by the number of seconds entered in the Nudge Markers dialog. Type either positive or negative numbers, and Peak nudges the marker by the value you entered in the dialog.
**Go To**

The Go To command (⌘-G) allows you to quickly and precisely navigate to the start or end of a selection, the start or end of a loop, a specific marker, or a specific time location in an audio document. This command is essential for speedily locating any of these important locations in an audio document. Choosing the Go To Time command allows you to enter the exact time location that you wish to navigate to. In addition, the Location submenu lists all markers, regions, and loops.

The Go To Time dialog

In addition, the Location submenu lists all markers, regions, and loops.

**Loop Surfer**

Peak’s Loop Surfer feature (⌘-J) automates some of the steps for setting up loop points. Loop Surfer allows you to “Loop Surf” (adjust your loops during playback) quickly, easily and in a musically intuitive manner.

If you’re working with music, and know the music’s tempo in beats per minute, you can use Loop Surfer to create a loop which lasts for a rhythmically “correct” length of time. For more detail regarding Loop Surfer, see Chapter 5: Editing.

**Guess Tempo**

If you are working with music and don’t know the tempo—and your music has a relatively pronounced or obvious beat—you can use the Guess Tempo command to have Peak automatically guess the tempo of a selection. Make a selection and choose Guess Tempo from the Action menu. There will be a pause while Peak scans your selection and calculates the tempo for you. A dialog will then appear showing you the estimated tempo in BPM, or beats per minute. You can then enter the estimated tempo in BPM in the Loop Surfer dialog’s Tempo field or in the Audio Information dialog’s Tempo field or press the Loop It button to create a loop at the current insertion point with the detected BPM.

**LE** Loop Surfer is not available in Peak LE.
**Audio Menu**

The Audio menu contains commands for playing back and recording audio, as well as configuring your audio hardware, SMPTE settings, and Peak’s audio Meters.

### Rewind

The Rewind command places the insertion point at the beginning of the audio document.

### Play

The Play command (Spacebar) starts playback of the audio file from the insertion point.

### Play Selection

The Play Selection command (Option-Spacebar) plays only the selected portion of an audio document.

### Play w/Auditioning

The Play w/Auditioning command (Option-Spacebar) plays the selected portion of an audio document with pre-roll and post-roll. The pre-roll and post-roll times are designated in the Auditioning dialog under the Preference menu.

### Pause

The Pause command pauses playback. The Spacebar can be used to pause playback.

### Stop

The Stop command stops playback. The Spacebar or the Return key can both be used to stop playback.

### Stop & Extend Selection

The Stop & Extend Selection command (Shift-Spacebar) stops playback and extends any selection from the point at which playback was initiated. The Stop & Extend Selection command can also be used to start playback from the insertion point or selection start.

### Fast-Forward

The Fast-Forward command places the insertion point at the end of the audio document.

### Record

The Record command (Option-R) opens the Record window. This window allows you to start and monitor recording.

When you select Record from the Audio menu (Option-R) or Toolbar, the Record dialog appears. There are transport buttons—Record Settings, Pause, Stop, and Record—along the bottom, an Audio Source display that shows you the waveform as it is being recorded, and a Notepad window. There are also text displays showing you the sample rate, bit depth, and number of channels you selected in the Record Settings dialog, as well as the amount of time you have available to record on the selected Record Disk with the recording settings you have chosen.
The Record Settings dialog

You will notice several pop-up menus, buttons, and checkboxes in the Record Settings dialog. These allow you to select which hard drive to record to, what file format you’d like to record in, sampling rate, source input, and so on. You may also wish to record in real-time through your Premiere or VST audio plug-ins. The next few paragraphs describe how to set all of these parameters using the Record Settings dialog.

Record Disk

The Record Disk pop-up menu allows you to choose which hard drive you would like to record to. If you have more than one hard drive connected to your Macintosh, use this pop-up to select your record drive. (This option will default to the largest drive currently available to your Macintosh unless you select otherwise.)

File Format

The File Format pop-up menu allows you to select the file format for the incoming audio. You can choose from AIFF or Sound Designer II. (If you need the newly recorded audio file to be in a different format, you can always use the Save As... function. To save it as a another format once recording is complete.) If you do not select a file format for recording, Peak will default to 44.100kHz 16-bit stereo.
**Auto Gain Control checkbox**

The Auto Gain Control checkbox allows you to disable the Automatic Gain Control feature used by the Sound Manager with some Macintosh microphone inputs. Auto Gain Control adjusts input gain automatically to get maximum recording levels. If the recording device you are using supports this feature, you can check the Auto Gain Control checkbox if you want to turn this feature on.

**Monitor checkbox**

The Monitor checkbox allows you to monitor the audio recording source while you are recording.

**Split Stereo Files checkbox**

The Split Stereo Files checkbox allows you to record the incoming stereo audio as dual mono files rather than a single stereo file. Dual mono files are used in programs like Digital Performer, Pro Tools, or BIAS Deck, so this option is useful if you need to record dual mono files (i.e., split stereo).

**Append to document checkbox**

The Append to document checkbox allows you to record into an existing audio document. To record into an existing audio document, place the insertion point in the existing audio document at the point where you want to insert the new audio. If the insertion point is at the beginning of the file, the newly recorded audio will be inserted at the beginning of the file. If the insertion point is at the end of the file, the newly recorded audio will be appended to the end of the existing file. If the insertion point is somewhere in the middle of the file, the newly recorded audio will be inserted at that point. If you make a selection, the Append to document feature will allow you to replace the selection with newly recorded audio from the beginning of the selection through the end of the selection or wherever you stop the recording.

**Record timer... checkbox**

The Record timer... checkbox allows you to designate a specific duration for recording. Peak will stop recording after this set time and bring up the Save dialog for your audio recording. Checking the Record timer... checkbox will bring up the Recording Time dialog. In the Recording Time dialog, designate the duration for recording in seconds and click OK.

**The Recording Time dialog**

**Device and Sample Format...**

Clicking on the Device and Sample Format button brings up the Sound dialog. This dialog contains a pop-up menu that brings up three sub-dialogs, and, on the right side of the dialog, a Speaker select pop-up, Volume and Gain controls, and an audio input level meter.

**The Sound dialog: Compression**

**Compression**

⚠️ The compression option is not supported in Peak yet, so leave Compression set to none.
The Sound dialog: Source

Source
Selecting Source from the Sound dialog pop-up menu allows you to select and configure the audio input you wish to use for recording. If you have a third-party audio card installed in your Macintosh, you can select it as the input device using the Device pop-up. Use the Input pop-up to select the audio device you wish to record through.

Once you have configured the options in the Sound dialog to your liking, click OK to return to the main Recording Options dialog.

Hardware Options
Clicking on the Hardware Options button in the Record Settings dialog brings up a dialog for the audio hardware you selected in the Source dialog. Note that in many instances there may be no settings for a given device (including the Apple Built-In Sound!). Some sound card’s drivers have control panels or utility applications that will launch when you click on the Hardware Options button. The actual third-party dialog will differ depending on the type of audio card you have.

Record Through Plug-In
If you have Premiere-format or VST compatible audio plug-ins installed in your Peak Plug-Ins or VstPlugIns folder(s), you can record through them in real-time. This is useful if you want to use a noise reduction, equalizing, or dynamics plug-in during recording.

Sample
Selecting Sample from the Sound dialog pop-up menu allows you to choose the sample rate and bit rate, as well as whether the incoming audio will be recorded as a Stereo or Mono file. To some degree, the choices that appear here will depend on your audio hardware. Possible sample rates are as follows:

48.000kHz This is one of two standard sample rates for digital audio tape (DAT) recorders, and is often used by sound editors working in audio post-production for video or film.

44.100kHz This is the standard sample rate for Compact Discs, digital audio tape (DAT) recorders, and high-fidelity audio applications on Macintosh and PC-compatible computers with 16-bit playback capability. Most sound engineers working in music production—or anything that may be distributed on a CD—work at “forty-four one.”

22.050kHz & 11.025kHz These sample rates are often used for lower-fidelity audio playback on Macintosh and PC compatible computers that have 16-bit playback capability. Many games and other multimedia productions utilize 22.050kHz 16-bit or 8-bit audio, since it uses one-quarter of the disc space of CD-quality audio. 22.050kHz 16-bit is the Shockwave audio standard.

16-bit is the current Compact Disc standard for professional-quality recordings.

8-bit is often used for computer-based and web-based multimedia and games.
For complete instructions on recording audio in Peak, please see Chapter 4.

**SMPTE Sync**

The SMPTE Sync... command is used to synchronize playback with an external SMPTE/EBU device, use the SMPTE Sync... dialog under the Audio menu. Enter the SMPTE/EBU time for the audio to begin playback in the time field. Choose the MTC sync device (such as a Studio/5 MTC source from Opcode) under the Sync Device pop-up menu and press OK.

When the SMPTE/EBU time is received by Peak, playback of the audio document will commence. As the SMPTE frames are received, Peak will adjust the playback rate and position to chase the SMPTE/EBU time code source.

⚠️ **SMPTE Sync requires Opcode’s OMS, which can be downloaded for free from:** http://www.opcode.com

**Arm External Sync**

The Arm External Sync command enables Peak to receive external sync.

**Hardware Settings**

The Hardware Settings command brings up a dialog for the audio hardware you selected in the Source dialog. Note that in many instances there may be no settings for a given device (including the Apple Built-In Sound!). Some sound card’s drivers have control panels or utility applications that will launch when you choose Hardware Settings. The actual third-party dialog will differ depending on the type of audio card you have.

**Meters**

The Meters command opens the Meters dialog, which allows you to configure the Meters display. Using the Meters dialog, you can select the Peak Hold time, Clip Indicator Hold Time, and also configure the MIDI Meters. The Peak Hold indicators appear as yellow bars at the far right of each of the bar graphs, and selecting a hold time causes the indicator to pause for easy reading of the peak value during playback. The Clip Indicators appear as red bars at the far right of each of the bar graphs, and are triggered when audio distorts, or “clips”, and selecting a hold time causes the indicator to pause for easy reading of any clipping or distortion that occurs during playback. Setting the Peak Hold and Clip Indicator Hold Times to None turns these features off.
DSP Menu

This menu contains Peak’s DSP-based audio processing and advanced editing tools. A complete description of Peak’s DSP functions and instructions on how to use them are given in Chapter 6 of this User’s Guide.

Add

The Add command adds any selection of audio copied to the clipboard into the audio document at the selection point. To use the Add command, you must first copy a selection of audio. The copied material can then be mixed into the target audio material.

Amplitude Fit

Amplitude Fit provides granular normalization of an audio selection on a grain-by-grain basis. Grains are small groups of samples, often around 30ms. As each grain is read in, it is normalized according to the Amplitude Fit Envelope—each normalized grain crossfaded with the previous grain and written out as the result. Amplitude Fit can be used to maximize the volume level of an audio selection, or to make quiet passages as loud as louder passages.

The Add dialog

LE Add is not available in Peak LE.

The Amplitude Fit Envelope editor

LE Amplitude Fit is not available in Peak LE.
Change Duration

The Change Duration command allows you to slow down or speed up the selected material by a specified amount without changing its pitch. You can specify the change in duration by a value in seconds, a percentage of the original, or, for rhythmically-oriented material, beats per minute. A change in duration by a reasonable amount, about 85% to 115%, can be very convincing. Exaggerated time stretching, 200% or more, can result in some very interesting granular textures. Try experimenting with the Change Duration function on drums, rhythm loops, speech, sampled instruments or sound effects to achieve a wide variety of useful effects.

Change Gain

The Change Gain function changes the gain (i.e., amplitude) of a selection. You can specify the amount of gain change either in decibels (dB) or as a percentage. If you wish to double the volume of a sound, you must apply approximately 6dB of gain change, or add 200%. Enable the Clipguard checkbox in the Change Gain dialog to protect against the possibility of clipping. Clipguard will search through the audio document or selection for the maximum peak in amplitude, and then limit the Change Gain slider’s range based on the maximum peak it finds in the audio document or selection.

LE Change Duration is not available in Peak LE.

Change Pitch

Peak’s Change Pitch function allows you to alter the pitch of an audio selection by as much as an octave. The Change Pitch dialog uses a pitch slider that allows you to choose a new pitch by musical interval, and “fine tune” the pitch change by smaller increments called “cents.” (Cents are divisions of a musical octave—one octave is equivalent to 1200 cents—thus, 100 cents is a semi-tone, 50 cents a quarter-tone, etc.) You can also choose to alter the length, or duration, of the selection just as you would by slowing down or speeding up analog tape, or you can choose to preserve the duration of the selection (something not possible with analog tape!). You can even preview the pitch change by clicking on the Play button at the bottom of the Change Pitch dialog.
**Convert Sample Rate**

The Convert Sample Rate command allows you to change the sample rate of a sound without changing its pitch. This feature is very useful for converting audio material into lower or higher sample rates as required by other applications. Please note that sample rate conversion is applied to an *entire* document. It cannot be applied to just a selection within a document. Refer to Chapters 3 and 4 for an explanation of commonly used sample rates.

**Convolve**

The Convolve command is a unique and powerful sound design tool that allows you to apply the sonic (e.g., spectral) characteristics of one sound onto another. Convolution works by multiplying the frequency spectrum of the *impulse* contained in the clipboard and that of the target audio document, reinforcing the frequencies that are in common between the two. To use the Convolve DSP command, you must first copy a selection of audio. The copied material will provide the spectral “character” that you will apply to the target audio material.

**LE** Convolve is not available in Peak LE.

**Crossfade Loop**

The Crossfade Loop function applies a “smoothing” effect to loops made in Peak audio documents. Crossfade Loop fades the end of the loop into the beginning of the loop to make the loop sound smoother. (It uses the Blending envelope you’ve set in Peak’s Preference menu’s Blending... dialog.) Use the Crossfade Loop dialog to select the length of the crossfade in milliseconds.

**LE** Crossfade Loop is not available in Peak LE.

**Dither**

Dither... allows you to use Waves IDR™ noise shaping and dithering, built-in to Peak. Typically you would pick your destination dithering bit-depth, click OK, then save to that bit-depth. The IDR available in Peak contains a fixed type of dither (type 1), and a fixed amount of noise shaping (normal mode for sample rates over 32Khz, moderate mode for sample rates under 32kHz, no noise shaping below 22Khz).

**Invert**

The Invert function allows you to invert the phase of a selection or an entire audio document.

**Fade In & Fade Out**

The Fade In and Fade Out commands allow you to apply an amplitude envelope to an audio selection.
The Fade In and Fade Out DSP commands, and the Fade Envelope Editor dialog are described at length in Chapter 5.

**Find Peak**

The Find Peak operation will place the insertion point at the sample with the maximum amplitude value that it locates in the audio selection.

*LE* Find Peak is not available in Peak LE.

**Gain Envelope**

The Gain Envelope operation allows you to enter an amplitude envelope to be applied to an audio selection. The selected audio’s amplitude will be boosted and/or attenuated according to the envelope you draw in the Gain Envelope editor.

![The Gain Envelope dialog](image)

**Loop Tuner**

Peak’s Loop Tuner provides a way to visually line up the start and end points of your loop and listen to the effects of these adjustments as you make them. The waveform display in the Loop Tuner dialog shows the Start and End points of the loop, which you can visually adjust with the scroll bars at the bottom of the window to achieve a natural transition at the loop point by carefully adjusting the slope alignment. The arrows of the slider will move the loop markers sample by sample and clicking in the body of the slider will move the loop markers to the next zero crossing. The two zoom buttons—magnifying glass icons—in the upper left of the Loop Tuner dialog allow you to adjust the vertical zoom up of the waveform. The two zoom buttons in the lower left hand corner of the Loop Tuner dialog allow you to adjust the zoom view in and out all the way down to the sample level. You can listen to the effects of the adjustments as you make them by clicking on the Play button. To exit this dialog, click on OK to accept the changes, or Cancel to leave the original loop unaffected.

*LE* Loop Tuner is not available in Peak LE.

**Mono To Stereo/Stereo To Mono**

These two DSP commands may be used to easily convert an audio document between one and two channel formats.

*Mono to Stereo Conversion dialog*
Stereo to Mono Conversion dialog

Mono To Stereo/Stereo To Mono is not available in Peak LE.

Mix
The Mix command allows you to mix material that you have copied to the clipboard with a target selection. This function can be used as a kind of “sound-on-sound” capability for mixing audio tracks together, or for blending sound elements. The Mix command is similar to the Add command, but it does not have the potential to clip because the target and clipboard contents are attenuated before mixing. To use the Mix command, you must first copy a selection of audio. The copied material can then be mixed into the target audio material.

Modulate
This Modulate command functions as a “ring modulator” which multiplies two audio signals together (e.g., the material copied to the clipboard and the currently selected audio). The resulting audio includes the sum and difference tones of the frequency components of the modulated audio and the modulating audio. These are generally very complex timbres that often have a “metallic” (i.e., inharmonic) character to them.

Normalize
This command allows you to optimize the volume of a selection or an entire audio document so that it is at its maximum possible amplitude without clipping. The normalize function is very useful for boosting the volume of material that was recorded at too low a level, or if used on multiple audio documents, for making sure that the amplitude of each of the documents is uniform.
Panner

The Panner allows you to adjust the panning, or left-to-right movement, of a stereo document by drawing an envelope in the Panner dialog. Left is at the top of the graph, and right is at the bottom.

Phase Vocoder

The Phase Vocoder is a type of audio spectrum analysis/resynthesis that allows you to modify the duration and/or pitch of an audio selection.

Rappify

The Rappify command applies extreme dynamic filtering to a selection. As one Peak user described it, "Rappify can turn your hi-fi into lo-fi!" If the target material has a pronounced beat, this has the effect of reducing the material to its most essential rhythmic components. Try using this function with a variety of different music material for some surprising and exciting results.
**Repair Click**

The Repair Click command will eliminate a selected click or “spike” in the waveform using the setting designated in the Repair Clicks dialog (explained next).

*LE* Repair Click is not available in Peak LE.

**Repair Clicks**

The Repair Clicks command allows you to find and repair pops or clicks in an audio document. The Repair Clicks dialog automates the process of finding and removing clicks (usually indicated by a sharp “spike” in a waveform), much like a search and replace dialog in a word processor.

The Repair Clicks operation works by looking for discontinuities from sample to sample. For example, a sample value of -100 followed by a sample value of 10,000 is likely to be a click. Once the area of the click is identified, a smoothing technique is used to maintain the original shape of the area being repaired.

If you are working with mostly digitally induced clicks, the Repair Clicks dialog will become an indispensable tool. Extremely damaged signals such as those of a scratching and popping vinyl record will require more careful repair in addition to using the Repair Clicks dialog, such as Change Gain, Delete, and the Pencil Tool. Clicks such as those of a scratching and popping vinyl record lose their detectability once they are sampled using Analog to Digital converters.

---

**Smoothing Factor**

Smoothing Factor determines how much smoothing is applied to the click. Material with high frequency information may require lower smoothing factors to preserve the high frequencies. In general, a setting of 40-60 percent will repair most clicks.

**Detection Setting**

The Detection Setting value determines how the clicks are located. Higher values locate only the most severe clicks, while lower values will detect less severe clicks. Note that lower values such as 10% also have a greater chance of misjudging audio for a click. In general, a setting of 40-80% works well.

**Repair Size**

The Repair Size setting affects how many samples around the click are used in determining the new shape of the repair. Repair size can vary from 5 to 100 samples, with a repair size of 50 samples working well in most circumstances. Peak will then interpolate what the correct waveform should be, and repair the click.

Buttons along the bottom of the Repair Clicks dialog allow you to control repairing, auditioning, and undoing click repairs:

- Click the Repair button when you wish to repair a click found by the Next Click button.
- Use the Next Click button to search for the next potential click in the audio selection.
- Once a click is located, you may listen to the click using the Audition button. The Audition button plays the click using the Pre-roll and Post-roll settings from the Auditioning... dialog under the Preference menu.
- If you repair a click and are unsatisfied with the results, simply click on the Undo button.
- If you would like to repair all of the clicks in the audio document’s selection without having to repair each one individually, click the Repair All button.

You may need to lower the detection setting in the Repair Clicks dialog to find some clicks, depending upon their severity. Be careful not to lower the
detection setting dramatically — lower it gradually for the best results.

**LE** Repair Clicks is not available in Peak LE.

### Remove DC Offset

This function allows you to remove any DC Offset in your audio file. Peak scans the audio for DC offset and then removes it. Peak will scan the left and right channels of a stereo file independently. DC Offset is usually caused by problems in the analog to digital conversion process. The result is that the waveform is not centered on the base line—it is offset either higher or lower than the center line. The Remove DC Offset function is particularly useful for preparing audio for processing with the RealAudio Encoder.

**LE** Remove DC Offset is not available in Peak LE.

### Reverse Boomerang

The Reverse Boomerang command mixes a reversed copy of the selected audio with the original. This creates a variety of interesting and useful results. Try using Boomerang on drum loops, voice, and sound effects.

The Reverse Boomerang dialog

### Reverse

The Reverse command reverses the current selection. In a reversed selection, the last sample becomes the first sample, the second-to-last sample becomes the second sample, and so-forth. The effect is similar to playing a record or cassette tape backwards.

### Swap Channels

The Swap Channels command reverses the left and right channels in a stereo selection.

**LE** Swap Channels is not available in Peak LE.

### Threshold

The Threshold command allows you to split up an audio document into its component parts by analyzing the amplitude levels in the audio document and setting a cutoff or threshold amplitude. For instance, you might use the Threshold command on an audio document that contains successive notes from a musical instrument to split them up, or on a drum loop to break it up into its component parts. You can save the segments with Markers, or as Regions.

See Chapter 7: DSP for more info on using the Threshold command.

Threshold is not available in Peak LE.
Sampler Menu

This menu allows you to import samples directly from compatible samplers, edit or process the audio using all of Peak’s functions, and send the modified sample back to the sampler. Peak supports SMDI, Ensoniq, Roland and AKAI samplers. A complete description of how to use this feature is given in Chapter 11 of this User’s Guide.

Send to Sampler
The Send to Sampler command will send the previously received sample from Peak to your sampler using the Sampler dialog in Peak (AKAI, SMDI, MIDI SDS, etc.) depending on the how the sample was previously received from the sampler.

Revert from Sampler
The Revert from Sampler command will revert to the previously received sample from Peak to your sampler using the Sampler dialog in Peak (AKAI, SMDI, MIDI SDS, etc.) depending on the how the sample was previously received from the sampler.

Send All to Sampler
The Send All to Sampler command will send all previously received samples from Peak to your sampler using the Sampler dialog in Peak (AKAI, SMDI, MIDI SDS, etc.) depending on the how the samples were previously received from the sampler.

Revert All from Sampler
The Revert All from Sampler command will revert all previously received samples from Peak to your sampler using the Sampler dialog in Peak (AKAI, SMDI, MIDI SDS, etc.) depending on the how the samples were previously received from the sampler.

AKAI Sampler

The Akai sampler dialog

Direct support for AKAI samplers in Peak makes it easy for you to transfer samples back and forth between Peak and your AKAI sampler. Supported AKAI samplers include the S1000, S1100, S2000, S2800, S3000, S3000XL, S3200, S3200XL, CD3000, and CD3000XL. Peak will also transfer loop information along with sample data.

Ensoniq Sampler Transfer

Owners of Ensoniq Samplers will find the Peak Ensoniq Sampler dialog an indispensable tool for transferring samples between the Macintosh and an
Ensoniq Sampler. The Ensoniq Sampler dialog provides several operations beyond wavesample transfer, including instrument, layer and wavesample renaming, creation, and deletion. See Chapter 10 for a full description of this dialog.

The Ensoniq Sampler dialog

**Roland S-760 Sampler**

Direct support for the Roland S-760 in Peak makes it easy for you to transfer samples back and forth between Peak and your S-760 sampler. Peak will also transfer loop information along with sample data. See Chapter 10: Samplers for more information.

The Roland S-760 sampler dialog

**E-mu, Ensoniq ASR-X, Kurzweil, Peavey, Yamaha Sampler**

A large number of samplers support SMDI sample transfer. Choosing the name of your SMDI sampler from the Sampler menu will open the SMDI Sampler dialog.

**SMDI Sampler**

SMDI Samplers, such as the Kurzweil K2500 or the E-mu E-IV, use SCSI to transfer samples between devices. SMDI is substantially faster than MIDI for transferring sample data. In order to transfer samples between the Macintosh and your sampler using SMDI, you must connect a SCSI cable between your Macintosh and the sampler. Consult your sampler’s owner’s manual for instructions on how to connect the cable to your Macintosh with proper termination. See Chapter 10: Samplers for more information.

The SMDI Sampler Transfer dialog

**MIDI SDS**

A large number of sampling instruments and older sampling instruments support transferring samples between samplers or computers using a method called MIDI Sample Dump. Peak allows you to transfer samples to and from these instruments if you have a MIDI connection.
Peak sends and receives all MIDI Sample Dumps as 16-bit resolution samples. Depending on your particular sampler, the 16 bit resolution may be reduced to a lower resolution to match the sampler’s capabilities. MIDI Sample Dump does not support stereo audio documents, so you may need to separate your stereo audio documents into left and right mono documents using the Export Dual Mono... command under the File menu. You can then send the mono documents separately to the sampler.

⚠️ In order to use MIDI Sample Dump, you will also need to install Opcode’s OMS software.

⚠️ Sampler Support is not available in Peak LE.

---

**Plug-Ins Menu**

This menu lists optional software plug-ins in Premiere, AudioSuite, TDM, and VST formats for Peak. They are available from BIAS and a variety of third-party developers such as Arboretum Systems, Cycling ‘74, DUY, and Waves. For a description of these items, please refer to the documentation for the plug-in software, and Chapter 8: Plug-Ins of your Peak User's Guide.

---

**Preference Menu**

This menu contains a number of commands that allow you to customize aspects of your Peak software such as waveform display colors, output volume, and other user preferences.

---

**Time Units**

The Time Units command allows you to choose a time format for the audio timeline in Peak’s audio document window. You can choose samples, seconds, SMPTE frames, and Bars | Beats. The format you choose will depend on the nature of the project that you are working on.

**Sample Units**

The Sample Units command allows you to select whether sample units will be displayed in decimal, percentage, or dB.

**Colors**

Peak allows you to customize the colors used to display the elements in audio documents. You can use this dialog to set the background color, waveform color, and colors for markers and loops. You can select either a preset color combination, or individual colors for each element in the audio document window, as
well as picking your own custom colors from a color palette. You can also choose to have the waveform display shading for a 3-D look, as well as select the amount of shading. Changes made using the Colors dialog affect both the current audio document’s colors, and any subsequent new audio document’s colors. See Chapter 3 for more information on this feature.

**Move Waveform During Playback**

The Move Waveform During Play command will move the waveform under the cursor as playback progresses, so that the playbar is always in the middle of the waveform display. A check next to this menu item indicates that it is enabled.

**Compute File Max dB**

The Compute File Max dB command scans the audio document for its maximum amplitude, and gives you a readout of the maximum value and its precise location. This feature requires extra time, and is best used with smaller audio documents when needing to monitor overall volume during editing. Otherwise, keep this option off and option-click the “Max” text left of the overview to update the current audio document’s maximum volume indicator at the left of the overview.

**Show Edits**

The Show Edits command indicates areas of an audio document that you have edited by enclosing these areas with hatched lines. This provides you with a convenient visual reference to portions of the document that have been affected by your editing actions. Once you save a document, the edits are saved, and these indicators will no longer appear.

**Show Marker Times**

The Show Marker Times command will show a time value as well as a marker name for all Peak markers, loops, and regions.

**Show Overview**

The Show Overview command (c-,) provides an Overview display of the entire audio waveform along the top of the Audio Document window under the title bar. This provides you with a convenient visual reference of the overall document when you are editing only a portion in the audio document window.

**Scratch Disks**

Because audio data can be very large, Peak utilizes a portion of your hard disk’s free space to hold audio
documents that have been cut or copied, as well as for temporary or “scratch” files for undo purposes. If your hard disk is short on space, you may not be able to cut, copy, or modify large selections. If you have more than one hard drive attached to your Macintosh, the Scratch Disks command in the Preference menu allows you to choose the hard drives (or “scratch disks”) that you wish to use for these temporary files. Peak allows you to select which disk you want to have as your default, or “Primary” disk for this purpose—usually you would select the disk that has the most free space. If you are connected to a file server, you can utilize available storage on the server by clicking the Allow Servers checkbox. Any available servers will then appear in the Scratch Disks pop-up menu. This feature is recommended only if you have access to a high speed Ethernet, Media Net, or other fast server.

Auto-Import Dual Mono

Certain audio applications such as Digidesign’s Pro Tools do not directly support stereo interleaved documents, and instead use “dual mono” documents which comprise the right and left channels of stereo material. Enabling the Auto-Import Dual Mono command tells Peak to automatically convert such documents into new stereo audio documents when you attempt to open these documents with the Open command. Because Peak actually writes a new stereo audio file to disk, this conversion process requires hard disk space equivalent to the two original mono documents. (Please note that the Import Dual Mono command requires that both files be mono documents, have the same sample rate, and the files must have exactly the same name with the separate suffixes of “.L” and “.R”.)

Audio Info

The Audio Info command (⌘-I) allows you to change an audio document’s length, sample rate, root key, low key, or high key parameters. When you choose this command, a dialog indicating the total time of the sample, its sample rate, and its key mapping information will appear. The Audio Info dialog allows you to change the sample rate, duration, root key (for use in a sample playback instrument), and high and low key range. Note that by changing the sample rate, the pitch and duration of the sample will be affected. (To change the sample rate of an audio document without changing the pitch, use the Convert Sample Rate command from the DSP menu.)

Audio Info dialog

You can also adjust the key range (for use in a sample playback instrument) of a document by clicking on the miniature keyboard in this dialog. To set the lower limit of the key range, click on the keyboard at the desired key. To set the upper limit of the key range, hold down the Shift key and click on the keyboard. To set the root key of the audio document’s key range, hold down the Option key and click on the keyboard. You can also enter the desired numerical value in any of the appropriate fields to accomplish this.
Dynamic Scrub Time
Peak provides a unique audio auditioning technique called dynamic scrubbing. This feature is very useful for precisely pinpointing a desired location in an audio document. Dynamic scrubbing allows you to drag the mouse forward or backward over a waveform while Peak plays a short loop (between 10 and 600 milliseconds) at the scrub location. You can control the tempo and direction (forward or backward) of playback by dragging the mouse slower or faster, forwards or backwards. When you have found the location you are looking for, you can commence editing or playback. The Dynamic Scrub Time command allows you to choose the length of this playback loop. Depending on the audio document’s content, a value of between 40 to 80 milliseconds typically works well. See Chapter 5: Editing, for step-by-step instructions on how to use the Dynamic Scrubbing feature.

Auto Snap To Zero
The Auto Snap to Zero command will automatically “snap” any Peak selection to a zero crossing after you make a selection.

Blending
Blending is an automatic crossfade function with a user-editable envelope. Peak can apply blending to areas of an audio document when they are modified by cutting, pasting or other editing processes in order to smooth abrupt transitions between waveform amplitudes. It can be very useful for creating a smooth transition between edits that would otherwise sound too abrupt. If you are going to cut, paste, or insert audio into a document, you may wish to enable blending to smooth things out a bit. It can be toggled on or off by choosing this command or by clicking the Blend enable/disable button on the Cursor Palette. For detailed instructions on how to use blending or how to edit the blending crossfade envelope, see Chapter 5: Editing.

Auditioning
Peak’s Auditioning command allows you to audition a selection along with a specific amount of audio preceding or following it. The Auditioning dialog allows you to select a desired amount of Pre-roll or Post-roll when you play the selection.

Fade In Envelope
The Fade In Envelope command (command-F-Space) allows you to edit Peak’s fade-in envelope. Fade-ins can be very useful for smoothly fading into an audio document, or for fading into one type of audio material from another. Very short fade ins can also be useful for smoothing or removing clicks and pops in a recording. The Fade In Envelope dialog allows you to control the exact shape of a fade in by providing you with user-definable envelope controls. For detailed instructions on how to create fade ins and edit their envelopes, see Chapter 5: Editing.

Fade Out Envelope
The Fade Out Envelope command allows you to edit Peak’s fade-out envelope. Fade-outs can be very useful for smoothly fading out of an audio document, or for fading out of one type of audio material into another.
The Fade Out Envelope dialog allows you to control the exact shape of a fade out by providing you with user-definable envelope controls. For detailed instructions on how to create fade out and edit their envelopes, see Chapter 5: Editing.

**Premiere Envelope**
This command allows you to apply third-party Adobe Premiere Plug-in effects gradually according to the envelope you create in the Envelope Editor dialog. This is very useful for applying effects over time.

**Sampler...**
The Sampler... command allows you to set an offset of one sample, for those samplers that require it, as well as choose SCSI preferences. See Chapter 10: Samplers, for more on the Sampler Preferences dialog.

**DSP Preferences**
Peak DSP Preferences allow you to set the size of the “window” used in time shifting, and the quality of sample rate conversion.

**Movie Sound Tracks**
The Movie Sound Tracks command brings up a dialog that allows you to Enable or Disable the movie’s existing soundtracks. You can use this dialog to toggle multiple soundtracks contained in a movie on and off to check balances or “solo” certain tracks. Click on the Set button to accept the changes, or Cancel to leave the movie unaffected.

**Playback Preferences**
Peak’s Playback Preferences dialog allows you to control the master output volume, hard disk playback buffer size, and window buffer size.
Playback Master Volume

Peak provides a master volume control for audio playback. In the Playback Preferences dialog, set Peak’s output volume to the level that you desire by adjusting the slider or entering a number value from 0 (silent) to 7 (loudest). If you are controlling your playback volume with the volume control of your playback system, you will most likely want to leave the output level set to 7.

Playback Buffer

Peak allows you to control the amount of RAM the program uses when playing back audio documents. In general, lower is better. A playback buffer of 32k is a good place to start. If you are experiencing clicks in your playback, working with fragmented files, using processor-intensive real-time DSP, or are using a slow hard drive, you may need a larger playback buffer setting.

Window Buffer

Peak also allows you to control the amount of RAM the program uses to keep audio documents buffered in RAM. Use larger values if you are working with a few large files, and smaller values if you are working with many smaller files. Experiment to find the best settings for your system and working style.

Plug-In Memory

When using third party Premiere plug-ins, you may need to set aside some RAM for the plug-in. The Plug-In Memory dialog allows you to set this memory reserve (this is separate from the Plug-In Preview Time described in Chapter 8: Plug-Ins). Generally, for the best results, this preference should be set between 512k and 2048k. Since plug-ins from different manufacturers have different needs, check with the manufacturer of the plug-in for suggested memory requirements.

Shortcuts & Toolbar

Peak allows you to customize any Peak menu item with a keyboard shortcut. To change your keyboard shortcuts, go to the Preference menu and select the Shortcuts and Toolbar item. Keyboard shortcuts are stored in a Preference file in the System Folder’s Preferences Folder, called “Peak 2.x Shortcuts.” Peak’s
default Keyboard Shortcuts are listed in Appendix 1 at the end of this manual.

You may also customize the Peak Toolbar using the Shortcuts and Toolbar dialog. Just scroll to a function in the dialog list, and use the checkbox to toggle the icon on and off. This allows you to group only the items you use most frequently on the Toolbar for easy access.

The Shortcuts & Toolbar dialog

Not available in Peak LE

Auto-Balloon Help

Auto-Balloon Help, when enabled, will automatically activate Balloon Help for items in the Toolbar if the cursor rests over an item for more than 3 seconds.

Speak Help

The Speak Help command, when enabled, will “speak” the Balloon Help for items in the Toolbar using the Apple Speech Manager.

Window Menu

The commands in this menu allow you to display and manage Peak’s windows, including the Toolbar, Cursor Palette, Contents Palette, Movie Window, and any open audio documents.

The Toolbar

You may assign almost any Peak command as an icon in the Toolbar. The Toolbar menu allows you to group together the functions you use most often, so that you can simply click a button instead of going to the menus. For example, if you frequently use Normalize and Pitch Change, you can choose to have the icons for these functions in the Toolbar, so that all you have to do is to make an audio selection and click a button. The Toolbar is an easy way to make your work in Peak faster and more efficient, allowing you to customize the program to suit the way you work.

To add or subtract items from the Toolbar, use the Shortcuts & Toolbar command under the Preference menu. Toolbar selections are stored in a Preference file in the System Folder’s Preference Folder, called “Peak 2.x Shortcuts.”

⚠️ You can “grow” or “shrink” the Toolbar by clicking on the plus (+) and minus (-) signs in the vertical gray bar on the right of the Toolbar. You can also choose whether to have a vertical Toolbar at the left of your screen, or a horizontal Toolbar along the top of your screen—just click on the box at the upper right of the Toolbar, and it will snap to its new position.
The Peak Cursor Palette

Peak has a floating Cursor Palette that contains several useful functions. On the right side of the palette are four different icons representing different cursor modes. The default cursor is a standard Arrow Cursor. You can also use the cursor palette to select a Hand Cursor for moving a waveform within its window, a Pencil Tool for drawing directly on the waveform at the sample level, and a Magnifying Glass Tool for zooming the waveform view in and out. On the left side of the Cursor Palette there are two buttons that control Blend Enable/Disable and Loop During Playback. To access any of these cursors or functions, just click on the corresponding icon in the Cursor Palette. To change the cursor tool, click on a new icon. To use the Magnifying Glass tool, simply click on the tool in the Cursor Palette, then move the cursor over the waveform. A “plus” (+) sign will appear inside the Magnifying Glass. Click on the waveform to zoom in; each click of the mouse will zoom in farther. To zoom out, hold down the option key. A “minus” (-) sign will appear in the Magnifying Glass, and you can click on the waveform to zoom out.

The Contents Palette

Peak has a floating Contents Palette that will display all Regions, Markers, and Loops contained in any open audio documents. There are three tabs at the top of the palette that allow you to select which items to view—from left to right: the Region Tab, the Marker Tab and the Loop Tab. Option-double-clicking on any item in the Contents window will bring up the Edit Region or Edit Marker dialog.

Movie

The Movie command toggles the Movie window on and off for any QuickTime movie you currently have open in Peak.

Playlist

The Playlist command (⌃P) allows you to open up
the current Playlist window. See Chapter 6: Playlists & CD Burning, for more on Playlists.

---

**The Playlist Window**

Crossfades, DSP Inserts, and Nudge Regions are not available for the Playlist in Peak LE.

**Tile Windows**

The Tile Windows command (⌘-T) arranges all open audio documents in a tile formation on your computer screen. This type of arrangement allows you to view multiple open audio documents and once, and is particularly convenient if you are cutting and pasting between several documents or jumping back and forth between them for editing purposes. You can press a ⌘-number key corresponding to an open audio document and the document will become the active window. (Click the Windows menu to see the numbers that correspond to each open audio document.)

**Stack Windows**

The Stack Windows command arranges all open audio documents into a stack, with each document overlapping the previous document, in the order that they were opened. This type of arrangement allows you to have the maximum number of documents open and use the minimum amount of screen real estate. You can then conveniently use the Windows menu to select any open document and make it the active window. Alternatively, you can press the ⌘-number key corresponding to the open document and the document will become the active window. (Click the Windows menu to see the ⌘-numbers that correspond to each open audio document.)

---

**Links Menu**

The Links menu in Peak provides useful links to BIAS’s Web site and the CDDB Web site. Included are the Peak online registration page, the BIAS home page, the Peak updates page, technical support pages, online documentation, Deck and SFX Machine product information pages, and the CDDB home page.

---

**Help Menu**

Peak’s Balloon Help, can be activated by selecting Show Balloons from the Help menu. Balloon Help will show you the functions of each menu item as you move the mouse across different menu items.
Appendix 1: Keyboard Shortcuts and Actions

Keyboard Shortcuts

This section lists the default keyboard shortcuts for Peak. As you learned in Chapter 3: Peak Basics, these keyboard shortcuts may be reassigned to any desired key or combination of keys, as well as to icons in the Toolbar.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Keyboard Shortcut</th>
<th>Command Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>⌘ N</td>
<td>New Mono Document</td>
<td>Creates a blank mono document</td>
</tr>
<tr>
<td>⌘ Shift-N</td>
<td>New Stereo Document</td>
<td>Creates a blank stereo document</td>
</tr>
<tr>
<td>⌘ Option-N</td>
<td>New Document from selection</td>
<td>Creates new document from selection</td>
</tr>
<tr>
<td>⌘ Shift-P</td>
<td>New Playlist Document</td>
<td>Creates a blank playlist</td>
</tr>
<tr>
<td>⌘ Shift-B</td>
<td>New Document From Playlist</td>
<td>Creates a document from a playlist</td>
</tr>
<tr>
<td>⌘ O</td>
<td>Open...</td>
<td>Opens a file from disk</td>
</tr>
<tr>
<td>⌘c-W</td>
<td>Close</td>
<td>Closes the front-most document</td>
</tr>
<tr>
<td>⌘ Option-W</td>
<td>Close All</td>
<td>Closes all documents</td>
</tr>
<tr>
<td>⌘ S</td>
<td>Save</td>
<td>Saves the front-most document</td>
</tr>
<tr>
<td>⌘ Shift-S</td>
<td>Save As...</td>
<td>Saves the front-most document with a new name and/or new location</td>
</tr>
<tr>
<td>⌘ Option-S</td>
<td>Save a Copy As</td>
<td>Saves a copy of the front-most document with a new name and/or new location</td>
</tr>
<tr>
<td>⌘ Q</td>
<td>Quit</td>
<td>Quit Peak</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>⌘ Z</td>
<td>Undo</td>
<td>Undo edits one by one (as long as you haven’t Saved)</td>
</tr>
<tr>
<td>⌘ Y</td>
<td>Redo</td>
<td>Redo edits one by one (as long as you haven’t Saved)</td>
</tr>
<tr>
<td>⌘ X</td>
<td>Cut</td>
<td>Cut selected audio</td>
</tr>
<tr>
<td>⌘ C</td>
<td>Copy</td>
<td>Copy selected audio to clipboard (useful for Clipboard based DSP effects like Mix and Convolve)</td>
</tr>
<tr>
<td>⌘ V</td>
<td>Paste</td>
<td>Pastes Copied or Cut audio at insertion point</td>
</tr>
<tr>
<td>⌘ D</td>
<td>Insert</td>
<td>Pastes, pushing audio at insertion point further to the right.</td>
</tr>
<tr>
<td>⌘ E</td>
<td>Silence</td>
<td>Replaces audio selection with silence</td>
</tr>
<tr>
<td>Delete Key</td>
<td>Delete</td>
<td>Deletes selection, does not put in Clipboard</td>
</tr>
<tr>
<td>Option-Delete</td>
<td>Delete Except Audio</td>
<td>Deletes Markers, Loops &amp; Regions</td>
</tr>
<tr>
<td>⌘ -</td>
<td>Crop</td>
<td>Crops selected audio</td>
</tr>
<tr>
<td>Menu</td>
<td>Keyboard Shortcut</td>
<td>Command Comments</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td><strong>A</strong></td>
<td>Select All</td>
<td>Selects all audio and events</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Insertion Point at Selection Start</td>
<td>Places Insertion Point at beginning of selection</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Insertion Point at Selection End</td>
<td>Places Insertion Point at end of selection</td>
</tr>
<tr>
<td>⌘ Left Arrow</td>
<td>Previous Selection</td>
<td>Selects previous view or selection</td>
</tr>
<tr>
<td>⌘ Right Arrow</td>
<td>Next Selection</td>
<td>Selects next view or selection</td>
</tr>
</tbody>
</table>

### Action

- ⌘ - or +: Zoom In
- ⌘ - or -: Zoom Out
- Control-Up Arrow: Increase Vertical Zoom
- Control-Down Arrow: Decrease Vertical Zoom
- ⌘ - Shift -: Fit Selection
- ⌘ - Shift [: Zoom Out all the way
- Shift-Left Arrow: Zoom To Sample Level
- Shift-Right Arrow: Zoom To Sample Level (End)
- ⌘ - Shift -: Loop this Selection
- Option-Left Arrow: Nudge Loop Backward
- Option-Right Arrow: Nudge Loop Forward
- ⌘ -: Select Loop
- ⌘ M: New Marker
- ⌘ Shift-R: New Region
- ⌘ G: Go to Time...
- ⌘ J: Loop Surfer™

### Audio

- Spacebar: Play
- Option-Spacebar: Play Selection
- Spacebar: Stop
- ⌘ R: Record
- Option-R: Record Settings

### Preference

- ⌘ L: Use Loop in Playback
- ⌘ ,: Show Overview
- ⌘ I: Audio Info...

### Window

- ⌘ P: Playlist
- ⌘ T: Tile Windows
- ⌘ 1, 2, 3: Document Windows

Peak User's Guide
<table>
<thead>
<tr>
<th>Menu</th>
<th>Keyboard Shortcut</th>
<th>Command Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option-1, -2, -3,...</td>
<td>VST Windows</td>
<td>Brings VST windows to front by number, in the order they were opened.</td>
</tr>
</tbody>
</table>
Peak Actions

This section lists common Peak Actions not found in Peak’s menus. It is organized by Peak windows and functions.

Useful Peak Actions, General

To stop lengthy processes, Saves and recalculations:
- Press ⌘-Period

Audio Document Window, General

To recalibrate the Max Level Indicator in Overview:
- Option-click on Max Level Indicator (at top left of audio document window), but only when Overview is visible.

To toggle Max Level Indicator in Overview between % and db:
- Click on Max Level Indicator (at top left of audio document window), but only when Overview is visible.

To bring up the Audio Info Dialog:
- Click on the Audio Info Area at the bottom left of the audio document window.

To navigate the Overview without playing audio:
- Option-drag in the Overview

Playback

To play from beginning of a document, or from the location of the insertion point:
- Press the Space bar, or click the Play button on the Toolbar

To stop playback:
- Press the Spacebar again, or click Stop on the Transport.

To play from a desired location in the audio document:
- Click cursor at desired location in track and press the Space bar, click the Play button on the Toolbar, or double-click mouse at desired location in the track.

Scrubbing

To begin dynamic "shuttle" scrubbing:
- Hold down the Control key and drag the mouse across the desired area.

To begin dynamic "jog" scrubbing:
- Hold down the Control and Option keys, and drag the mouse.

Selections

To make a selection:
- Click and drag the mouse.

To select all:
- ⌘-A.

To extend or shorten a selection:
- Shift-click on the end of the selection that you wish to modify, then drag the mouse to extend or shorten the selection.

To toggle selection start/end:
- Use the shift key.

To snap selection to the nearest zero crossing:
- Hold ⌘-Option while making a selection.

Views

To zoom out by increments:
- Press ⌘-[ ]

To zoom in by increments:
- Press ⌘-]

To scroll audio display left or right:
- Press control-arrow key left or right

Markers, Loops, and Regions

For a quick list of all Markers in an audio document:
- ⌘-click on the title bar of the audio document window.
To find a Marker by name:
- Type in the first few letters of the marker name

To edit a Marker:
- Double-click on the triangular base of the Marker to open the Edit dialog

To name a Marker:
- Double-click the triangular base of the marker, and enter a name.

To select the audio between two markers:
- Option-click anywhere between the markers, or press the Tab key.

To select additional audio between markers:
- Option-Shift-click between another two markers, or press Shift-Tab.

To move a marker:
- Click on the triangular base of the marker and drag it.
- Or, double-click on the triangular base and enter a time.

To change regular markers into loop markers:
- Double-click the triangular base, and click the Loop Start or Loop End radio button.

To move a pair of loop markers together:
- Hold down the Option key and drag one of the loop markers.

To move a marker to a zero-crossing:
- Click on the triangular base of the marker, and hold down the Shift key while you drag the marker.

To move both ends of a loop or region marker simultaneously:
- Hold down the Option key while moving the marker.

To delete a marker:
- Double-click the triangular base. Click the Delete button.

To delete all markers, loops and regions, leaving audio intact:
- Select all, then press Option-Delete.

To paste just markers, loops and/or regions, leaving audio intact:
- Hold down Option while selecting paste from the edit menu (Option-V).

Playlist

To do multiple assignments of DSP effects in the Playlist:
- Shift-click DSP boxes

To scrub Playlist audio during playback:
- Click and hold the mouse on the time display. The cursor changes to a scrub cursor ( <-> ). Drag to the left to scrub backwards, drag to the right to scrub forwards. The farther to the left or right you drag, the faster the scrub will progress.

Loops

To create a loop from a selection:
- Select desired range, and choose Loop This Selection from the Action menu.

To listen to a loop:
- Choose Use Loop in Playback from the Preference menu or Toolbar, and start playback before the loop end marker.

VST Plug-Ins

To set the VST delay compensation offset:
- Hold down the Option key while choosing Bounce VST Effects.

The Cursor Palette

To toggle between tools in the Cursor Palette:
- Press the esc (Escape) key.

To toggle Blending on and off:
- Press the Caps Lock key.

To find the zoom factor amount:
- Double-click on the Zoom tool in the Cursor Palette.
To bring up the Smoothing dialog for the Pencil tool:

- Double-click on the Pencil tool in the Cursor Palette.

The Contents Palette
To edit a region, marker or loop in the Contents Palette:

- Option-double-click on it’s name in the Contents Palette.

The Movie Window
To make the Movie window smaller:

- Option-click on the QuickTime movie’s “grow box” (at the upper right corner of the Movie window.)
Appendix 2: Troubleshooting

This Appendix contains solutions to common problems that you may encounter when using Peak.

Before Calling For Help

Before you call BIAS Technical Support for help, please take a moment to examine the Read Me file installed with Peak. This document contains late-breaking information not included in your User’s Guide.

Also, visit the BIAS web site for technical support, support files, upgrades, and more:

http://www.bias-inc.com

Typical Problems and Solutions

Peak software won’t open:

• Does your Macintosh have enough RAM to run Peak? You must have at least 32MB of RAM—48MB of RAM is recommended. To find out how much memory your Macintosh has, choose About This Macintosh in the Finder’s Apple Menu. A window will appear telling you how much memory is currently installed in your computer. If you have less than the amount required to run Peak, you will have to install additional RAM in your computer.

• Is Macintosh System Software version 7.6.1 or later installed on your computer? If not, you may need to purchase and install the most current version of the Macintosh System Software in order to run Peak.

• Is Sound Manager version 3.3 or later installed on your Macintosh? If not, you must install this Macintosh System software in order to use Peak.

(Sound manager 3.3 or later is recommended.)

• Is QuickTime™ 3.0.2 or later installed on your Macintosh?

• Is the QuickTime™ PowerPlug installed on your Macintosh?

Digidesign hardware not recognized:

• Currently, version 1.42 of the Sound Manager drivers works with AudioMedia, Sound Tools, and other Digidesign cards. Contact BIAS for more information, or visit the BIAS web site at http://www.bias-inc.com to download the required system extensions.

• Version 1.42 is the current recommended version to use with PCI ProTools III or AudioMedia III hardware.

• Make sure the correct version of the DigiSystem Init is installed in the Extensions folder.

• Try using the ASIO Digidesign Direct IO driver which can be downloaded from Steinberg at http://www.steinberg.net

Peak used to work but now acts strangely or won’t launch:

• If Peak used to work but now won’t launch or suddenly started acting strangely, the Peak Preferences file may be corrupted. Try quitting Peak, dragging the Peak Preferences file from the Preferences folder (in your System Folder) to the Trash icon on the Desktop, choosing Empty Trash from the Finder’s Special menu and then relaunching Peak.

I can’t audition audio from Peak’s Open dialog:

• Be sure that “Show Preview” is checked in the Open dialog.

• Be sure that your Sound Card’s Sound Manager driver is selected for Sound Out in the Sound
Control Panel.

- Check the Volumes in the Sound Control Panel and make sure the Volume for your selected sound card is turned up.

I am having trouble with my Waves Premiere plug-ins:
- BIAS recommends that you use the new Waves Waveshell-P 2.6 or later.
- Try trashing the Waves preferences folder from the Preferences folder in the System folder.

When I place the cursor on the waveform, it jumps to the right or the left. Why?
- This is the result of Peak’s “Auto Snap To Zero” preference, that automatically places the cursor at a zero crossing in the waveform. You can turn it off by going to the Preference menu and un-checking the option.

I notice files on my hard drive with Peak file icons, called “AFM.temp”
- These are temporary files that Peak created as you edited audio. If you change Scratch Disk preferences at the end of a session, or force-quit or crash in Peak, sometimes these temporary files won’t be deleted. You can either manually drag them into the Trash, or launch and then quit Peak.

I know that I can process separate channels in Peak, but not edit them separately. Is there a workaround?
- The workaround is to export dual mono files, open the Left and Right channels in Peak as two separate mono files, edit them, save them, and then Import as Dual Mono. You will then have a stereo file with your changes in it.

Type -1, type -2, and type -3 errors are usually memory related and result from one or more of the following conditions:
- Be sure that sufficient RAM has been allocated to the application (recommended 48MB, but at least 32MB). It is possible to allocate too much memory to an application (see next point). If you are running Peak, be sure that you have set your Monitor for no more than thousands of colors (or even 256).
- Be sure that there is sufficient free RAM for the System, if the OS runs out of RAM the Application and/or the System may report a type 1, 2, or 3 error.
- These types of errors can result from extensions conflicts. To eliminate any possible extensions conflicts simply duplicate your Mac OS Base Extensions Set and enable the additional extensions required by the application (you may also want to enable any sound card drivers, OMS, etc.). Reboot and use this extensions set when running the application.

Peak reports a -108 error:
- A -108 error generally means Peak doesn’t have enough RAM. If the Installer gives you this error, increase the Installer’s RAM in the Finder’s Get Info Window.

Peak reports a -2804 error
- Because Peak uses AppleScript to interact with Toast when burning a CD from Peak’s Playlist, you must have the extension, AppleScriptLib active in your extension set.

Peak reports a -2807 error:
- If Peak reports a -2807 error when launching, make sure that the QuickTime and QuickTime PowerPlug extensions version 3.0.2 or later are installed in your Extensions folder (in your System Folder).
- Make sure that the Sound Manager version 3.3 or later is installed in your extensions folder.

Peak reports a -2817 error:
- If Peak reports a -2817 error when launching you do not have the three MSL extensions active in your extension set that were installed during the Peak installation process, but you do have the RealAudio extensions folder in your System’s Extension folder. If you plan to use Peak to encode sound files in RealAudio 5.0, then you must have the three MSL extensions active. If you do not plan to use Peak to encode files with RealAudio, then remove both the RealAudio folder and the three MSL extensions from your System’s Extension folder.
**Peak reports a -2821 error:**

- If Peak reports an error result code -2821 you will need to be sure that the Shared Library Manager and Shared Library Manager PPC extensions are installed and enabled in your extensions set.

**Peak reports a “QuickTime Lib not found” error:**

- Make sure you have both the QuickTime and QuickTime PowerPlug version 3.0.2 or later extensions in your Extensions folder (in your System Folder).
- Make sure that the Sound Manager version 3.3 or later is installed in your extensions folder.

**Peak quits unexpectedly:**

- Have you allocated enough memory to Peak? Allocate additional RAM to Peak if possible, using the Get Info command from the Finder’s File menu. To do this, select Peak’s icon in the Finder, choose Get Info from the Finder’s File menu, and enter the desired amount in the Preferred Size field. Make sure you allocate more RAM than the amount indicated in the Minimum Size field.

**Playlist DSP Plug-ins stutter during playback:**

- Go to the Preference menu and select Playback. Increase the disk buffer size in the Playback preference.
- Select Prime Realtime w/ Silence from the Plug-Ins menu.
- Avoid moving windows, selecting menus or doing other actions in the Peak window while playing back using real-time effects. Premiere plug-ins cannot do interrupt-level processing.

**Digital noise burst in bounced playlist containing Plug-In DSP:**

- Select Prime Realtime w/ Silence from the Plug-Ins menu and bounce the Playlist again.

**Peak stops or stutters during recording or playback:**

- Is your hard disk too slow? For direct-from-disk recording and playback, your hard drive must have an average seek time of 18ms or faster. If you are not sure of the speed of your drive, check with the manufacturer or the dealer where you purchased the drive.
- Is the data on your hard disk fragmented? If the files on your hard drive have become fragmented (see Chapter 3 for an explanation of fragmentation) you may have to use a hard disk maintenance program such as Norton Speed Disk™ or the optimizer module of TechTool Pro™ to defragment your drive.
- Is Peak’s playback buffer in the Playback Preferences (found in Peak’s Preference menu) set too low? Try increasing the playback buffer to 128K or higher.
- Is the Macintosh’s disk cache set too low? If you have enough RAM to permit it, use the Memory control panel to set the Macintosh’s disk cache to at least 384K and restart your computer.
- Are you using too many System Extensions? Extensions can slow down your Macintosh by using precious processor cycles and can conflict with a disk-intensive program such as Peak. In particular, turn off or remove System Extensions such as menu bar clocks and screen savers that are in constant operation, and restart your Macintosh.

**Audio playback has pops and clicks:**

- Try turning off Interrupt-based metering in Peak’s Meters dialog.
- If you are playing through Digidesign Sound Manager Drivers (not DAE) on Digidesign hardware that has its own separate SCSI bus and audio drives you may need to move the audio files off your Digidesign audio drives and onto a hard drive that is attached to your Macintosh’s internal or external SCSI chain. You should also disable any drives attached to the Digidesign audio bus in Peak’s Scratch Disks dialog.
- Is AppleTalk turned on? If so, use the Apple menu’s Chooser to turn it off if you don’t need it.
- Try increasing the playback buffer size in Peak’s Playback Preferences dialog. (Always use the smallest working setting, because this setting also affects how much memory is used per audio track.)
document window.)

- Do the Sound Control Panel’s Sound Out sample rate and resolution settings match the ones set in Peak? To check, select a portion of audio in Peak, choose the Audio Info command from Peak’s Preferences menu, and note the settings. Then, open the Sound Control Panel from the Apple menu, and choose Sound Out from the pop-up menu. If the settings don’t match, correct them here.

**Audio playback is at the wrong speed or pitch:**

- Do the Sound Control Panel’s Sound Out sample rate and resolution settings match the ones set in Peak? To check, select a portion of audio in Peak, choose the Audio Info command from Peak’s Preferences menu, and note the settings. Then, open the Sound Control Panel from the Apple menu, and choose Sound Out from the pop-up menu. If the settings don’t match, correct them here. (This may also cause the system beep to play at the wrong speed.)

- If you are using a plug-in audio card such as Digidesign’s AudioMedia III card, the input source or clock rate may be set incorrectly. Make sure that both of these parameters are set correctly by opening the Macintosh’s Sound Control Panel and choosing Sound In from the pop-up menu. This problem is very common if your audio card is connected to a digital recorder and is receiving its clock rate from that device. To avoid this problem, always set the input source back to line or line + mic and set the Sync Mode back to Internal in this dialog after you have finished transferring audio digitally. If the file plays back about 10% slow or fast after switching from digital to internal sync, the sample rate selected in the Hardware Setup window may not match the sample rate of the digital source.

**Problems with Scrubbing:**

- QuickTime 4.0.2 had problems with scrubbing. Try upgrading to QuickTime 4.1.

---

**The items in the DSP menu are grayed out:**

- You need to open an audio document before the DSP effects will be available.

- Not all DSP processes are available in Peak LE and Peak SE.

**The items in the Premiere Plug-Ins menu are grayed out:**

- You need to open an audio document before the Premiere Plug-Ins will be available.

- Real Time Premiere Plug-Ins are not available in Peak LE and SE.

**Using Peak with Digidesign or other third-party hardware:**

- If you don’t have them already, you will need to place the appropriate Digidesign compatibility extensions (the Digidesign Sound Drivers and the DigiSystem Init) in your Extensions folder (in your System Folder). Make sure you’re using the recommended versions of these extensions.

- If you experience problems while using Peak with Digidesign or other third-party boards, you may be able to narrow down the source of the problem by removing the associated System Extensions from your Extensions folder and restarting the computer. If this fixes the problem, there may be an extension conflict or other problem with the third-party software. FAQs and technical support information for Digidesign products may be found at http://www.digidesign.com/

- Whenever you change hardware or software, it’s a good idea to drag the DigiSetup file (a preference file that stores your Digidesign hardware settings) from the System Folder to the Trash icon on the Desktop, and then choose Empty Trash from the Finder’s Special menu. Sometimes this preference file can get corrupted. It will be recreated when you change settings in the Hardware Setup window.

- If you are experiencing pops and clicks while using Peak with Digidesign’s AudioMedia III card, these problems have generally been resolved by one or more of the following:
1. Use the recommended Digidesign extensions.

2. Rebuild your Desktop. This is a good thing to do every now and then. It is done by holding down the Option and Command keys while you restart the Macintosh.

3. If your hard drive is highly fragmented, you should defragment and optimize it.

4. Zap your PRAM. The PRAM is a programmable RAM chip that remembers things like Control Panel settings after you turn off your Mac. Sometimes the PRAM can get corrupted, causing a variety of problems. The solution is to zap your PRAM. There are two methods for doing this:
   a. While holding down the Option-P-R keys, turn on the computer. It will restart, re-chiming to indicate that the PRAM has been reset. Then Release the Command-Option-P-R keys. You will then need to reset all of your system Control Panel preferences, such as 24/32 bit and Virtual Memory settings in the Memory Control, Date & Time Control Panel, etc.
   b. Use TechTool from Micromat, a utility which can clear the entire PRAM clean. It can save the previous contents (in case you find out you really shouldn’t have zapped it) and restore the PRAM to what it used to be.

5. Throw away all of your various Finder preferences and preferences for problematic applications. Make sure AppleTalk is turned off, or if you have Open Transport running, use the Network Control Panel to select Classic AppleTalk and then turn it off. Finally, restart your computer.

If you get a -9095 DAE error in Peak, please try the following steps:

- Quit Peak and DAE.
- Trash the Peak preferences file and the DigiSetup file from the System folder.
- Launch Peak and under the Preferences menu in Peak go to Scratch Disks--designate a Primary scratch disk and enable only those drives as scratch disks that are on your Digidesign SCSI bus.
- Launch DAE from Peak (Audio->Sound Out->DAE).
- When recording, be sure to designate your recording drive as one of the drives on the Digidesign SCSI bus.

Please note that you can only record to and play from those drives on your Digidesign SCSI bus when running DAE with Peak on a Digidesign system that has its own dedicated SCSI bus.

Peak does not work with DAE 5.0 on non-TDM systems:
Please note that DAE 5.0 does not support third party applications, such as Peak, with non-TDM hardware (such as the AMIII or the Digi 001). The AMIII card will work with Peak 2.1 via the AMIII ASIO or Digidesign Direct IO ASIO drivers, the Sound Manager Driver, and/or DAE 3.4.x. The AMIII ASIO and Digidesign Direct IO ASIO drivers can be downloaded for free from Steinberg at http://www.steinberg.net

Digidesign 001 and Peak:
The Digi 001 will not support third party applications, such as Peak, via DAE, and currently there are only output drivers for the Sound Manager. The best way to get sound in and out of Peak via the Digi 001 is to use Peak 2.1 and the Digidesign Direct IO ASIO driver, which can be downloaded for free from Steinberg at http://www.steinberg.net

Problems using Peak with an Ensoniq Sampler:
- Make sure you choose the correct OMS device in the Ensoniq Sampler dialog’s OMS device selection pop-up menu.
- Make sure your Ensoniq Sampler is set to MIDI SYSEX = ON.
- Make sure your MIDI interface is powered on.
- Make sure your MIDI cables are connected correctly.
- Check to see that you have a good MIDI connection.
• Either use the Modem serial port, or turn off AppleTalk using the Chooser (under the Apple menu).

**Problems using Peak with a SMDI sampler (via SCSI):**

• Use high-quality, tested SCSI cables that are as short as possible.

• Check for SCSI ID conflicts. Make sure every SCSI device in the SCSI chain has a unique ID.

• Check for problems with SCSI termination. For more information, consult the manuals of your SCSI devices. SCSI termination should exist on each end of the SCSI chain: one termination inside the Macintosh (usually this is the case), and one termination on the last SCSI device in the chain.

• Try turning off Asynchronous transfers in Peak’s Samplers Preferences dialog.

• Reduce the number of components in your SCSI chain. If you have more than one device connected between the sampler and your Macintosh, try removing devices to determine if this affects the errors.

• Change the power-up order of your devices. Try turning all SCSI devices on first, including the sampler. Once the devices have powered up, turn on the Macintosh. If this does not help, try turning on your other SCSI devices, then the Macintosh, and finally the sampler.

• Turn on the Use New SCSI Manager option in the Sampler dialog under Peak’s preferences menu.

**What is the Apple System Profiler, and how can it help solve difficult technical support problems?**

• Apple System Profiler lets you gather information about the configuration of your computer. The information the Apple System Profiler reports is helpful if you report a problem to our Tech Support department.
Appendix 3: Encoding RealAudio, Shockwave and MP3 Files

RealAudio

Peak is an indispensable tool for preparing audio files for the internet. Peak supports the RealNetworks™ RealAudio 5.0, 3.0, and 2.0 Encoders, allowing you to prepare audio for streaming over the internet. This chapter discusses how to use the RealAudio Encoder dialog in Peak, and how to optimize your results.

You must have the RealAudio Encoder extensions installed in your System Folder. If you chose “Custom Install” when you installed Peak, you may not have the proper extensions. The following extensions are required, and are bundled with Peak:

- RealAudio 14.4 encoder
- RealAudio 28.8 encoder
- RealAudio dnet encoder
- RealAudio Engine
- MSL RuntimePPC.DLL
- MSL RuntimePPC++.DLL
- MSL C.PPC.DLL

The RealAudio™ system delivers music and speech over a network in real-time. Real-time delivery means that users do not have to wait while a file downloads; the sound plays as it is delivered. Users have complete control over the sound; they can pause, move forward and back, and start or stop at any time.

The network can be the Internet, an intranet, or any local area network. RealAudio formats are optimized for low- to medium-speed connections including 28.8 and 56 Kbps modems and ISDN. Users can also listen to RealAudio files stored on their local computers.

A RealAudio clip is a file or live broadcast containing sound encoded in one of the RealAudio formats. These formats are highly compressed to deliver the best possible sound over a limited-bandwidth connection.

Because there is no one best format for delivering sound, the RealAudio system provides several formats that are optimized differently for different kinds of audio content. You can choose to provide a clip in one or more formats based on the type of content and the available bandwidth. For example, you would use a different format to deliver speech over a 28.8 Kbps modem than you would to deliver music over an ISDN connection.

In addition to the sound contained in the RealAudio clip, the RealAudio system can deliver images and other Web pages that are synchronized with the sound. These presentations are called Synchronized Multimedia.

The RealAudio system uses several file types, each identified by a specific file extension. The RealAudio files Peak supports and their file extensions are:

- **RealAudio clip (.ra):** The sound encoded in the RealAudio format. This file is created with Peak delivered by RealAudio Server.
- **RealAudio events file (.rae):** The file that contains the events defined for a Synchronized Multimedia presentation. The events file has the same name as
the RealAudio clip it contains events for and it is stored in the same directory on the RealAudio Server. This file is created using markers in your Peak audio document.

To save a file in the RealAudio format, choose Save As... from the File menu in Peak. In the file type pop-up menu that appears in the Save As... dialog, choose “RealAudio.” The RealAudio dialog will appear with several options.

**RealAudio Encoder**

You can play back RealAudio documents created with Peak using the RealNetworks RealAudio Player™ application, which is free. Download the RealAudio Player™ from the RealNetworks web site at:

http://www.real.com

Encoding a RealAudio clip is a one-way process; you cannot convert a RealAudio file back into the original source format. If you want to be able to encode in other formats in the future, you need to archive a copy of the original source.

When you encode an audio file, you select an encoding algorithm. The RealAudio Encoder can encode using several different algorithms. Each encoding algorithm is optimized for a particular type of audio and connection speed bandwidth. You need to select one or more algorithms that best suit your needs.

It is possible to offer more than one encoding algorithm from your RealAudio Server. In this way, you can reach the widest possible audience while still providing high-bandwidth users with the best listening experience. Using Bandwidth Negotiation, you can configure your site to automatically serve the appropriately encoded file. For more information about Bandwidth Negotiation, refer to the RealAudio web site at http://www.real.com.

**Options**

**Source**

The Source pop-up menu allows you to specify the type of audio material your source document contains. For instance, if your audio document is just narration, choose Voice from the Source pop-up menu.

**Encoder**

The Encoder pop-up menu contains a list of encoding options based on the Source settings, described above. Specific algorithms exist for different bandwidths (e.g., 28.8 bps modems, ISDN, etc.), and different numbers of channels (Mono or Stereo). Choose the Encoder option that is correct for your internet streaming delivery needs.

**Bandwidth Negotiation**

Peak does not support bandwidth negotiation at this time.

**Title**

RealAudio clips include text strings for the title, author, and copyright. This text is displayed by RealAudio Player when the clip is played. Although the player usually labels the text as title, author, and copyright, the player displays whatever text you choose to supply.

Text information entered into the Title edit box is stored in the RealAudio document. Use this field to enter information about the name or source of your audio.

**Use Source Document Name**

If you would like Peak to place the audio document’s
file name in the Title field instead of providing a custom Title, check this box.

**Author**

Use this text field to enter the author or group on the recording.

**Copyright**

Use this text field to enter copyright information for the recording.

**Copy Protect**

Click on the Copy Protect button to create a RealAudio document that can only be played, but not recorded.

**Embed Markers as URLs**

Click this button to create an “.rae” Synchronized Multimedia file along with the encoded “.ra” file. If this option is turned on, Peak will generate a “.rae” file using the text from the markers in the audio document.

In addition to basic audio content, the RealAudio system allows you to create real-time on-demand multimedia from within Peak. These presentations can be as simple as a narrated slide show of your home page or as intricate as a multi-frame training program that the viewer controls.

The RealAudio System includes the ability to synchronize World Wide Web pages with audio. Thus the audio can be used as a “time line” to display new pages or frames in the Web browser or to update its content. This enables the creation of Internet slide shows, presentations, guided tours, and site walk-throughs. A user can have full random access (fast forward and rewind), and the Web browser content is synchronized with the audio.

The RealAudio System stores the information for the synchronized events in a file with a .rae file extension. The audio file is located by the RealAudio Server when the listener opens the .ra file. The RealAudio Server streams audio and event information to the RealAudio Player. The event information is streamed to the RealAudio Player, and in turn the RealAudio Player sends Web page information to the Web browser telling it to update the page’s content.

As an example, we might want to create a slide presentation for users to watch that is coordinated with the audio. We use Peak to record the narration of the presentation “Welcome to the Storyboard Society of America’s thirteenth annual presentation. Today we’re going to look at how storyboards have affected developmental changes in adolescents in Germany, Spain, and the United States. We’ll look at several key issues including storyboard design, market dominance, storyboard manufacturing materials choice, creative storyboard potential, and storyboard plagiarism.”

We can place text markers into the audio file using Peak. The text of each marker contains the URL for the browser application to go to. For instance, we might put a marker where it reads “Welcome to the Storyboard Society...” to have the text “http://www.storyboard.org/slidepresentation/slide1.gif.” Then we might put a marker into the audio where it reads “We’ll look at several key issues...” and place a marker there with the text “http://www.storyboard.org/slidepresentation/tableofcontents.gif.”

When the RealAudio clip is played, the RealAudio server will send events to the Web browser at the times corresponding to your markers so a graphic, animation, or other HTML activity can be synchronized to the audio playback.

**Perfect Play**

Click on this button to allow the RealAudio document to be played on 14.4 bps modems when encoded using a 28.8 algorithm. If a RealAudio document is played to a 14.4 bps modem and Perfect Play is enabled, a pre-buffering scheme will allow the 28.8 bps audio to be listened to on a 14.4 bps modem.
Use Peak Sample Rate Converter

To use Peak’s high quality sample rate conversion in place of the Progressive Network’s sample rate converter, click on this box.

Filename “.ra” suffix

RealAudio documents on non-Macintosh systems typically have a “.ra” at the end of the document’s name. Click this box to create a RealAudio document with “.ra” on the end.

Strip “/” from filename

Forward slash characters may be interpreted by RealAudio as an Internet URL. Click this box to ensure that document’s are not encoded using the forward slash in the file name. The RealAudio server and player may misinterpret other characters such as the question mark “?”, so try to avoid non-alphanumeric characters when naming your RealAudio encodings.

Tips for Optimizing Audio Quality For RealAudio

The quality of your RealAudio clips depends largely on the quality of the original source file. Because the RealAudio compression algorithms are “lossy,” some of the information contained in your original audio input will not be included in the reconstructed signal sent to the RealAudio Player. You produce higher-grade audio following compression/decompression if you start with a high-fidelity recording with full dynamic range and a high signal-to-noise ratio.

The following is some advice for getting high-quality source files:

• Use high-quality source files from Compact Disc (CD) or Digital Audio Tape (DAT).

• When possible, digitize the sound to a supported file format. Then preprocess the file with a sound editing program. Set the amplitude of your input signal to maximize the use of the available dynamic range.

• Eliminate any DC offset. DC offset is visible in Peak’s waveform view as an imbalance of the audio signal above or below the horizontal zero axis. This enables you to remove low frequency noise. Peak has a Remove DC Offset feature available in the DSP menu, which will remove DC offset for you.

• Use a CD quality sampling rate (44.1 kHz), sampling width (16-bit) and two channels when creating an input file. You can always down-sample and convert the file to one channel later.

• Applying EQ, or equalization, to your source file may also help. Try using a “brick wall” low pass filter, such as those available in SFX Machine or Waves™ Q10. Setting a cutoff of 12KHZ will filter out all frequencies above 12kHz, and help reduce audio artifacts that may occur due to compression.

• The source files should contain signals of the maximum allowable amplitude. If the full amplitude range is not used, the resulting RealAudio files may sound hollow. Adjust the range using Peak’s Normalize function to automatically maximize levels. Generally, settings between 70%-90% work well.

• If your original audio file signal exceeds the acceptable amplitude range, the file may contain “clipping.” Clipping can cause clicks or pops during playback. If your source file contains a clipped signal, your final RealAudio file will have high-frequency background noise or static. Use Peak to first edit out any clipping that might be in your source audio document before encoding.

• Cut any unnecessarily long silences from the beginning or end of the output file to conserve space.

ShockWave

You can now encode Shockwave audio files from Peak and Peak LE 2.0 or later. The get the Shockwave option to show up in Peak’s Save As... dialog’s file type pop-up menu, you’ll need to download the Macromedia “SWA Export XTRA”: 
http://download.macromedia.com/pub/updates/SE16SWA.hqx

Drop the “Shockwave Export XTRA” into the Peak Plug-Ins folder, then launch Peak. You do not need to install the Shockwave Settings XTRA into the Peak Plug-Ins folder. The Shockwave option will now appear. You can listen to your encoded files using MacAmp, SoundApp, or other shareware programs.

---

**Encoding MP3 files**

To encode MP3 files from Peak, follow the directions above for installing the SWA Export XTRA in the Peak Plug-Ins folder.

---

**High Quality**

Use this option to achieve the highest possible quality in the encoding. This option makes the encoding process take longer, but the results are noticeably better sounding.

⚠️ To speed up the encoding process, go to the Apple Memory Control Panel and set the Disk Cache size to the lowest possible setting.

**Mono**

Use this option to encode stereo documents into a Mono document

**Bit Rate**

Select the desired bit rate for your encoding. Higher bit rates sound better, but require more disk space and take up more bandwidth.

**Copyright**

Type in your copyright information to be stored in the encoding here.
and take up more bandwidth.

**Info**

Type in the Song Name, Artist, Album, Comment, and Year information in the appropriate fields. Use the pop-up menu to choose the Genre.
Glossary

**AIFF**
Apple’s Audio Interchange File Format used for recording and storing digital audio. It is also Peak’s default file format and is supported by many Macintosh software applications.

**AU**
AU, or .au, is the audio file format common to most Sun Unix workstations. It is one of the most commonly used audio file formats on the World Wide Web.

**audio card (third-party audio card, audio expansion card; audio recording/playback card)**
A third-party expansion card that plus into a NuBus or PCI or PCMCIA slot in your Macintosh. These cards enhance a computer’s audio recording and playback capabilities. Using Apple’s Sound Manager software, Peak works with a variety of Macintosh audio cards from Digidesign, Digigram, Echo, Korg, Lucid, Mark of the Unicorn, MIDI Man, and others. In some cases, special Sound Manager Driver software or ASIO Driver software or DAE (for Digidesign cards only) may be needed from the audio card’s manufacturer to work properly with Peak.

**audio document**
An audio document is a Macintosh audio data file created by Peak. Peak can create and open audio documents in a variety of common audio file formats. The AIFF file format is Peak’s default file format. For more information, refer to AIFF, .au, WAVE, Sound Designer II, Red Book, and QuickTime.

**bit resolution (bit rate)**
Describes how many bits—as in “0s” and “1s”—are available to describe a digital recording. In practice, the bit resolution defines the dynamic range of a sound, whereas the sample rate defines the frequency range. 16-bit audio is the professional Compact Disc standard; 8-bit audio is suitable for less demanding applications, such as multimedia presentations. More bits result in better quality, but also require more hard drive storage space. Also refer to dynamic range, frequency, and sample rate.

**blending**
Blending is an automatic crossfade function that Peak applies to areas during cutting, pasting and other editing processes in order to smooth abrupt transitions between waveform amplitudes. Blending can be toggled on or off by choosing the Blending command from the Preference menu, or by clicking the Blending enable/disable button in the Cursor Palette.

**clipping**
A type of audio distortion that occurs when a source signal (such as from an audio CD player) is recorded at such a high level that the recording device (such as a Macintosh running Peak) runs out of “headroom.” It can also occur when a signal is played back from a audio source into an audio destination at an excessive level, such as when a mixing console feeds a signal to a power amplifier at an extremely high level. In either case, clipping represents a mismatch in level between an audio source and an audio destination. When digital clipping occurs, such as during digital recording, the results can be a harsh “crackling” or “raspy” sound. When you use Peak, you can avoid digital clipping by ensuring that the record levels are set so that the loudest incoming audio passages stay below the maximum input level, as indicated on the record or playback meters. Peak’s Clip indicator will easily show any clipping that occurs. Also refer to headroom.

**dB (decibel)**
This is the most common unit used for measuring the level of audio. The greater the number of decibels, the...
higher the audio signal. Within Peak, the record and playback meters show a signal’s relative level in terms of dB. There are many different kinds of decibel scales, but for the purposes of using Peak, “dB” can be used to describe the relative gain of different passages of audio, or to describe the available headroom during recording. Also refer to gain and headroom.

**DSP**

DSP stands for digital signal processing. In the world of audio, DSP refers to manipulating a digital audio signal by processes such as level changes, reverberation, delay, or other such effects. Peak uses DSP to perform many of its audio processing tasks—including those found in the DSP menu or Toolbar.

**dynamic range**

In audio recording terminology, dynamic range refers to the range in level between the quietest and loudest passages of a selection of audio. It is usually expressed in decibels. Bit resolution determines a recording’s dynamic range. An 8-bit recording has 256 available levels, which translates into a dynamic range of 48dB. This may be suitable for some applications, but it may also sound noisy, since the difference in gain between the loudest passages and the quietest passages (which may contain hiss and other potential noise) is not that great. A 16-bit recording has 65,536 available levels, which translates into a high-quality dynamic range of 96dB. As a rule of thumb, you can calculate dynamic range in decibels by multiplying the bit rate by “6.” Also refer to bit resolution, decibel, and gain.

**fade-in/fade-out**

A fade-in is a process where the gain of an audio signal is increased from zero (silence) to its full volume. A fade-out is a process where the gain of an audio signal is decreased from its full volume to zero (silence). Peak allows you to create fade-ins/fade-outs by making a selection and choosing the Fade In or Fade Out command from the DSP menu, or from the Toolbar. Envelope shapes can be editing with the Fade In Envelope or Fade Out Envelope commands in the Preference menu.

**frequency**

Sound consists of waves, which occur in cycles. Frequency refers to how frequently these wave cycles occur in a given period of time (generally, one second). The higher the frequency of a sound, the higher its “pitch” as perceived by human ears. Frequency is measured in Hertz (Hz), or cycles per second. Roughly speaking, humans are able to hear sounds in the frequency range between 20Hz and 20,000Hz (20kHz).

**gain**

1) The process of amplifying a signal. 2) A way to express relative signal levels for audio. For instance, by adding 6 decibels of level to a signal, we double the perceived loudness of the signal. Also refer to decibel and headroom.

**headroom**

Describes how much gain is left before a signal induces clipping or distortion. When recording with Peak, the record meters indicate how much headroom is left before clipping. When playing back audio in Peak, the meter strip at the bottom of the screen will indicate this as well. Most professional audio engineers leave between 3dB and 12dB of headroom while recording, to minimize the possibility of clipping. If you leave too much headroom, however, your signal may be recorded at too low a level, and you may end up with excessive noise or hiss. Also refer to clipping, decibel, and gain.

**Hz (Hertz)**

This is the unit of measurement for frequency, and refers to the number how many “cycles per second” a sound wave generates. In the world of sound, the higher the number of Hertz, the higher the frequency of a sound and hence the higher its “pitch” as perceived by human ears. A thousand Hertz can be expressed as 1kHz (one kilohertz), so that 20,000 Hertz may also be referred to as 20kHz.
**loop**
Loops are used to sustain or repeat a section of audio. They can be used for material that you intend to transfer to a sampler, or simply for playback within Peak itself. Peak allows you to create one loop per audio file. You can do this either by making a selection and choosing the Loop this Selection command (⌘L) from the Actions menu or Toolbar, or by placing markers at the desired start and end point of a region, and defining the markers as loop markers.

**Loop Tuner**
A feature of Peak that allows you to “fine tune” the start and end points of a loop.

**Loop Surfing™**
Peak’s term for adjusting loops during playback.

**Loop Surfer™**
A proprietary feature of Peak, which automates many of the steps required to “loop surf.”

**marker**
A marker is a location in an audio document that you define as important; you can also think of a marker as a “memory location.” By marking a specific location in a recording, you can easily navigate to it for selection, editing or playback purposes. Peak allows you to define a marker by pressing ⌘M or clicking a Toolbar button, either when playback is stopped or while it is engaged.

**playlist**
A playlist is a list of audio events, or “regions,” strung together in a specific order. See also region.

**Plug-Ins**
Plug-Ins are optional software enhancements for Peak that are available from BIAS and other developers that support either the Adobe Premiere Audio Plug-In Standard, the Digidesign AudioSuite and TDM standards, and the Steinberg VST standard. By installing plug-ins in Peak’s Plug-Ins folder, you can enhance Peak’s audio editing and processing capabilities with tools such as filtering, reverberation, chorusing and flanging, noise reduction, spatialization, and more.

**QuickTime**
This is an audio format developed by Apple Computer for QuickTime-based multimedia. It is supported by all Macintosh software applications that support QuickTime. The QuickTime format is best if you plan to use an audio document in multimedia applications that support QuickTime, such as Adobe Premiere or Macromedia Director.

**region**
A region is a portion of an audio document bounded by region markers. Regions are portions of an audio document defined using the New Region command (⌘Shift-R) from the Actions menu or Toolbar. Regions can be saved into only AIFF and Sound Designer II files created by Peak. See also playlist.

**sample**
(verb) Sampling refers to the act of recording audio material digitally by a sampling instrument or other digital recording device. See sampler and sample rate.

**sample**
(noun) A sample refers to audio material which has recorded digitally or “sampled” by a sampling instrument or other digital recording device. Sample also refers to a single wave-cycle” snapshot” of sound. See also sampler and sample rate.

**sampler**
A sampler is an electronic instrument capable of digitally recording or “sampling” a sound and playing it back from a keyboard or other controller. Samplers are used extensively in all areas of audio production, ranging from recording and performance, to film production and sound design. See sample rate.
**Sample Rate**

Sample rate describes how frequently an analog audio signal is been “sampled” or analyzed as it is recorded and converted to a digital medium. Sample rate directly affects audio fidelity in terms of upper frequency response: the higher the sample rate, the higher the available frequency response. A fundamental principle of sampling states that to accurately capture a sound, the sample rate must be at least twice the highest frequency in the sound. The standard sample rate for Compact Discs is 44.1 kHz. The following are common sample rates which are supported by many Macintosh computers and Peak software.

96.000 kHz This is the standard sample rate for Digital Video Disc (DVD) audio, and is often used by sound editors working in audio post-production for DVD. This rate results in an upper frequency response of 48 kHz — well above the range of human hearing.

48.000 kHz This is one of two standard sample rates for digital audio tape (DAT) recorders, and is often used by sound editors working in audio post-production for video or film. This rate results in an upper frequency response of 24 kHz — well above the range of human hearing.

44.100 kHz This is the standard sample rate for Compact Discs, digital audio tape (DAT) recorders, and high-fidelity audio applications on Macintosh and PC-compatible computers with 16-bit playback capability. It is colloquially called “forty-four one” (as in 44.1 kHz). Most sound engineers working in music production — or anything that may be distributed on a CD — work at this rate. This rate results in an upper frequency response of 22,050 Hz — above most people’s hearing range.

22.050 kHz & 11.025 kHz These sample rates are sometimes used for lower-fidelity audio playback on Macintosh and PC-compatible computers. Many games, web-sites and other multimedia productions utilize 22.050 kHz (or lower) 8-bit audio, since it uses half the disc space of CD-quality audio. The 22.050 kHz sample rate results in an upper frequency response of 12.025 kHz; this may sound “muffled,” since most people can hear considerably higher frequencies than 12.025 kHz.

Also refer to bit resolution, frequency, and Hertz.

**SCSI**

Stands for Small Computer System Interface. It is a standard developed to allow a variety of computers and peripheral devices such as hard disks, CD recorders, scanners, and other storage media, to connect and transfer data. Most external hard drives designed for use with the Macintosh are SCSI hard drives and must be connected to the SCSI port on the rear of the Macintosh. The SCSI specification allows up to seven SCSI-equipped devices to be connected or “daisy-chained” together.

**SMDI**

SMDI stands for SCSI Musical Data Interchange Protocol. SMDI Samplers use SCSI to send samples between devices several times more quickly than over MIDI. In order to transfer samples between the Macintosh and your sampler using SMDI, you must connect a SCSI cable between your Macintosh and the sampler.

**Sound Designer II™**

This is an audio file format developed by Digidesign for use with its digital audio products. The format can also be read by a wide variety of Macintosh-based audio editing and multimedia development programs, including Peak. Use this format if you wish to interchange audio documents with a Digidesign audio application.

**WAVE**

This is Microsoft’s Windows Audio File Format. It is supported by many Windows software applications and some Macintosh applications. The WAVE format is
best if you plan to use an audio document in an application that supports or requires WAVE format files.

**zero-crossing**

The zero-crossing is the point where the waveform meets the zero crossing line or the center line through the waveform. It is the point of zero amplitude in the waveform.
Index

Symbols

.au 23, 150, 207
.paf 24, 150
.WAV 21
µLaw 25
16-bit 50
24-bit 49
44.1kHz 50
48kHz 50

A

Action Menu 157
Actions 190
Add 97, 166
Adobe Premiere Plug-Ins 115
AIFF 23, 73, 86, 91, 150, 207
AKAI 174
AKAI samplers 138
Allocating additional RAM to Peak 5
Allow Servers 32, 64, 178
Allow Servers checkbox 32
Amplifier 13
Amplitude Fit 98, 166
Analog-to-Digital Converter 19
Anchor 72
Append to document 40, 163
Apple Events 128
Apple Sound Manager 39
Apple System Profiler 198
AppleTalk 5
Arboretum 115, 120, 176
Arm External Sync 165
ASIO 13, 14, 15, 29, 47, 207
Active in Background 48
Clock Source 48
Deactivate for Previewing 48
Digidesign Direct IO 193
Driver Setup 48
Installation 47

Play Through 48
Record Settings 48
Recording 48
Bit Depth 49
Channels 49
Record Through 49
Sample Rate 49
Sample Rate 48
Asynchronous SCSI transfer 136
Audio
playing 51
Audio between adjacent markers
selecting 60
Audio Card 13, 42, 207
Audio CD 45
import options 46
Audio Compression 25
Audio Connections 12
Audio Document 207
creating 21
Audio Document Window 55, 190
Audio Engineering Society's file format 24, 150
Audio Extraction 45
Audio Info 32, 58, 178
Audio Info Area 58
Audio Interchange File Format 23, 150
Audio Levels
setting for recording 40, 163
Audio Librarian Pak 128
Audio menu 43, 161
Audio Source 44
Audio Waveform Overview 56
Audio Waveforms 56
Audio Window 26
AudioSuite 115, 176
using Plug-Ins 120
Auditioning 30, 61, 179
Authorization 12
Auto Import Dual Mono 23
Auto Snap To Zero 179
Auto-Balloon Help 182
Auto-Import Dual Mono 30, 178

B

Balloon Help 7
Batch File Processor 125, 153
Available Processes 126
File Name Suffix 127
Input Area 126
Process Area 126
Save Changes Area 127
with TDM Plug-ins 119
BIAS Deck 22, 30, 40, 152, 163
Bit Depth 41
Bit Resolution 19, 207
Blend Enable/Disable 179
Blending 30, 67, 179, 207
Envelope Editor 68
parameters 68
Blending Envelope 68
Blending Envelope
custom
saving 69, 76
Burn Audio CD 92
Bypass 118

C

CD
recording from 45
CD-ROM drives 45
CDDDB 46, 152
CDDDBLib 46
Change Duration 98, 167
Change Gain 99, 167
Change Pitch 100, 167
Choosing a Time Format 31
Choosing Colors 30
Clear Clipboard 64, 156
Clicks 108, 172
Clip Indicator 59, 165
Clipboard 64
Clipping 207
Close 25, 150
Close All 25
Colors 31, 176
choosing 30
Compressed Audio support 21, 25
Compression 25, 115, 120
µlaw 21
MACE 21, 25
QDesign 21, 25
selecting for recording 41, 163
Compute File Max db 177
Contents Palette 27, 85, 183, 192
Convert Sample Rate 100, 168
Convolve 101, 168
Copy 65, 155
Creating an Audio Document 21
Creating Loops 74
Creating Markers 71
Crop 66, 156
Crossfade Loop 75, 101, 168
Crossfades 67
Cursor Location Display 59
Cursor Palette 26, 183, 191
Hand Tool 26
Magnifying Glass 26
Cursor Palette
Arrow Cursor Tool 26
Cut 155
Cycling '74 176
Cycling '74 120

D

DAE 14, 29, 49, 207
Playback 50
dB (decibel) 207
DC Offset 110, 173
Decibel 207
Decrease Vertical Zoom 158
Delete 65, 72, 156
Delete Except Audio 156
Device and Sample Format 41, 163
Digi 001 197
Digidesign 14, 49, 196, 207
DAE 14, 15
AudioSuite 120
Playback Engine Setup 50
TDM 118
DAE 5.0 197
MasterList CD 85
Pro Tools 30
Pro Tools III 50
TDM 14, 118
Digidesign Audio Engine(DAE) 49
Digigram 14, 207
Digigram VX Pocket 42
Digital Audio explained 19
Digital Sampling 19
Digital Signal Processing 97
Disk Cache 203
Disk I/O 50
Disk-based Recording 20
Dither 25, 102, 168
Document From Playlist 149
Drag and Drop folders, disks, CD audio tracks 23
Draw Tool 27
DSP 97, 208
DSP Menu 166
DSP Preferences 99, 180
Dual Mono 23, 40, 163
auto-import 30
files 22
format 23
DUY 115, 176
Dynamic Range 19, 208
Dynamic Scrub Time 29, 61, 179
Dynamic Scrubbing 29, 49, 61

E

E-magic
WaveBurner 85
E-mu 175
Paris System 24, 150
Echo 207
Edit Marker dialog 71, 159
Edit Menu 155
Editing
Cut 64
Nondestructive 20
Editing Audio 55
Auto-Zero 57
Edits command 63, 155
Ensoniq 174
ASR-X 175
Error Messages and Troubleshooting 145
Sampler dialog 142
samplers 141
EQ 120
equalization 115
Error Messages 140
Errors
-108 194
-2804 194
-2807 194
-2817 194
-2821 195
DAE -9095 197
Type -1 194
Type -2 194
Type -3 194
Export Dual Mono 152
Export Marker Regions 80
Export Regions 79, 152, 153
Output Directory 80
Output Format 80
Region Detection 80
t through Batch File Processor 80, 153
Exporting Playlist as a Text Document 91

F
Fade Envelope Editor 70
Fade In 168
Fade In Envelope 69, 103, 179
Fade In/Out Envelope
loading 70
Fade Out 168
Fade Out Envelope 69, 103, 179
Fade-in 69, 102, 208
custom, saving 70
Fade-ins and Fade-outs 69
Fade-Out 103
Fade-out 69, 208
Fast-Forward 161
File Format 23
selecting for recording 40, 162
Marker 209
  Show Marker Time 29
Markers 57, 70, 190
  Audio between adjacent markers 58
  Delete 73
  dynamic scrubbing 72
  Nudge 73
Markers to Regions 159
Master Output Volume 180
Memory Control Panel 5, 203
Meters 59, 165
MIDI Man 207
MIDI Meters 59, 60, 165
MIDI Sample Dump 140, 175
MIDI Sample Dump Standard 139, 175
MIDI Time Code 165
Minimum Size field 5
Mix 105, 170
Mixer 13
Modulate 106, 170
Monitor 40, 165
Mono 149
Mono to Stereo 104, 169
Mono-to-Mono 119
Mono/Stereo 119
Move Waveform During Play 29
Move Waveform During Playback 177
Movie Sound Tracks 180
Movie Window 192
Movie window 183
MP3 24, 151, 203
Mute 118

N
New 21, 149
New Audio Document
  from a Playlist 91
  from Selection 66
New Marker 158
New Region 159
Next Selection 157
Noise Reduction 115
Non-Destructive Editing 55, 85
Non-Destructive Recording/editing 20
Non-Linear Recording/Editing 20
Normalize 106, 170
Notepad 44, 162
Nudge 159
Nudge Loop Backward 158
Nudge Loop Forward 158
Nudge Regions 90

O
OMS 60, 137, 140, 165
Online Help 7
Only Regions 80
Open 149
Open an Existing Documents 21

P
Palettes 25
Panner 107, 171
Paste 65, 156
Pause 161
Peak
  finding 103
  installing 11
Peak Envelopes Folder 69, 76
Peak Features 3
Peak Hold 59, 165
Peak LE
  unsupported features 6
Peak SE 7
Peavey 175
Pencil 27
Performance
  maximizing 5
Phase Vocoder 107, 171
Pitch Change 100, 167
Play 161
Play Selection 161
Play with Auditioning 161
Playback 51, 190
Playback Buffer 28, 181
Playback Buffer Size 28, 180
Playback Master Volume 28, 181
Playback Preferences 180
Playing Audio 51
Playlist 183, 191, 209
  about 85
  auditioning 88
    post-roll 90
    pre-roll 90
  Bounce 87, 91
  Burn CD 87
  creating 87
  crossfade 87
  DSP inserts
    Premiere plug-ins 90
  DSP plug-ins 87, 195
  gain 87
  gap time 87, 89
  modifying events 89
  Nudge Regions 90
  opening 92
  saving 92
  scrubbing 89, 191
  VST plug-ins 90
Playlist Document 87, 149
Playlist Event 87
Playlist Regions 86
Plug-In Memory 116, 181
Plug-In Preview Time 116
Plug-Ins 49, 209
  AudioSuite 115, 176
    install 120
    installing 115
  Premiere 115, 176
    install 115
    RealTime 117
    processing 115
  TDM 176
    bounce 119
    insert 118
    using 118
  VST 120, 176
    bounce 121
    insert 120
    install 120
    record through 121
      with Batch File Processor 122
Plug-Ins folder 116
Plug-Ins Menu 176

Pops and Clicks 195
  Position field 71
  Postroll 61
  Preferences 27
  Preferences Menu 28, 176
  Preferred Size field 5
  Premiere 115, 176
    audio plug-in standard 209
    Envelope 117, 180
  Premiere Plug-Ins
    general info 115
    memory 181
    recording through 43, 118, 164
  Previous Selection 157
  Premiere Envelope 117, 180
  Product Authorization Code 12
  Progress Bar 59
  Proper Levels 39

Q

QDesign 25
  Qualcomm 25
  QuickTime 209
    file format 24, 150
    file support 21
  QuickTime Movies
    editing soundtracks 81
  Quit 154
  Quitting 34

R

RAM
  crossfades 88
  requirements 4
  Random-access Recording/Editing 20
  Rappify 108, 171
  Raw Audio Files 24, 150
  RealAudio 24, 199, 202
    file format 150
  RealAudio Player 200, 202
  RealAudio Server 200
RealNetworks 199
RealTime Premiere Plug-Ins 117
Recently Opened Documents 22, 154
Record 40, 43, 161, 162
Record Dialog 43
Record Settings 51
  ASIO 48
Record Timer 41, 163
Recoding 50
  ASIO 48
  initiating 44
  through Premiere plug-ins 43, 118, 164
Recording levels 39, 40
Recording Options 40, 162
Red-Book 85
Redo 63, 155
Reference Point 72
Region 209
Regions 73, 85, 190, 209
  creating 86
  editing 86
  exporting 79
  while recording 44
Remove DC Offset 110, 173, 202
Replace 66, 156
Reverb 115, 120
Reverse 110, 173
Reverse Boomerang 110, 173
Rewind 161
Roland 136
  S-760 175
Root Key 178
Roxio
  JAM 24, 85
  Toast 85, 92, 93
Sample 41, 164, 209
  duration 58
  key range 58
  root key 58
  sample rate 58
Sample Rate 19, 41, 164, 210
  conversion 100, 168
Sample Units 176
Sampler 180, 209
  ensoniq
    keyrange 143
    List menu 143
    panning 143
    send 134
Sampler Menu 174
Sampler Preferences 136
Sampler Support 133
Samplers 133
  AKAI 174
  and Ultra-Wide SCSI cards 134
  Asynchronous SCSI sample transfers 133
  E-mu 133, 175
  ensoniq 133, 174
    wavesample 142
  Kurzweil 133, 175
  List of Samplers 135
  Peavey 133, 175
    receive 135
  Roland 175
  Roland S-760 136
  SMDI Device 134
  SMDI Sampler Error Messages & Troubleshooting 135
  troubleshooting & error msgs 140
  Yamaha 136, 175
Samples List 134
Sampling 19
Save 24, 150
  Save A Copy As 151
  Save a Copy As 23
  Save As 24, 151
Saving 23
Scratch Disks 32, 64, 177
Script (Batch File Processor) 127
  Definition 129, 130
Scroll During Play 177
Scroll During Playback 29
Scrubbing 62, 190
  problems 196
SCSI 50, 210
SCSI Management 136
Select All 156

Index
Select Loop 157
Selecting a region 60
Selecting Audio 60
Selections 57, 190
Set Selection 157
SFX Machine 202
Shockwave 24, 150, 202
Shortcuts 181
Show Edits 67, 177
Show Marker Time 29
Show Overview 177
Shuttle Scrubbing 62
Silence 66, 156
insert 67
SMDI 175, 210
SMDI Sampler 134, 175
SMDI Samplers 133
SMPTE 165
SMPTE/EBU 165
Snap Selection to Zeros 158
Sonic Solutions 24, 150
Sound Control Panel 14
Sound Designer II 23, 73, 85, 86, 91, 210
Sound Designer II format 150
Sound Dialog 41, 163
Sound frequency 19
Sound Manager 13, 14, 49, 207
Source 42, 164
Spacebar Operation 28, 181
Speak Help 182
Speakers 13
Split Stereo 40, 163
Stack Windows 184
Start Surfing 77
Steinberg 47, 120, 193
Stereo 149
Stereo To Mono 105, 170
Stereo to Mono 104
Stereo/Stereo 119
Stop 161
Stop & Extend Selection 161
Storage Requirements 20
SWA Export Xtra 24, 150, 202, 203
Swap Channels 111, 173
System Extensions 5

System Requirements 4

T

Tape-Style Scrubbing 29
TDM 14, 115, 176
Plug-Ins 118
Tempo 32
Tempo Calculator 77
Theme 31
Threshold 78, 111, 173
Tile Windows 184
Time Compression/Expansion 98
Time Display 59
Time Format 31
Time Units 176
Timestamp 32
Toolbar 33, 181, 182
customizing 34
Transport 51

U

Undo 155
unlimited 55
Units 31
Unlimited Undo and Redo 63
USB 15
Use Loop in Playback 75, 177

V

Vertical Scaling 56
Views 190
VST 115, 120, 176
VST Plug-Ins
delay compensation 121
Record through 43
VstPlugins 120

W

WAVE 24, 150, 210
Waveform Display 26
Waves 115, 120, 176, 202
Premiere plug-ins 194
Waves IDR 102, 168
Window Buffer

  settings 28, 181  
  size 180  
Windows 25  
Windows Audio File Format 24, 150  
Windows Menu 182  

X  

XPose Visual Sampler 60  

Y  

Yamaha 175  
  DSP Factory 47  

Z  

Zero-Crossing 158, 211  
Zoom All the Way Out 158  
Zoom at Sample Level 158  
Zoom at Sample Level (End) 158  
Zoom In 157  
Zoom Out 157  
Zoom Tool 26